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Artistic Digitizer embroidery software is equipped with a next generation working environment which will

excite with its innovative design, 3D integration, intuitive usability and stunning embroidery quality. 

Every embroidery creation takes less time and effort to be made, providing you more time to enjoy your

creations. 

All this in dual platforms, MS Windows® and macOS®. No more operating system dilemma. 

Installation

The first step in order to start using the software is the actual "installation". The installation will get the

software on your computer. Before proceeding make sure that your system meets the system requirements.

The minimum systems requirements should be met to be able to install the software.

 Operating Systems other than those stated below are not supported.

Minimum System Requirements:

Operating System:

Windows 10 or 11 with the latest updates

macOS latest and previous version, compared to the release date of this

software

CPU:

Intel Core i3/i5/i7/i9 or AMD Athlon X4, A10-Series, FX series, Ryzen

3/5/7/9, 

Apple's M1 and M2
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RAM: 6 GB of RAM 

Hard disk: 1.5 GB of free uncompressed space

Graphics card:
3D DirectX 11 accelerator with at least 1 GB RAM, 32-bit color (Windows

only)

Monitor Resolution: 1366 x 768

Internet connection: Required

Installing the software

Make sure that you are logged in as a user with administrative privileges. 

Close all applications, including all virus detection programs and applications that are open in the

system tray or on the Windows task-bar. Not doing so may increase the installation time and interfere

with the installation.

MS Windows installation 

Insert the installation USB flash drive into a USB port on your computer. It is recommended that you close all

running programs before you proceed. 

Now open Windows Explorer and navigate to the installation flash drive labeled Artistic, and run the

"setup.exe" program.

If you have a link to download the installation file, you can type it in any web browser’s URL field and

download the file. Extract the installation file from the downloaded zip file by right clicking on it and

selecting "Extract All…" Follow the instructions to extract the installation file, then go to that folder and run

the file by double clicking on it.

If you are running the installation on a Windows 10/11 operating system a "Security screen" will appear with

information about the new software and it will ask you if you allow it to be executed. You need to either log

in as administrator or select "Allow" if you are already logged in as administrator.

1. The initial welcoming dialog of the installation will appear, from this point you must follow the wizard

steps in order to proceed with the installation. If applicable, keep your "Hardware USB Key" and cutter

unplugged during the installation of the software. Click "Next>" to continue.

2. When the window with the License Agreement opens, Click on the first radio button of the window,

confirming that you accept the terms of the license agreement. (CAUTION! PLEASE READ THE TERMS &

CONDITIONS OF THE LICENSE AGREEMENT CAREFULLY). Then click the "Next>" button. 

3. At the next dialog, you can specify where you want the software to be installed. You can change the

"Installation Folder" by clicking on the "Browse..." button and selecting another directory. Click "Next >"

to continue.
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4. At the next dialog, you can select which file types you want the software to handle. By default, the

application is set to handle all supported embroidery file formats. Click "Next>" to continue.

5. The software is now ready to install. Click "Install" for the installation to begin. During the installation,

you can click the Show details button to view the installation process.

6. During the installation process, multiple dialogs might appear requesting access to install embroidery

machine drivers. Click "Install" to continue.

7. At some point, you will be informed that the installation is finished. Click "Finish" to end the

installation. 

8. Run the software by double clicking on the shortcut (Artistic Digitizer ) that you will find on the

desktop. 

9. A message will appear informing you that you must press "OK" to enter the software key and activation

code you have received with the software. Internet connection is required. In case you have a USB key,

plug your USB key.

10.The "Software key" window will appear. Type the Serial number of your key and the Activation code in

the respective fields and click Activate. If the process is successful, the message “Key updated

successfully” will appear in the messages’ area.

11.Run the software once more by double clicking on the shortcut (Artistic Digitizer) that you will find

on the desktop.

12.The "Registration information" window will appear. This window is a form that you should fill in with

valid information and return by clicking on the "Register" button.

13.You are ready! You can now use the software.

macOS installation

Insert the installation USB flash drive into a USB port of your computer. The USB flash drive is automatically

mounted and you will get an icons named Artistic in your desktop. Double click on the disk drive to open it

and the folder will open from where you must run the "Artistic.dmg" by double clicking on it. Then follow the

step from the 5th step.

If you have a link to download the installation file, you can type it in any web browser’s URL field and

download the file. Alternatively, the installation file is available through the following webpage:

http://www.janome.co.jp/e/e_downloads/artistic_installation_user_guide.html

1. In the Dock area, you can see the download progress.

2. Once the download is complete, the download icon will change. 

3. If you click on the "Downloads" icon, then a list with the latest downloaded files appears on top. Click

on the "Artistic.dmg" file. You will get a warning that this software was downloaded from the internet,

click "Open" to proceed. This only happens the first time that you run the application.

4. The file you've downloaded is a disk image and by clicking on "Artistic.dmg" it is mounted onto your

Mac and you can see its contents. On your desktop, there is an icon for the mounted disk image. If you

accidentally close the Finder window, you can start again by double clicking the "Artistic Digitizer" icon

on your desktop.

http://www.janome.co.jp/e/e_downloads/artistic_installation_user_guide.html


12

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Getting Started

5. To perform the installation of "Artistic Digitizer" you must drag the icon onto the "Applications" folder

icon that you can see. 

6. Drag the "Artistic.dmg" application onto the applications folder icon.

"Notice": Do not double click on the icons because this will run the program through the mounted

media and it will not be installed.

7. Installation is complete and at this point. you can "Eject" the installation media. Right click on Artistic

Digitizer on your Desktop and use "Eject" option.

8. To Run the software, start "Finder" and navigate to "Applications" folder and locate "Artistic"  icon.

9. The "Software key" login window will appear. Now you need to type the "Serial number" and the

"Activation code" into the respective fields. To proceed with the activation, you need to be connected

to the internet. After typing the key and activation code press Activate. 

10.After successful activation, you get a message "Key updated successfully".

11.Now you are ready to start "Artistic Digitizer", go to "Applications" folder and locate "Artistic" 

icon once more. Double click on this icon to start the software. 

12.You are ready to use the Artistic Digitizer.

Maintenance

Modify MS Windows installation 

To activate the program maintenance options please insert the Artistic Digitizer DVD into your DVD-ROM

drive and it will automatically run or double click on the installation file you downloaded. 

Another way that you can activate the program maintenance is: "Start > All Programs > Artistic Digitizer

select Uninstall Artistic Digitizer ".

If the User "Account Control" is enabled you may have to log in as Administrator (If you are not already the

administrator) or select "Allow" on the warning dialog that informs you about a software that requires

administrator rights to run,  to continue with the program maintenance. The Dialog that will appear allows

you to "Add or remove components", "Update components" and "Remove all components" by selecting the

respective option. 

Select the maintenance option you want and click on "Next >" to proceed. Follow the dialog steps to

complete the process. 

Modify macOS installation 

To modify the macOS installation the only thing you can do is to start "Finder" and navigate to "Applications"

folder. Find the "Artistic" icon and drag it into the trash can. Then you must follow the normal installation

process described above. 
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Software key

Together with the software you will get a software key that consists of a "Serial number" and an "Activation"

code. These two numbers can be found in the packaging of the software, and they must be inserted in the

respective fields of the Software key tool. The Software key tool is installed together with the software and

can be found at the bottom right corner of the task bar on MS windows (next to the antivirus) and at the top

right corner of the MAC’s Menu bar. The Icon color will vary, based on its status. To activate the "Software

key", you must insert the "Serial number" and the respective "Activation code".

Generally, at the software start-up (if you have not already activated the software key) you are prompted to

type your serial number and activation code in order to activate the software. In order to proceed with the

activation you must have an active internet connection. After typing the key and activation code press

"Activate" to proceed. if you get a "Key updated successfully" message the serial has been activated and the

software is ready to start. Run the software once more to start it.

At this point we must mention that the software key is a utility that has been installed on your computer and

you can access it on your system tray. If the software cannot be started bring up software key and check the

status of your key. If the key is inactive, you must type your activation code and re-activate. 

Using the software on a different computer

You must click on the "Software key" tool that you will find at the bottom right corner next to your

antivirus (on Windows) and at the top right corner of the MAC’s Menu bar. Click "Logout" while you are

connected to internet.

Windows mac OS

1. You will be logged out immediately 

2. Now you can go to another PC and open the "Software key" login tool by simply running the software.

3. Type the "Serial number" and "Activation Code" in the respective fields.

4. Click "Activate" and the software key will be activated. You can now work with the software on this PC.
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5. To switch back to the first PC or any other PC, you have to repeat the process described above. 

Just remember, every time you want to change PC you have to LOGOUT first and then login on the

other PC. 

Software Update

The software periodically checks for updates and informs you if a new version is available. Consequently, you

will be always up-to-date and have access to the latest features available in the software. 

Windows OS

The software is updated regularly, and the user is automatically notified that there are updates available. The

updates icon  will appear notifying you that there is an update available for the software. 

By clicking on the icon, the installation wizard will open informing you of the update available. Follow the

installation steps to install the update.

You can also check for updates manually. Click on the "Help" menu of the software and select the "Check for

updates" options.

mac OS

Every time the software starts, it checks for updates. If there is an update available a dialog will appear with

information about the update. You have the option to "Install Update", "Remind Me Later" or "Skip This

Version". Click the "Install Update" button to install the latest updates of the software. If you want this process

to be done automatically, check "Automatically download and install updates in the future" and then click the

"Install Update" button. 

Connect external devices

The software can be connected to many external devices such as Embroidery machines, Cutters, Printers etc.

Some of them need be set up inside the software prior to using them. 

Monitor Calibration

Monitor calibration is important to be able to view the actual size of the design you are creating in your

Monitor whenever you set the view port to 100%. 

To do this you have to open Artistic Digitizer software and then select the "Options…" item from the Tools.

The "Options" dialog will appear. Click on the "Monitor" tab.
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Measure the visible area (width) of the Monitor, in the way it is shown in the dialog’s icon and type it in the

respective field. Click "Ok" to apply the change. The next time you select the 100% view setting, you will see

the design in its actual size in the monitor. 

Embroidery Machine connection

MS Windows

Use the USB cable to connect the embroidery machine with the PC. The MS Windows hardware wizard will

automatically start searching for the respective drivers in order to install the machine on the system. During

software installation, many machines will be installed. If MS Windows is not able to find the driver of the

Embroidery machine, you might need to install the driver from the CD that came with the Embroidery

machine. After successful installation of the Embroidery machine, you are ready to send designs from Artistic

Digitizer. 

MAC OS

Use the USB cable to connect the embroidery machine with the computer. MAC OS will connect the device

automatically. You can then send an embroidery design to your machine through Artistic Digitizer. If the

machine is not detected by the software, all the export options will be disabled. 

Supported embroidery machines

Artistic Digitizer supports many machines with different connection types. The available types are: USB, Direct

and WiFi connections. View the list of supported machines below:
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Machine Direct Connection USB stick WiFi

CM17 • • •

MC15000 • • •

MC14000 • •

MC12000 • •

MC11000 • •

MC9900 •

MC9850 •

SKYLINE S9, Atelier 9 • • •

MB-7 • •

MB-4S • •

MB-4 • •

MC1000 •

MC500E, MC550E • •

MC450E •

MC400E •

MC350E •

MC200E / MC100E •

NS-1, NS-a • •
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Getting help

You can find the "User guide", in the "Help" menu of the software. It is called "Help topics" and you can

access it by pressing "F1" shortcut key. To navigate through this help 

 

1. Table of contents: allows you to see all of the information organized by subject. Click top-level entries to

view subtopics. 

2. Index: allows you to look up specific terms or concepts in alphabetical order. Type in a word or phrase.

3. Search: lets you search the full text of the Help for a particular word or phrase.

4. Language selection area: You can select an alternative language for the user guide and also download the

user guide to be available offline. The languages that have this globe icon are viewed online through the

internet, while the languages that have this monitor icon are versions that are also available offline. For

languages that are viewed online, there is an option to make them available offline.

Notice: If you change the language used for the software, through Tools menu, Options tab, on General

section, the user guide will prompt you to download a translation of the user guide if available. 

5. You can also navigate through the user guide using the navigation arrows  

The same manual is included in pdf file format and can be accessed using the option "Printable Help" of

"Help" menu.
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Another help resource is the "Show help on" that can be also accessed from the "Help" menu or by pressing

the "Shift+F1" shortcut key. Show help on: can provide help for a specific tool, area, or function. When you

activate "Show help on", the mouse pointer turns to a pointer with a question mark. Click on any function you

want in Show help on and the subject will be displayed. 

Finally, "tooltips" provide helpful information about application controls when you position the pointer over

icons, buttons, and other user interface elements.

New features

   

Convert images with transparency to stitches without filling the transparent areas

Artistitc Digitizer v.2.0 supports PNG files with transparency and will only generate stitches in the non-

transparent area of the image. This ensures that the finished product has clean lines and does not waste any

thread or fabric by filling in unnecessary spaces. Learn more...

Show - hide objects during editing

This tool is meant to temporarily hide objects from the screen, to facilitate editing of multi-layered designs,

such as fill areas, shapes, and borders stacked on top of each other. The tool practically helps the user focus

and handle underlying shapes and layers, without having to move the upper layers, while keeping them out of

the way. This allows the clearer editing, creating intricate designs becomes simpler and more efficient.  Learn

more...

Support for vertical text 

Artistitc Digitizer v.2.0 offers support for vertical text placement. This feature automatically generates stitches

to fill the designated text area, allowing a seamless integration of vertical lettering into the designs. This

addition offers greater design flexibility and allows for unique visual elements in embroidery projects. Learn

more...

Precise text spacing between characters

Embroidery letter spacing can now easily be adjusted with numeric values. Depending on the design, a

smaller value will result in tighter spacing while a larger value will create looser spacing between letters.

These settings can be adjusted to the user’s liking, allowing for maximum customization of the designs. Learn

more...

Fit the embroidery design in the hoop automatically

Artistitc Digitizer v.2.0 offers the “fit to hoop” option, a unique feature to conveniently fit any design in the

hoop. The software automatically scales the design to fit within the embroidery area of the hoop. No more

manually adjusting or guessing at the correct size -the software takes care of it. Learn more... 

Change the density of stitch designs (.dst, .pes, .jef, .vip etc.)

Artistitc Digitizer v.2.0 allows adjusting the density of stitching in embroidery files like .dst, .pes, .jef, .vip, etc.

within a 25% range. Fluctuating the density adds emphasis to certain features or reduces the stitch count for
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more delicate fabrics. This fine-tuning can also be helpful in compensating for changes in the design’s scale.

Learn more...

Apply Special functions (Trim and Stop) on objects through the Sequence manager

The Sequence manager allows more customization of the designs. The "Trim" function triggers a thread trim

before a specific object, allowing more control over the design process. The "Stop" function pauses the

embroidery machine before stitching the selected object, offering the chance to change thread colors or add

embellishments. This added feature in the Sequence manager allows for even more precise and creative

embroidery designs. Learn more...

Added cross-hair that goes across all screen

Cross-hair tool is expanded to both screens for better and more accurate design creation when using

digitizing tools. Cross-hair provides a clearer visual reference, making it easier to accurately align objects

within a project. Learn more...

Auto add Fix / Lock stitches, if needed, in stitch designs (.dst, .pes, .jef, .vip etc.)

Proper stabilization of the embroidery is crucial to prevent unraveling or distortion. That's Artistitc Digitizer

v.2.0 automatically adds fix and lock stitches, where necessary, to raw stitch designs like .dst, .pes, .jef, .vip etc.

This not only saves time and effort, it also ensures high-quality results with every design. 

Fix: small stabilizing stitches added at the beginning of an object to stabilize it

Lock: small stabilizing stitches added at the end of an object to prevent unraveling.  Learn more...

Replaced Colors dock by a smart edit box and swatches

The old Color dock has been replaced with a more efficient and user-friendly, smart edit box for naming or

inputting color codes, coupled with an expanded swatch display. The edit box allows quick access to specific

colors, while the expanded swatch display provides an at-a-glance view of all available colors. This new setup

streamlines the design process and enhances the overall usability.  Learn more...

Find a specific color by searching with a hex color code or a specific thread color

name/number

Search in the Colors dock is now possible by using a hex code, also known as a hex triplet. Exact shades can

be selected just by inputting the six-digit combination of letters and numbers. Alternatively, a certain thread

of the current thread palette can be located by searching with the respective thread color name or number.

Finding a color has never been easier. Learn more...

New help system

The new help system utilizes HTML for easy updates and allows for greater language accessibility. No need

to download language-specific files as the online repository allows for immediate access to the help content

in any supported language. For those who prefer offline access, downloading the file remains an option. This

system not only streamlines the user’s experience, but also allows for quick updates and improvements

without requiring a software update. Learn more... 
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Manual mode improvements 

Manual mode has been significantly enhanced in Artistitc Digitizer v.2.0 so that experienced users can have

more control over how the software generates embroidery. When switching from Auto to Manual the

software automatically separates fills from outlines, re-arranges items for fewer color changes, and trims

whatever is necessary, in case an object is moved from back to front, to avoid changing the design. Learn

more...

In manual mode, all connecting stitches are visible

In manual mode, all connecting stitches between objects are visible. The software determines whether the

stitch should be trimmed or not, based on the distance between the end of one object and the beginning of

the next. However, this can be overridden by the user. When a connecting stitch is trimmed, locking stitches

will be added to the previous object and fixing stitches will be added to the next object. This allows for more

precise control over stitching and helps ensure high-quality finished products. Learn more...

Objects in Manual mode have either Fill or Pen - not both

In manual mode, objects now have either fill or outline (pen), instead of both. This change provides a more

intuitive user experience, uncomplicated color changes and better aligns with traditional digitizing software,

providing more control over a design.  Learn more...

When loading a stitch file or an artwork file, the new design will have the same name

When loading a stitch or artwork file in Artistitc Digitizer v.2.0, the new design automatically inherits the

name of the file. This allows for easier organization, quick and efficient access to the designs and minimizes

managerial work. Renaming the design during the saving process is always possible. Learn more...

Re-designed object properties

The redesigned object properties in Artistitc Digitizer v.2.0 allows for a more streamlined user experience.

Having moved properties into the design area and having integrated 3D acceleration, makes it easier to

quickly shrink or hide unneeded items to create a more refined view. No need for tabbed views by making all

properties accessible through touch. The "properties" area automatically hides when a tool that does not

allow for selection is being used. Overall, these changes make for a smoother and more efficient design

process. Learn more...

3D adjustments

3D adjustments have been made focused on ensuring the visual width of threads and avoiding

misrepresentation of stitch density. Extra care was taken to ensure that the threads do not appear too narrow,

making it seem as though the stitching is not dense enough. As a result, careful adjustments were made to

accurately represent the design in its true form. These adjustments allow for an as much as technologically

possible precise representation of the design, which in turn refines the design process adding a level of detail

necessary for a trustworthy and enjoyable stitching experience. Learn more...
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Supporting more embroidery machines and hoops

Support for additional machine models has been added, broadening the range of machines, and

consequently the share of the embroidery market which can benefit from the features of Artistitc Digitizer

v.2.0. Support for a wider variety of hoop sizes is also provided, allowing more versatility in designing and

flexibility in user’s choices.  Learn more...

Override default machine selection when stitch files .pes, .jef.jef+ or .jpx are loaded

For those who frequently switch between machines, the "Override default machine selection from stitch file

data" option is a valuable tool. By toggling this feature on, the default machine will automatically change,

based on the imported stitch file. So, if for example, a .pes file is loaded, the machine will switch to a Brother

model. This saves time and eliminates the need for manually adjusting settings before embroidering.  Learn

more...

Bar-code support in Printouts

The Printout feature of Artistitc Digitizer v.2.0 includes a barcode so that embroidery machines which support

this feature can quickly load designs just by scanning the barcode code on the software’s Printout. This

streamlines the production process, saving time and increasing efficiency for industrial embroidery

operations. In addition to design information, the barcode can also contain stitch count and color change

data for even more versatile usage.  Learn more...

Convert vector-based objects to raw stitches for accurate stitch editing

The ability to convert vector-based objects into raw stitches allows for more precise editing, when for

example the stitches of a design are adjusted to match the tension of the fabric, therefore producing better

results on the finished product.  Learn more...

Improvements in the way the Delete object function works

When deleting an object, the next object in the sequence automatically becomes selected. This allows both

the Sequence Manager and the user's focus to remain on the current position, streamlining the workflow and

saving production time.  Learn more...

Improve Hi DPI support for multi-monitor Windows

Updates to Artistitc Digitizer v.2.0 hi DPI support, specifically for larger hi DPI screen sizes, such as 4k displays,

improve both compatibility and user experience on Windows 10/11, no matter the size or configuration of a

user’s setup.

Support ARM native build for new Macs with M processors

The recent release of Apple's M processors has sparked excitement within the tech industry, offering

improved performance and energy efficiency. As Macs continue to transition to these new processors, it is

important to keep up with the change by supporting ARM native builds, thus optimizing code to run directly

on the processor, rather than through emulation or translation. ARM native builds can improve speed and

efficiency for end users, as well as potentially open up new capabilities within the system. Moving forward,
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staying updated with emerging technologies ensures optimum experience for Artistic Digitizer users.  Learn

more...

Limitless undo levels

Users can now enjoy practically limitless levels of undo functionality. This allows a user to freely explore

options and experiment with designs without the fear of losing progress, therefore enhancing one’s creative

freedom.  Learn more... 

Kerning pair support in Pre-digitized fonts for creating accurate lettering designs

Kerning pair support in Pre-digitized fonts allows for accurate, yet aesthetically pleasing letter placement, by

adjusting the space between letters. This is a dynamic functionality which results in smoother and more

refined lettering to ensure that every embroidery design turns out exactly as intended. Learn more... 
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Workspace tour

The main application window consists of a variety of menus, toolbars and various property bars. All these

together with the design tabs are called a workspace. A workspace is any combination of the above

components. The way that the workspace components and windows are placed is fully customizable. When

opening the application for the first time all these tools are placed by default in a way to help you focus on

your task (creating, editing and viewing designs). Make any arrangement on workspace components in order

to have a workspace that matches your personal preferences. More information about customizing

workspace will be provided later on this chapter. Take some time using all the available workspace

components. As you are getting more familiar with the tools and their usage you will improve your

productivity. Let’s take a look at the tools and their default placement.

When the software starts, the "Welcome screen" gives you easy access to application resources and lets you

quickly complete common tasks. The main options are "Create a new design", "Open an existing design" or

start the design "Browser". You can also quickly load any of the recently created designs that appear on a list.

You can select an embroidery machine and one of its  hoops as the default hoop for any created design.

Similarly, the Fabric type and its color. Finally you can open the user guide of the software and watch any of

the training videos.

1. Create a new design.

2. Open an existing design.

3. Start the design "Browser".

4. Select the default embroidery machine and hoop.

5. Select the default fabric and its color.

6. Open the software's user guide.

7. Load any of the recently used files.
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8. Adjust the size of the preview icons, for the lost of the recent files.

9. Watch useful demonstrations about the software.

We will now describe the available workspace components and the ways to customize them. On the top area

of the application window you can see the Title bar, the main menu, the standard toolbar and the "Tools

options" bar. On the left side of the application window you can see "Tools" toolbar. You can also see the

"Used colors" bar and the "Status" bar at the bottom area of the window. On the right side of the design area

you can see Properties tab and the Sequence. Properties bar is a context sensitive bar because it provides

properties for the object you have selected. Each object might have different properties depending on its

size and shape. Let’s take a closer look at all these components.

1.Title bar

This bar is located on the top of the application window. Most windows applications provide file information

and window handling controls via this bar. The default location is on the top of any application window. By

double clicking on the title bar the application changes from maximized state to custom window state. 

2.Main menu bar

Under the title bar is located the Main menu bar. This bar provides access to most of the commands that

control the main functionality of the software. It consists of several menus, click on any of them (for example,

File, Edit, View, Tools) to see the included menu commands.

3.Design tabs

By pressing on the top of any tab you can select the active design. Another way to select the design that you

want to be active is by selecting from the list of the loaded design of "Window" menu. 
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4.Standard toolbar

Standard toolbar, this toolbar is a collection of buttons that serve as shortcuts for the basic functionality of

the application. Most of these icons implement the same functionality in the majority of windows

applications. If you are familiar to any windows application, you have used many times, tools such as new

design, open design, Save, Cut or Paste. Besides these basic file operations, you can use shaping tools (Weld,

Trim, and Intersect), Select Fabric and adjust view options.

5.Tools options bar 

Tool options pane is a context sensitive toolbar. Depending on the tool you have selected from the toolbox

the property bar changes accordingly. It also contains controls that you can use to change the properties of

the selected object. Some of the available tools have extra parameters that appear on the Tool options

toolbar, every time you select them.

6.Design area 

The heart of the software is the design area. All the tools, menus and functions exist to provide functionality

useful during designing process. The design area is the rectangular area inside the application window. This

area is used for creating and editing designs. Any tool you are using from any toolbar affects the creation

inside the design area. You can have many loaded designs in the same window. Every design has its own

design area. Multiple designs are can be loaded in different tabs. By pressing on any of these tabs you can

select which design you want to be visible.

7.Tools toolbar

Tools toolbar, this toolbar contains shortcuts for most of the viewing and designing tools. Selection modes

(Rectangle and Lasso), View port presets (Zoom in, Zoom back, Zoom all, Pan), Slow redraw,  use Text,  and

"Color manager". The tools and their usage will be described later on a separate section each.

8.Properties

The Properties pane contains all the properties that can be customized in the embroidery aspect of the

design. Using the provided options you can change the stitch type of the design easily by just clicking on it.

The Properties pane contains all available parameters for each stitch type. You can see and change the

parameters of selected objects. Just click on a parameter to change its value. When selecting an object the

Properties pane, shows the properties of the selected object. Every stitch type has a different set of
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parameters. The available parameters and the proper way of affecting them will be described later on this

manual, in a different section. 

9.Sequence manager

This tool provides a graphical representation of the embroidery sequence. There are signs to separate the

different types of objects (Embroidery, appliqué). It is often needed to change this sequence, in order to

improve embroidery quality. Any item you select on sequence manager gets selected on the working area.

The extra ability of this tool is that you can re-arrange the sewing order for the current design, and select an

object. Therefore you can organize the sequence of embroidery production in the way you prefer.

Context menus 

The term context menu (shortcut menu or pop-up menu) is commonly used for menus which pop up when

right clicking on an item inside the design area, offering a list of options. The available options vary

depending on the context of the action and the item selected. For example different options appear when

right clicking on a design object than when clicking on the same object in Edit shape nodes mode. The

available context menus are hierarchically organized, allowing navigation through different levels of the

menu structure. Some of the applications functionality can only be revealed by specific context menus. This

kind of logic separates the available actions for each type of object. Select any object, right click on it and

select a function from the appearing menu, just like that you can perform a number of designing tasks.

Status bar 

The status bar displays information about selected objects (such as Width, Height, and Number of stitches). It

also displays information while transforming objects about angle etc, information that assist in more accurate

transformations.

Quick start

The easiest way to get started with the software is by opening an existing design and sending it to the

machine. You can open either any of your own embroidery designs or any of the sample designs that are

included in the software. 

1. From the "Welcome" page select any of the "Recent" sample designs or click on the "Open…" button to

select one of your own embroidery designs.
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2. The design will open inside the workspace of the software and will be ready to be exported to the

embroidery machine. Before doing that select the "Fabric" that you will use, set the Embroidery category

to Smooth and if you want, change the fabric color.
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3. Select the "Hoop" you will be using Change button under the machine icon on the top toolbar.

4. Fron the appearing dialog select the machine manufacturer and model and then click on the hoop you

want to use on the list of available hoops. 

5. After setting the hoop, click on the "Slow redraw" option from the "Tools" bar, to simulate the sew-out

process, before sending the design to the machine.

6. Click "play" icon to view the sew-out stitch by stitch or drag the "current stitch handle" to view it faster.

7. If you are satisfied with the way it sews out, you are ready to export the design to the machine. 

8. Click on the Print icon from the standard bar and make a printout of the design. It will be useful during the

sew-out.

9. Finally select File > Export > To USB storage and a dialog will appear that will guide you to save the

design on a USB Stick. 
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10.You are ready to start embroidering! 

Quick Reference Card

General

MS Windows MAC OS

New document Ctrl+N Cmd+N

Open document Ctrl+O Cmd+O

Save document Ctrl+S Cmd +S

Save As document Ctrl+Shift+S Cmd +Shift+S

Print document Ctrl+P Cmd +P

Export to image Ctrl+Shift+E Cmd +Shift+E

Export to SVG Ctrl+Alt+E Cmd +Alt+E

Help F1 F1

Show Help on… Shift+F1 Shift+F1

Selection

MS Windows MAC OS

Select all Ctrl+A Cmd+A

Invert selection Ctrl+Shift+I Cmd+Shift+I

Top object Ctrl+Home Cmd+Home

Bottom object Ctrl+End Cmd+End

Next object Tab Tab

Previous object Shift+Tab Shift+Tab

Modifications

MS Windows MAC OS

Undo Ctrl+Z Cmd+Z

Redo Ctrl+Shift+Z Cmd+Shift+Z

Select fabric Ctrl+F Cmd+F

Options Ctrl+T Cmd+T

Optimizer options Ctrl+Shift+J Cmd+Shift+J

Repeat last transform Ctrl+R Cmd+R
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Modifications

Group Ctrl+G Cmd+G

Ungroup Ctrl+U Cmd+U

Combine Ctrl+L Cmd+L

Break apart Ctrl+K Cmd+K

Convert to curves Ctrl+Q Q

To front one PgUp PgUp

To back one PgDn PgDn

To front of design End End

To back of design Home Home

Directions Ctrl+Shift+D Cmd+Shift+D

Divide Shift+D Shift+D

Edit Stitches

MS Windows MAC OS

Insert stitches Enter Return

Delete stitches Backspace Backspace

Slow redraw

MS Windows MAC OS

Design's start Home Fn + Left arrow

Previous object Up arrow Up arrow

Next object Down arrow Down arrow

Next stitch Right arrow Right arrow

Previous stitch Left arrow Left arrow

Design's end End Fn + Right

arrow

Designing

MS Windows MAC OS

Insert symbol Ctrl+F11 Cmd+F11

Delete objects Delete Delete

Text F8 F8
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View

MS Windows MAC OS

Zoom in Z Z

Zoom previous F3 F3

Zoom design F4 F4

Zoom all Shift + F4 Shift + F4

Hand tool (pan) H H

Measure F9 F9

Modern laptop and desktop keyboards may have a multi-purpose set of keys in the “function” row.

These keys can perform special actions related to the audio volume, playback, and display brightness,

etc. These keys will often perform these special actions by default according to the preference of the

operating system or the keyboard. If these special keys are performing special actions, then in order

to use them as the classic F1-F12 keys, you need to  hold down the Fn key every time you press any

function key. For example if you need to use Ctrl+F5 shortcut (mac OS Cmd+F5) in reality you need to

press Ctrl+Fn+F5 (Cmd+Fn+F5).



Working with files
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When the software starts, the "Welcome screen" gives you easy access to application resources and lets you

quickly complete common tasks. The main options are "Create a new design", "Open an existing design" or

start the design "Browser". You can also quickly load any of the recently created designs that appear on a list.

You can select an embroidery machine and one of its  hoops as the default hoop for any created design.

Similarly, the Fabric type and its color. Finally you can open the user guide of the software and watch any of

the training videos.

1. Create a new design.

2. Open an existing design.

3. Start the design "Browser".

4. Select the default embroidery machine and hoop.

5. Select the default fabric and its color.

6. Open the software's user guide.

7. Load any of the recently used files.

8. Adjust the size of the preview icons, for the lost of the recent files.

9. Watch useful demonstrations about the software.

Create design

When you start the software you can create a new design through the welcome screen using "Create new"

option. In the welcome screen you can also define the machine you are using and select a hoop for the

created design. Additionally you can select a fabric for the design and a color for it. When you press "create

new" a blank canvas is created with the selected hoop and fabric. You can also create a new design at any

point using "New" option from File menu or by clicking on the New icon  on standard toolbar. Finally you
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can use Ctrl+N keys to create a new design (macOS use Cmd+N ). Now you are ready to start creating from

scratch using all designing tools or import artwork using any of the import options.

Open designs

As in any creativity software there is a file format (.draw) in which the software keeps all the information

about the artwork of the design. Always have in mind to save yours designs into this file format. When

opening a .draw file you have the same design as when creating it. 

You can open a file in various ways, use "Open" option of "Welcome" screen, "Open" option of "File"

menu,  the Ctrl+O keys as keyboard shortcut (macOS use Cmd+N ) or by pressing the open design

icon  on standard toolbar. You can also open files you have located, using the "File

Explorer" (Windows) or "Finder (mac OS)", simply by dragging the file (Artwork or Embroidery) on the

design area in order to be imported into this design or on the design tabs area to be imported into a

new design. 

When using "Open" option, a browse dialog appears and you can navigate through the different folders and

locations of your computer. The folders you navigate may have various files but you can only see the files that

are supported, that is, the files that the software can open. You can filter visible files by selecting a file type.

For example if you want to import a".CMX" image you can select the respective option on "Files of type"

drop-down menu and now while navigating you can see only ".CMX" images. In the same way you can filter

by a category of files. for example if you want to import an embroidery files you can select "All embroidery"

option and then only the supported embroidery type will be listed. By selecting any file you have preview on

the lower part of the dialog.

You can select multiple files using the "Ctrl" (on Mac OS "Cmd") or "Shift" keys and the designs will

appear in separate tabs.

The software can also open various other types which are in reality imported into a new design. You can open

"graphic files" or "embroidery" files, but this is a conversion task. When you save a .pes file to be send to an

embroidery machine, this format has only the stitches information, no information about the artwork. So, if

you open a .pes file for example, which is an embroidery file, it is imported into a new design, but this design

does not have any artwork information about the shapes, it only shows stitches. If you wish to change its size

the results may not be as expected and you can not apply a new style or edit stitch properties. But if you load

the initial .draw file that this .pes file was exported from then you have full set of options available. So any

file type you open may need to be handled in a different way. When opening a vector image it is

automatically converted into an embroidery design, but when importing a Bitmap image the image need to

be converted, so a list of conversion option will come up. 

Notice: When opening a file, that is to be imported into an new file, the software names the new

design after the opened one. 



35

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Working with files

On the welcome screen there is a list with last several files you have saved or recently opened. To open one

of these files, double click on any of them.

Notice: If a Data Loss Warning appears, this means that you are trying to open a .draw file that was

created from a previous version of the software. If you attempt to open the design it will open but

you might lose some information of the .draw artwork. Therefore, every time you want to open a

.draw file from a previous version of the software you should save it with a new file name so the

original file to remain unchanged. By following this procedure, you will be able to work with different

versions of the software and avoid losing your artwork. 

Browser

The “recent list” of the “welcome” tab allows you to locate and open a file with a single click, as long as you

actually accessed that file recently. For the rest of your files, instead of having to remember exactly where you

have saved them on your disc, you can easily locate them by using the “Browser". You can start the "Browser"

by pressing the "Browse" button of the "Welcome" tab or by using the "Browser" option from the "Window"

menu. 

Using the "Browser" tab, you can navigate to any folder on your computer and see preview icons of all

supported files in that folder. For any icon that you click on, you get a preview of the design in the preview

area. 
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1.  Navigation area:

Browse through your "Favorites". 

You can access the content of your favorite folder simply by clicking on it. If you want to remove a folder

from the Favorites list, you can do so by selecting the relative option from the right click menu.

Likewise, you can access the content of your "Recent" folders by clicking on the respective tab.

The folders you accessed recently are automatically added in the list and you can access their content just

by clicking on them. The browser will show the respective content at the "Folder content" area.

In the "Devices" section you can view the computer’s internal storage devices, USB or other memory

external devices and all embroidery machines connected via Wifi.
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More options are available if you right click on a folder.

Most "Windows File Explorer" or "MAC's Finder" abilities are also included in the embedded Browser. If you

right click on a file you get the following options:

· Create "New folder"

· Open the folder inside File Explorer/Finder

· "Refresh" the folder's content
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· Add the folder to favorites list

· Scan the directory's content and add sub-paths to favorites

· Rename the folder

· Copy the folder

· Delete the folder

 You can also move a folder by clicking and dragging it into another folder. 

2. Address bar/Folder path

From the "Address bar/Folder path" you can:

· navigate through the folders by clicking on the name of the folder and selecting another folder from the

drop down menu.

· Click on the Edit/Pen icon and type or paste a specific folder path

· refresh  the current folder

· copy  the current folder path 

· paste  another folder path

· move back and forth with the use of the arrow buttons. 

3.  Search

You can search for a specific design in the current folder by clicking on the Search  button. 

You can search in your designs by "File name", "Date modified", "Stitch count" and "Color count". Each

parameter can be refined even more to get more specific results. After setting the search terms tap on the

Search button to start the search process. Some of the search criteria (Modified, Stitch count and Color

count) may not be available on machine folders.
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Also, when you want to change numerical values, you must tap in the field and either insert the exact value

you want or slide the icon  to the left or right to decrease or increase the value.

Also, character search targets folder names and file names.

File name: search in the file names.

· all: search in all files

· contains: searches for the specified text in the text field anywhere in the file names.

· is equal to: searches for exact match of the specified text, in the text field, anywhere in the file names.

· starts with: searches for the specified text in the text field at the beginning of the file names.

· ends with: searches for the specified text in the text field at the end of the file names.

Modified:

· all: searches to all designs.

· is: searches to those designs that were modified the specific date.

· is before: searches to those designs that were modified before the specific date.

· is after: searches to those designs that were modified after the specific date.

· between: searches to those designs that were modified between the specific dates.

Stitch count: 

· all: searches to all designs.

· is equal to: searches for designs with number of stitches equal to those specified.

· is greater than: searches for designs with number of stitches greater than those specified.

· is less than: searches for designs with number of stitches less than those specified.

· between: searches for designs with number of stitches between those specified.

Color count:

· all: searches to all designs.

· is equal to: searches for designs with number of colors equal to those specified.

· is greater than: searches for designs with number of colors greater than those specified.

· is less than: searches for designs with number of colors less than those specified.

· between: searches for designs with number of colors between those specified.

4.  Folder Content

View the content of each folder and interact accordingly. If you right click on a file you get the following

options:
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· Open the file

· Open the folder inside File Explorer

· Select all designs

· Invert your current selection

· Rename the file

· Copy the file

· Delete the file

If you right click on an empty area you get the following options:

· Create a New folder

· Open the folder inside File Explorer

· Add the current folder to Favorites

· Scan the current folder for folders that contain files and add them to favorites

· Select all files and folders
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You can open designs directly from the connected embroidery machine.

The “Click and drag” ability of files or folder is also supported.

Finally, you can select multiple design by holding the "ctrl" key down (Windows) or the "cmd" key (Mac OS)

and then clicking on the designs you want to select. If you hold the "shift" key down while clicking on more

than one designs, you get to select all those designs at once. 

5.  Preview area

The "Preview area" is located on the right side of the Browser. Whenever you select a supported file, the

preview of the file appears at the "Preview area". You may resize it by dragging the left side and hide it by

clicking on the arrow that appears on the left side.  

6.  Zoom level

With the Icon size bar you can increase or decrease the size of the icons that you are viewing.

7.  View filter

With the "Embroidery" and "Artwork" options you can filter the designs that you are viewing.
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8.  Resize Preview

On the right side of the Preview there is a resizeable area where you can actually preview the selected

design. You can resize that image by using the respective track bar.

9.  Change view

At the bottom bar there is a button  that allows you to change the way you view the designs inside the

Design browser. 

· Minimal : View only the design

· Normal : View the design’s name above the design.

· Details : View the design’s name above the design and more details such as dimensions, number of

colors and number of stitches, bellow it.  

Import files

The software can import files created in other applications and convert them into design artwork. The

supported file types can be separated into 3 categories, the embroidery files, the artwork files and various

design files. Using the option "From file" of menu "File-Import", a Browse dialog appears in order to select

the file to be imported. First you must choose the folder where the file is stored. You can filter visible files by

selecting a file type. For example if you want to import a ".JPG" image you can select the respective option

on "Files of type" drop-down menu and now while navigating you can see only ".JPG" images. In the same

way you can filter by a category of files. for example if you want to import an embroidery file you can select

"All embroidery" option and then only the supported embroidery type will be listed. By selecting any file you

get a preview on the lower part of the dialog. According to the type of the artwork the software responds in

a different way. 
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Artwork

For artwork types, we must mention that there are 2 major types of images files, "Vector" images and

"Bitmap" images. Vector graphics use mathematical equations to draw out your designs. These mathematical

equations are translated into points that are connected by either lines or curves, also known as vector paths,

and they make up all the different shapes you see in a vector graphic. This allows vector graphics to be scaled

to any size without sacrificing image quality. The (*.CMX), the (*.EPS), the (*.SVG), the (*.AI) and the (*.PDF)

files types are vector image types. Although, most of them may include bitmaps (images and photos from

imported .jpg files) objects inside them that will be either kept as bitmaps or be automatically converted to

Cross-stitch or PaintStitch.

The other type of images is "bitmap graphics", which are made up of tiny squares called pixels. Once a raster

graphic is created at a certain size (i.e. a fixed number of pixels), it can’t be scaled up without losing image

quality. Bitmap images are those we capture with our camera or what we usually find on the internet. Widely

used raster file formats are .jpg, .png, .png, .bmp, and .tiff. The software handles each image type in a

different way. Vector images can be directly converted into an embroidery design, while Bitmap images must

be converted and the result of the operation depends on the quality of the selected image. We will describe

the conversion of Bitmap and vector images into the following topics in detail. 

Embroidery

For embroidery files we must mention that the software can import most of the available embroidery file

formats. Select any embroidery file you like (".dst", ".pes" ".jef" etc) and it will be imported as is into your

design. The design is not converted it is just placed into your design and you can add - remove parts from the

design and embroider again. Additionally there is a capability to trace the artwork of the design and convert

it into a vector design and then change the design completely. 

Notice: If you have located any file, using the "File Explorer" (Windows) or "Finder (mac OS)" that you

wish to import, you can simply drag the file (Artwork or Embroidery) on the design area in order to be

imported into this design or on the design tabs area to be imported into a new design.

Import vector images

You can easily can import Vector designs and directly convert them into a design. When you select a vector

file using the open dialog or using "From file" option of "File-Import" menu the software automatically

recognizes and visualizes all mathematical descriptions, of the vector file, that determine the position, length

and direction in which lines-curves that form the shapes are drawn. Once you press open to confirm your

selection the imported vector file is converted directly into outline design.
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Notice: If you have located any file, using the "File Explorer" (Windows) or "Finder (mac OS)" that you

wish to import, you can simply drag the file (Artwork or Embroidery) on the design area in order to be

imported into this design or on the design tabs area to be imported into a new design.

Import bitmap images

Bitmap images are those we capture with a camera or what one usually finds on the internet. Bitmap images,

 are actually made from dots of color. When you import Bitmap images (.jpg, .png, .png, .bmp, and .tiff), they

must be converted during the import procedure. The "Load image" dialog appears to select a conversion

type. You can also change the resolution of the image or select a portion of the image to be imported. The

available conversion options are, "Open as backdrop" and "Auto-digitize /Trace to outlines".

The available handling option are described into separate topics. Using Open as Backdrop the image is

placed on the background of the design area and you can create a design from scratch using the image as a

guideline. Using the "Auto digitize - Trace to outlines" the image will be converted into artwork. 

A preview of the selected graphic file, appears below the conversion types. You can click and drag on top of

the preview, to select a portion of the image to import. Using the circle dots you can re-size the selected

portion or even move the selection. If you're not satisfied by the initial selection use the circle icon to reset

the dialog. 
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You can change the "Resolution" of the imported image by editing the "Width", the "Height" or the "dpi"

values. Change one value and the others are automatically calculated. The image resolution changes

proportionally. If any of the imported image dimensions (width or height) is larger than the default

"backdrop size limit" (29,5cm), the resolution values (width, height and dpi) will be automatically adjusted to

match this limit.

You can adjust the "Backdrop size limit" at the "General" tab of the preferences of the software (Menu

Tools - options, Windows OS and Artistic Digitizer - Preferences, mac OS).

Transparency

The software now supports PNG files with transparency and will only generate stitches in the non-transparent

area of the image. This ensures that the finished product has clean lines and does not waste any thread or

fabric by filling in unnecessary spaces.  When tracing an image the transparent area becomes a solid artwork

. 
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Open as Backdrop

As already mentioned, when you import bitmap images you have an option to "Open as Backdrop". If you

select this option you can import the bitmap image and use it as guideline to draw a design on top of it. It is

very useful for complex bitmap images that cannot be easily traced or you want to embroider only a part of

them. Using this technique to create the design on top of an image you can create the design exactly in the

way you want to be embroidered. Professional digitizers find this functionality very useful.

You can only import one photo as Backdrop. If you have added a Backdrop image and try importing

one more, then the "Open as backdrop" option is not available, unless you remove the previous

backdrop first. 

The image file will appear in the design area as a backdrop (You can not edit it). You can only import one

bitmap backdrop, in case that you want to import multiple backdrops you will have to use an image editor

and make the multiple images a single image by combining them and then import the combined image as a

backdrop. 

Once an image has been added as backdrop, there are some ways to view the backdrop. You can select a

view option using "Backdrop" option of "View" menu. 

· Show - Hide backdrop, using "Hide" option or press Alt + 1 shortcut key – you can temporarily hide the

backdrop image. The Hide option can help you view the embroidery design you have created without

confusing it with the backdrop image at the back.

· Below embroidery, using this option you can make the backdrop visible and position it below the

design you are creating. Whenever you import a Bitmap image as backdrop, the image is automatically

positioned under the embroidery design. Another way to enable this option is by pressing the Alt + 2

shortcut keys from the keyboard.

· Edge enhance: When selecting this view the backdrop colors appear Washed-out and the software

enhances the edges on the backdrop image. This means that the colors of the backdrop will have lighter

tones and the edges will be enhanced. This is very helpful when you are trying to draw a shape (with any
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of the available drawing tools) that will have the same color with the backdrop image. Also, another

way to apply this option is by pressing the Alt +3 shortcut keys from the keyboard.

· Above embroidery, using this option you can position the backdrop image to appear above the design

you have created. This is very helpful. You’ll be able to view the backdrop image and be able to design

the objects that will be on top of larger objects you have already designed. Also, another way to enable

this option is by pressing the Alt + 4 shortcut keys from the keyboard.

Backdrop properties

The Properties option is available only if you have inserted a backdrop Bitmap in the working area. By

selecting the Properties option from the View menu a 3D pop-up dialog appears on the working area with

various options related with the already inserted backdrop. 

The Backdrop Properties dialog includes the following options:

· "Select Backdrop view", by selecting any of the available options you can select how the backdrop will

be visible. 

· First of all you can "Hide" the backdrop temporarily (Alt+1).

· Using "Send to back" the backdrop is placed behind the embroidery you are creating. This option is

enabled by default whenever you import a Bitmap image as backdrop and positions the image

under the embroidery design. Also, another way to apply this option is by pressing the "Alt + 2"

shortcut keys from the keyboard.

· Using "Bring to front" option you can make the backdrop colors appear Washed-out. This means

that the colors of the backdrop will have lighter tones. This is very helpful when you are trying to

draw a shape that will have the same color with the backdrop image. Also, another way to apply this

option is by pressing the Alt +4 shortcut keys from the keyboard. Using "Bring to front" option you

can position the backdrop image to appear above the embroidery design you have created. This is

very helpful in order to view the backdrop image and be able to design the objects that will be on

top of larger objects you have already designed. 
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· Edge enhance: When selecting this view the backdrop colors appear Washed-out and there software

enhances the edges on the backdrop image. This means that the colors of the backdrop will have

lighter tones and the edges will be enhanced. This is very helpful when you are trying to draw a

shape (with any of the available drawing tools) that will have the same color with the backdrop

image. Also, another way to apply this option is by pressing the Alt +3 shortcut keys from the

keyboard.

· Rotate bitmap, using this tool you can rotate your image freely by clicking and dragging the indicator

either way. This tool helps to straighten your backdrop image before starting to draw the embroidery

design. The rotation circle always opens up at the zero position. This tool can help you straighter your

backdrop image before starting drawing the embroidery design based on it.

· Scale bitmap, using Scale track-bar you can change the size of the Backdrop. Drag the track-bar to the

left to reduce the image and drag it to the right to enlarge the Backdrop. You can also scale simply by

typing a new width or Height value and pressing Enter key. The scale tool is very useful in helping you

change the size of the Backdrop image without the interference of any other software. Therefore, you do

not need editing software for Bitmaps to adjust the size of your Backdrops.

· Straighten, using this option you can straighten the backdrop. Press Straighten option and you need to

click and drag to define a virtual straight line that your design will adjust to. For example, if you make a

diagonal straight line on the Bitmap, the Bitmap will be rotated and turn the diagonal straight line into

a horizontal straight line. You can apply the Straighten bitmap option as many times as needed to bring

the backdrop bitmap to the straight position.

· Remove backdrop: Press this button to remove the imported bitmap backdrop. 

Auto digitize - Trace to outlines

The first of the available conversion options is to "Auto-digitize" the image. The software has the ability to

convert bitmap images into curves via tracing, using the integrated powerful Trace tool. The trace operation

converts a Bitmap graphic into a Vector design, which is automatically converted into an embroidery design.

Tracing an image is not an easy thing to do, the quality of the traced image depends on the quality of the

image. The curves that are created can have thousands of nodes depending on the complexity of the image.

The actual trace of such an image may take a while and when a very complex object is created, the post

conversion handling may be difficult for your computer. On the right is a Preview window, which can give you

a quick idea of what the final scans will look like. 
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The Trace Image dialog box can be enlarged so the adjustments will be easier to observe. Click on box, hold

down on the bottom right corner of it and pull diagonally to fill up the screen, or make as large as you want

it. The Trace tab has some options that can help you produce the results you want. Those are:

Scale image:

The outline design when auto-digitizing an image will always open at the default 100% - the original size of

the Bitmap. To enlarge or reduce the size of the produced design, click first on "Scale Image", then type in a

new value above or below the 100% option. You can also change the image size by clicking on up-or-down

arrows (hold down for a speedy change). No matter how you do it, the scaling will always be proportional to

all dimensions of the design: A 35mm x 60mm design will become a 70mm x 120mm design while you’re

adjusting it in Trace Image. Any change in values is automatically changed in Preview.

Accuracy: 

The "Accuracy" option lets you choose how much detail of the original artwork will be in your final

embroidery design. Click on the box to edit this option, which will open with a default Value 5. If you want

your embroidered design to appear as the artwork, click up to Value 8 – the highest degree of accuracy. A

Note of Caution: Depending upon your design, a Value 8 may not produce results best for embroidering

because of excessive details. On the other end of the Accuracy scale, a Value 1 option may not have enough

details to please you. You will find that the Accuracy value varies greatly among bitmap images, so you must

try different Accuracy values to get the preferred result. Each time you change a value, you can see it in

Preview.
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Color limit: 

The Color limit box gives you a choice of how many threat colors you want in your Traced image. Click on the

box. It always opens with a value of the maximum number of colors, but there are several factors to be

considered. If you have a 6-needle embroidery machine, you may want to change the Value 6 with six

threads. The number of threads affects the way the Bitmap image will be converted to Vector design. In the

Preview, you can view any value changes. Another Option: You can go ahead and create your vector design

with 20 colors and then reduce the colors using "Color manager". Having a file of all 20 colors gives you the

option of later sewing your design commercially. Or . . . when you step up to your own big-time machine, you

will have the files ready!

Use background: 

With Use background option you can make the color/object that you will choose from the Preview area

transparent. This is an easy way to remove a specific color/object from the Bitmap image. To edit this option,

click the check-box next to it. Move the mouse cursor over the Preview and it will automatically change to an

eyedropper tool. The color that you will select from the preview area with the eyedropper tool will

automatically become transparent and will fill the color tab next to the Use background option. Only one

color object will become transparent from the design. You can make a different color transparent by

selecting a different color with eyedropper tool from the design.

While adjusting the scale options, the preview is somehow recalculated after each change. You can use the

mouse wheel to have a better view of this preview. 

If you Hold Ctrl key pressed and scroll in or out with your mouse wheel you can zoom in or out at the cursor

point. If you zoom in a lot so that you can see only a portion of the image, you can scroll to the rest of the

image using the mouse wheel. Scroll in or out and you see the preview moving up or down. Hold Shift key

press and scroll in or out to move the preview left or right. 

Additionally, on tools section, there are a few option that can assist during the conversion process. There are

3 options button that are activated when pressed. 

If you enable this magnifying glass icon  , you can click and drag to define a view area. You can also

select a view percentage from this drop-down list.

You can enable - disable the view  of traced nodes and outlines .

You can also enable or disable the view of the original image  and adjust the blending with the traced

artwork using the track bar next to the icon. 
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Finally using the "Trace as Artwork" option the image will be converted into artwork objects and no

embroidery types will be applied. In this way you can create an artwork design, keep the parts you like and

then decide for fill and outline types manually. 

Image from webcam

Another way to import artwork would be to capture a snapshot using a camera that is connected to your

computer. Using "Import from Webcam" option of "File-Import" menu you can take a snapshot with your

camera and import it as when importing a bitmap image. In order to capture an image make sure that your

camera is plugged in to your Computer and use "Import from webcam" option. The camera Preview dialog

will appear as on the following image and you can easily capture anything that you see on live preview by

pressing "Capture" button. Through this dialog you can take snapshots of anything you want. 

Once you press "Capture" on the preview area you can see the captured image instead of the live preview.

Now you can press "Retake photo" if the one captured is not what you have wished and switch back to the

live preview to capture a new image. Once you are satisfied by the captured image, you can click and drag on

the image to select a portion of the image to keep and by pressing "OK" button the captured image is save

as a Bitmap image. When the captured image is saved, it is automatically imported and you are prompted to

select how to handle it. The available conversion options are the same as when importing a bitmap image.
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On the "Settings" tab you can select a camera, if you have multiple connected and adjust the image quality as

well, bu dragging the "Image quality" track bar.  

Image from scanner

The software includes a mechanism that help you acquire an image using your scanner. It is easy to import

any image using your scanner and just like that you can import various images from printed material. First of

all make sure that you have placed the desired image into your scanner and that your scanner is turned on.

Use "Import" - "From scanner" option of "File" menu to start the scan operation. First you need to select a

scanner if more than one is connected to your computer. 

The "new scan" dialog will appear to help you scan anything that is placed on the scanner. Using this dialog

you can customize the scan options and preview the scanned image. First of all you can change the selected

scanner if you have selected one by mistake. According to the scanner software capabilities some options on
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this dialog may appear disabled. For the scanner we have used there are various scanning profiles, any other

scanner may have different profiles. Then you need to place the paper to be scanned, either on the scanner's

flatbed or on the scanner's document feeder and make sure that "Source" is set to scan from the location you

prefer. Then you may be able to select the "Color format", the produced "File type", the resolution in DPI. 

At this point you need to press the "Preview" button to perform a preview scan and you will see a preview of

the scanned image. You can adjust "Brightness" to make the image lightened or darkened, or "Contrast" to

make the image sharper and if you retry preview you will get an updated preview. You can also change the

color format for example change from color to gray-scale scanning and by pressing preview you can see the

scanned image. If you change any option and then "preview", a new scan operation will occur with the new

settings. For some scanners you may have a rectangle on top of the preview area, that you can resize in order

to define the scanned area. When you are done press "Scan" to proceed. When you press the "scan" button

the image is scanned one last time and saved into the "Pictures" folder on your computer. When the scan and

save is done the program automatically opens the scanned image like if you were importing any "Bitmap

image" and you are prompted to select how to use the scanned image.
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Import embroidery files

When you select to select to import an embroidery file, the file is imported as is in the design area. It is not a

normal outline object, as you can see on Properties it is a "Raw" object. This means that the stitches of the

imported design are imported as is, you can not change the stitch type or apply a style. In case that you need

to enlarge or shrink any of the imported embroidery parts, make sure that "Auto density adjust" option is

enabled. When this option is enabled the software automatically adjusts the density of imported part in order

to be suitable for the new size. 

Notice: If you have located any file, using the "File Explorer" (Windows) or "Finder (mac OS)" that you

wish to import, you can simply drag the file (Artwork or Embroidery) on the design area in order to be

imported into this design or on the design tabs area to be imported into a new design.

Change density (Density fine-tune)

You can easily adjust the density of a section, even in embroidery files. Select one or more parts from the

embroidery file and use the Density fine-tune option on Properties toolbar on Fill section. The allowed

density adjustment range will be ±25%. The density fine-tune will obviously be added to what may be

needed due to design scale.
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Convert to Vector design

You can leave the imported part as is and design new parts but you can also convert the imported part into a

normal outline design using Convert to curves option. You can press the respective button on "Properties" or

use the same option through the right click menu. There is also a Hot-key Ctrl+Q. When you convert into

curves then you have full editing abilities The embroidery design will be automatically converted to fully

editable Vector artwork which can be edited. You can also convert only an object or two and have Stitch

objects together with Vector objects in the same file. You can convert specific parts of the embroidery design

to Vector artwork, make the changes in those objects, and then embroider them and keep the rest of the

embroidery design unchanged. Just like that is easy to give life to your old designs. By editing your imported

embroidery files you can give life to your old designs

In such cases you may don’t want to view both stitch and vector objects. You can disable Stitches option of

View menu to temporary hide all stitch objects. You can also hide all vector artwork by disabling Outline

design option of View menu. In this case if stitches option is enabled you can only see the available stitch

objects. Using these View options you will be able to edit your Stitch and Vector objects easier. 

Import ngs embroidery file

There are also some file types that include both vector and stitch data into the same file. The ngs embroidery

files of Wings’ modular software are a typical sample. When you import an .ngs file, you do not have to

convert into curves. The importer reads the outline data from the imported file and you can change the

artwork and recalculate the embroidery result. The outline data of the imported ngs file will be automatically

recognized from the software and will be imported as Vector data. Therefore, the Vector artwork of the

embroidery design will be directly editable. Some ngs files may only contain stitch data. This can happen if

you open a .dst file for, example, which holds only stitch data and then save it as .ngs file format. For the ngs

file to hold the outline data, it must be created inside Wings’ modular from scratch.

Auto add Fix / Lock stitches, if needed, in stitch designs 

In embroidery, it is essential to ensure that each design is properly stabilized to prevent unraveling or

distortion. That's why this new feature in our software automatically adds fix and lock stitches, if necessary, to

raw stitch designs like .dst, .pes, .jef, .vip etc. This not only saves the user time and effort but also ensures

high-quality results with every design. 

Lock: are small stabilizing stitches that are added at the end of an object to prevent unraveling. 
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Fix: are small stabilizing stitches that are added at the beginning of an object to stabilize it.

Convert vector-based objects to raw stitches for accurate stitch editing

One of the challenges of embroidery design is matching the stitches to the tension of the fabric. In order to

make these adjustments, it's often necessary to remove the artwork from the design and work with just the

raw stitches. That's why an important feature for any embroidery software is the ability to convert vector-

based objects into raw stitches. This allows for more precise editing and produces better results on the

finished product. 

You can convert any object to stitches by right clicking on it and then selecting the "Convert to stitches"

option. You can select the same option from the "Convert" button at the top bar. The outlines will be

removed automatically. This will have as a result that every stitch editing you make(inside edit stitches mode)

will be retained during resizing. 

Saving designs

Your designs should always be saved in 2 formats: 
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· "DRAW" is the native format of the software and it is the only format that holds all the design

information (artwork and properties). If you load a "DRAW" file you can start from where you were and

create other variations of your design. This is the only lossless format.

· then you need to save to any stitch file that your machine supports. The software supports many stitch

file or machine formats such as JEF, SEW, DST, EXP, and others.

You can save a design using the "Save" icon on the standard toolbar, using the "Save"or "Save as" options of

the "File" menu or using "Ctrl+S" keys (for MacOS Cmd+S). The dialog shown bellow appears and you can

select a location to save to, choose a filename and using the "Save as type" drop-down menu select a format

to save as. 

On the "Save as type" drop-down only the formats that your machine supports are available. On

"Welcome" tab by pressing the "Hoop" icon, you can select the "embroidery machine" that you are

using and a "Hoop". Your selection is saved as default and it is used in any design you create. So when
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you save a design, you can only select among the formats that your machine supports. For example

Janome machines support (".jef", "jpx", ".jef+")

In general the software supports the following file formats:

Tajima (".dst", ".dsz", ".dsb")

Tajima TBF (".tbf")

SEF xp (".sef")

SWF (".sst")

Pfaff (".ksm",".pcs", ".pcm")

Singer (".xxx")

Happy (".tap")

Melco expanded (".exp")

Brother/Baby Lock/Bernina (".pec", ".pes")

Husqvarna (".hus")

Husqvarna Viking (".vip")

Husqvarna Viking/Pfaff (".vp3")

Viking Designer 1(".shv")

Janome/elna (".jef", ".sew",".jpx") 

Janome/elna JEF+ (".jef+")

Juki(".M3")

Toyota(".10O")

Laesser (".mst")

QuiltCAD (".hqf")

PC Quilter (".txt")

Statler Stitcher(".qli")

CompuQuilter (".cqp/", ".cmd")

Mitshubishi HD (".1??")

Barudan FDR (".U??")

ZSK TC(".Z??")

Print designs

One important step in order to review a design before production is the "Printout". By printing a design you

are getting valuable of information about your design , stitching information, sewing sequence, color

changes, thread colors or codes. You can print the design together with much information that are useful for

the embroidery process or Print the artwork of the design in order see clearly the artwork without any other

information.
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Print design

The printout of the design provides information needed to evaluate before sending a design for production

or to a customer to see if this is what he likes. To print a design, you can press the print  icon on the

standard toolbar, use "Print" option of "File" menu or use Ctrl + P shortcut key (Mac OS Cmd+P). The

following dialog will appear, you can see a preview of the printout of a design.
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In print preview window, we can see a preview of the design together with provided information. On the right

part we can see various customization of the printout. In reality you can select the parts that will be visible in

the printout and customize the options of the print.

· Using "setup" button, you can select a printer and customize the options o f the print. 

· Using "Save to JPG" you can save the printout as an image file in case that you don’t want to print at this

point, but you want to save it for later reference. 

· In "Print" section you can select which parts will be visible. Click on any of the check-boxes in order to

enable/disable printout items. 

· Using "Design only" you can create a quick print of the design only.

· If you have customized the print items and you want to undo, use "Restore defaults" to go back yo to

the default printout. 

· If you want this selection of visible items to be the default for any design, you can use "save defaults"

button. 

· In "tiled printout" section you can customize some aspects of the print, number of pages, orientation,

and scale. 

Print items

Now let spend some time describing the items of the "print" section. Every item of the printout can be

enabled or disabled by clicking on the square on the left of its description. If the item is enabled the changes

can be viewed on the preview area.
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· Header: The header is at the top of the page, showing the size, color changes, number of stitches,

quantity of thread needed, the colors of the design, and their position.

· Name as a barcode: By checking this option the name of the design will appear as a barcode.

Embroidery machines that are capable of reading barcodes can now quickly load designs by scanning

the code on the Printout. You have the ability to change the barcode type from "Tools > Options >

Printing" tab.

· Color changes: The box shows the sequence of the color changes. This information is really useful in case

the design will be saved in a file format which uses “stop” instead of color-change command.

· Sequence icons: The sequence icons are at the bottom of the page. You can see the parts of the design

split with a special function like color change, applique, or stop. Also in the bottom of the icon you can

view the name of the color that should be used, plus comments.

· Information: Information is at the bottom of the page. The information area lists and describes the

components of your embroidery design. The information is sent from the program to the component

presets you have selected.

· Company name: The company name, which is at the top of the printout, can be changed by using the

Printing tab of the Tools > Options dialog.

· Orientation: The orientation is the icon shown with the "R" character at the top right corner of the

printout. This is important because it shows how the printed page should be put on the embroidery

machine to identify the starting point of the design.

· Binder space: This option makes the necessary margin (on the left side of the page) in case you want to

put the printout in a folder.

· Stitch count: The number of stitches in your design can be viewed at the header of the printout. This

Stitch count is important for commercial use when the number of stitches is used to calculate the

embroidery price.

· Start point: This option shows or hides the starting point of the design, marked with the  icon.

· 3D-preview: Select if the design will be displayed in 3D-preview mode.
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· Fabric: Hides or Shows the fabric behind the design.

· Fill areas:  You may now print only the design's outline, hiding any objects from within. This is great for

making templates and for quickly visualizing a design's final placement.

· Hoop: Hides or Shows the embroidering area (doted line) of the selected hoop with a dashed line

around the design. If your design is position outside this line you will have problems embroidering the

design on a hoop that has the same dimensions (You might damage your machine).

· Grid Line: A grid has been added to the printout for accurate measurements and placement of the

designs. When producing intricate patterns that require many hoopings and design placements, is a

tremendous time-saver. The grid will become visible only if the Fabric or 3D-preview option is

unchecked. 

Tiled printout

This section manages the way that your design will be printed. When the printout dialog is called up, the

first two fields indicate the number of pages needed for printing: "X" for horizontal and "Y" for vertical; the

number of designs printed on each page can be changed by using the arrows on the right hand side or with

the mouse wheel. The changes you make can be viewed on the print preview as you make them.
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The Portrait option specifies how the design is positioned on the page. If it is enabled, then the design is

printed vertically as a portrait. If disabled, then the design is printed horizontally as a landscape. 

The Scale field shows if the design will be depicted smaller than its actual size and the percentage of the

reduction. The first time that the printing dialog is used, the software finds the best way to show the design

in actual size with the least number of pages. 

Using Autofit option you can adjust pages and orientation to make the printout 100% of the actual design.

Finally at the bottom of the right area of Print preview dialog there is a control that you can use in order to

set the number of stitches that you want to be viewable in the respective area of the printout. Click on the

editable area and type the value you want to appear in Printout.

Print Artwork

Using "print artwork" you have the ability to print only the artwork of your design. You can use this option in

case you want to print on a special paper for textile printing. Then you can iron the paper on the fabric and

apply the design on the fabric. You can also combine textile printing with redwork embroidery and create

unique and stylish designs on garments. To print the artwork of a design, use the "Print Artwork" option from

the "File" menu. A "print preview" dialog will appear, and you can select a printer, save into JPG file and

customize the visible parts as described in previous section. 

At the right side of the Print artwork dialog you can do the following:

· Select Print options: From this drop down menu you can select the printer you want to send the printout.

Also, you have the option to save the printout as PDF file with the "Save as PDF" or as jpg image file with

the "Save as JPG". 

· Page Setup...: In this dialog you can change the page settings of the selected "Print option". You can select

the page "Size", "Source", "Orientation" and "Margins".

· Print: At this section you can select what will be print on the print out. There are the informational option

and the artwork options. The informational options are the "Header" and the "Binder space". The design
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options are the "Artwork", "Embroidery", "Applique", "Backdrop" and "Mirrored". If they are checked they

will be visible (the artwork of the option) and if they are unchecked they will not. The "Mirrored" option

allows you to make a mirrored image of the artwork you want to print. 

· Design Only: This option disables the "Header", "Backdrop", "Mirrored", and "Binder space" options from

"Print" and leaves only the design options ("Artwork", "Embroidery", "Cut", "Stencil", "Paint", "Applique",

"Crystal").

· Restore defaults: Restores the default settings of the dialog

· Save defaults: Saves the current settings as default.

· Tiled printout: In this section you can change the 'X' (horizontal) and 'Y' (vertical) repeats of the pages. If the

design does not fit in one page, the software will automatically fit it in two pages, while trying to keep the

design's size to 100%. You can also select, if you want that pages to be portrait or landscape by checking

the "Portrait option".

· Autofit: This option adjust pages and orientation to make the printout 100% of the actual design.

Export design

You can export any design you create in many embroidery formats, as embroidery image or for quilting, or

even as vector file to be used by another program.

Export to Dropbox

The software includes a mechanism that can be used to export designs to "Dropbox". This is not just an

export procedure, the exported designs are synchronized to "AcuDesign" iOS application for iPad / iPhone.

The uploaded designs are organized into packages. 

You can access this mechanism from "File" menu – "Export" - "To Dropbox" option. 

In order to "Export to Dropbox" you must first authorize the software to create an "Artistic" folder into

"Apps" folder of your "Dropbox" account. The appearing dialog is informing you about the authorization

process. 
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1. Click on "Get code from Dropbox" button and your default internet browser will load the "Dropbox"

authorization page.

2. Sign-in by using your Dropbox account credentials and/or authorize the application by pressing Allow.
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3. The Dropbox will create an authorization code that you need to copy and paste into the "Connect to

Dropbox" dialog.

4. Switch back to the software and press "Paste" to enter the copied authorization code into the respective

field. The you must press "OK" and you are ready to start using the Dropbox Upload dialog. Now the

application is connected to your Dropbox account. 

5. A folder called "Artistic" has been created into "Apps" folder of your Dropbox account. The exported

designs are placed into that folder.
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6. The software has read and write access to this folder only. Any designs that are exported can be

added / synchronized with the designs on "AcuDesign" iOS application.

Notice: In order to have your files synchronized please make sure that "Enable Dropbox" option of

"AcuDesign" settings is in ON state.

7. If the authorization is not successful the message of the following figure will appear. If something went

wrong and the authorization failed you must start over again, using the "Export to Dropbox" option of

"File" menu. 

8. After the successful authorization the Dropbox Upload dialog is grayed out. The only option that is

available is the plus sign in packages section. In order to upload a design we must first select a package

for the design. As we have already mentioned the uploaded designs are organized into packages. A

package is a collection of designs. Using the plus sign you can create as many packages you like, the only

thing that you must define is the package name. 
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9. We have created a package called "Hearts".

10. The Uploaded design will be a part of "Hearts" collection. 

First we must select a package for the

design. In our case we only have one

package. 

Type a name for the design.

Author name the dialog automatically

detects the user name of the computer but

we can change it in anything you like. 

Type Keywords, comma separated, that may

help you in case that we search for a

design. 

Select a category that the design will

belong to.

We can add a short description about the

design and if there are things that we must

remember about its production or anything

else.

Finally, we must press Upload to send the

design to Dropbox.
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11. A confirmation message about the upload success appears. Using Export to Dropbox option of Artistic

Digitizer we have uploaded a design into Dropbox. In the same way we can upload as many designs we

like. As we can see on the following figures in our Dropbox account in Apps - "Artistic", a folder called

"Hearts" (package name) was created (Upper part of the following figure) and the uploaded designs were

placed into that folder (as we can see on the lower part of the following figure).

12. From now on you can create packages and upload designs to Dropbox with just a few clicks. Let's

switch to "AcuDesign" to see how these designs are synchronized to the design collection of "AcuDesign".

Make sure that "Enable Dropbox" option of settings area is set to "ON" state. 

13. In "AcuDesign" category view, the uploaded designs are placed into a special section called

"Imported". You can tell which designs are imported from Dropbox by the respective icon that is on the

design preview.
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14. In package browser we can see the created package and the designs that belong to it.

Export embroidery image

 In many cases it is very useful, for decoration or archive reasons, to export a to an image file. In order to

export the embroidery design to an image file, once you have created a design, you have to follow the steps

below:

1. Use "File" - "Export" - "To image" option or press Ctrl+Shift+E shortcut key (for Mac OS Cmd_Shift+E).

2. A "Save dialog will appear, browse to the location you want to save the design,

3. Define a name for the image file.

4. Select the image file type you want, using "Save as type" drop down menu. The options you have are

Tiff (*.tif), PNG (*.Png), Jpeg (*.jpg, *.jpeg) and Bitmap (*.Bmp).
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5. There are also some more adjustments, DPI, Fabric and Backdrop options, once you are ready click

"Save" button and the image preview of your design has been saved to the selected location.

Change image resolution

You can adjust the resolution of the produced image by changing the DPI (Dot Per Inch) value. The DPI

expresses the number of dots a printer can print per inch, or that a monitor can display, both horizontally and

vertically. The resolution of an image is measured by the number of dots per Inch that it consists of when it is

printed. The DPI value that you will choose affects the image quality. The DPI value that you can enter in the

DPI field can vary from 60 to 600. Generally images that are created only to be displayed on computer

monitors are 72 or 96 dpi and images that are created for the internet are 72 dpi. In addition images created

for printing on desktop printers are between 150 to 300 dpi, while images for professional printers are usually

300 dpi or higher. We propose for better embroidery effect results to set the dpi value more than 150 dpi.

With resolution near to 160 dpi you will be close to the real dimensions of the design and you will get a

proper representation of the embroidery effect by avoiding re-sampling the original image. For textile

printing it is better to use the highest possible resolution of 600 dpi for more realistic results.

Include fabric option

With the Include fabric option you can decide whether you want the exported image to have fabric

background or not. With a fabric background you could have a realistic preview of the design with the

selected fabric. The preview will look very much alike to how the design will be embroidered on the actual

fabric. If Include fabric option is selected, the fabric that is used for the design will be added as a background

in the exported image. If the "Include fabric" option is not selected, the exported image will not have a fabric

background. For Bitmap, Jpeg and Tiff files the background will be a solid black color and for PNG files will

be transparent. 

Include backdrop option

In cases when we digitize based on a backdrop, it would be very useful to export the design with the used

backdrop. In this way we can review the design in comparison to the design source in order to improve any

aspect of the design we like. If this option is selected, the Backdrop that is included in the design will be
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exported to the image, as seen on screen. To be able to export the backdrop, the desired backdrop must be

visible. 

The images that will be exported can be used as artwork in various graphics designing projects. The

embroidery image artwork can be used from embroiderers to present their work or promote it. They can print

it on any fabric to visualize the actual size of their work or create brochures with their designs. It can be also

used to make combinations, e.g. of printed embroidery effect on a T-shirt along with actual embroidery. This

is a market trend which combines both embroidery and printing on garments. In addition, embroidery

images can also be used for decoration of envelopes, birthday cards, business cards or any other graphics

creation that could have embroidery-like images on it.

Export to SVG

The artwork of anything that you create, can be exported to a special file type, SVG file, that contains only the

artwork. The exported SVG file can be used for printing purposes or for creating combinations of embroidery

and textile printing on garments. To save your design as SVG (Scalable Vector Graphics) file by following

these steps:

1. From "File" menu, expand "Export" submenu,

2. Then use the "To SVG" option. Another way to activate "To SVG" option directly is by pressing Alt+E

shortcut key.

3. A save dialog will appear, define a name for the file. Find the location you want the design to be saved

4. Click the "Save" button to export the design in SVG file format.

Once the SVG file is saved, you can edit it in any Vector design editor. The design can also be imported back

into the software and you can create another variation. By keeping the artwork separately, it’s ready to use

again if you need to create a similar embroidery design. 

Send to machine / USB

Using this "to Machine" icon, you get access to various hoop and export options.
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· Send by WLAN:  The "By WLAN" option allows you to send a design via Wireless Lan to an embroidery

machine if supported and you are connected properly to the machine via WLAN. This option is available

only when machines that support WLAN connection are available. 

· Send by Cable Connection: The "By cable Connection" is used to send a design through cable connection to

the machine. The machine must be connected to the computer by USB cable.

· Export to USB storage: Use the "To USB storage" option to send the design to a USB storage drive and then

plug this removable storage device to the embroidery machine and load the design you want.

· Change machine - Hoop: By default when creating a design the default hoop and machine is used for the

design. Using the change option you can change the machine and-or the hoop, if you want to send the

current design to another machine or hoop. The "Edit hoop" dialog hoop will appear to select an

alternative machine and-or hoop. The default applied Machine and Hoop can be changed by pressing the

Hoop icon on the Welcome tab. You can also change the Machine / Hoop using the respective icon on

Tools toolbar and even create designs with multiple hoops.

· Center to Hoop: Using this option you can center the design into the hoop automatically. This is an easy

way to align the hoop with the design and the design will be then centered to the hoop.

· Fit to Hoop: With this option you can fit any design into the selected hoop. Simply click on the "Fit to hoop"

option, and the program will automatically scale the design to fit within the usable area of the hoop. If the

design is larger than the usable area of the hoop it will scale it down to make it fit. On the other hand if the

design is smaller that the embroider-able area of the hoop it will scale it up to make it fit. The software

always keeps a safety distance from the hoop's edge. If the software finds that the design fits better if the

hoop is in landscape mode, it will rotate the hoop and make it fit.

The available options on this dialog depend on what the selected machine supports and if you need to send

something to your machine, your machine must by first selected for this design. The choice of machine

determines the available hoops, connections and file types for export. Now according to the selected

machine the software, the software provides the available ways to connect to the machine and transfer files. 

For example if you select to connect to Janome "Memory Craft 1500" , this machine supports Direct Usb cable

connection and Wireless connection. 

If the machine is connected to your computer, either via USB or via WiFi to your network you will see a "By

cable connection" or a "by WLAN" option on "standard" bar and on "Export" section of "File" menu. Using

any these options you can connect to the machine and transfer designs. The software automatically detects if

the selected machine is currently connected to the PC USB port.
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Send by WLAN 

The "By WLAN" option allows you to send a design via WiFi to your machine. First you need to select your

machine in case that there more machines of the same type on the same network. In case there seems to be

no machine available, make sure that your machine is turned on and connected to the wireless network. Then

press "scan" to see if your machine is detected. When your machine is connected, you can see the available

storage places of the machine. Select any of the available storage places of your machine and click to view

its contents. Define a name for your design and press "Send" to save the current design to the machine.

  

Send by Cable Connection 

Likewise, if you use the "To machine name" option, the dialog of the following figure will appear and you can

send a design through cable connection to the machine. Select a name for the design and then select a

destination place from the right area. Now by pressing the arrow that is pointing to the Sewing machine area

the design is transferred to the connected machine.
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When using "To machine" option make sure that it is physically connected to your PC. if there is a connection

problem you will see a confirmation message if you try to send a design while the machine is unconnected. 

Export to USB

Use the "To USB storage" option to send the design to a USB storage drive and then plug this removable

storage device to the embroidery machine and load the design you want. Using the "To USB storage" option

the following dialog will appear and you can select any of the connected storage devices and save your

design. Once you select a storage device you will see have the available folders on the right area. Click to

select a folder, provide a name and by pressing "OK" the design is saved to the USB storage device.
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if this is the first time that this storage device is used the program will prompt you to prepare the necessary

folder structure for the selected machine. You can select a machine, that you are working with, through the

"Welcome" tab by clicking on the "Hoop" icon or by pressing "Hoop / Machine" icon on tools bar and then

as you can see on the following figure, you need to select the manufacturer "Company", the model of the

"Machine" and once you select a hoop, your selection is applied. The software will remember you selection

and from now on you do not need to change the selected machine unless you want to connect to another

machine. 

The USB storage device must be formatted using the "Fat32" file system in order to be able to

correctly save designs for most of the embroidery machines.



Selections
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To make changes in your design, you must first select the objects to be manipulated. There are various way to

select the objects you like. The "Select" tool  is the most frequently used selection tool but there are also

various other way to select objects. Besides from using the mouse for your selections you can also use the

keyboard or Select by stitch type, when you want to select all objects of a specific stitch type or Select by

color if you want to select all the objects that are using a specific color. In the following topics we will

present all the available selection ways.

Select with mouse (click)

In order to edit objects you need to select them first. By default when starting the program and when no

other tool is selected the program is in the default Rectangle selection  mode. This is the default

selection mode, what ever you click gets selected and if you form a rectangle on the design area and all the

object(s) that are in this rectangle become selected. if you have any other tool and you want to go to

selection mode simply click on the  rectangle selection icon . So the easiest way to select an object, is to

simply click on it using your mouse. A highlight rectangle appears around the object to reveal that it is

selected. This is helpful for not losing your current selection when you have to work on a complex design. This

section covers selecting objects with a mouse. To select multiple objects, hold "Shift" or "Ctrl" keys and then

click on the objects you wish to select. The difference in the usage of "Shift" - "Ctrl" keys is that when pressing

"Shift" key you can only add to selection. If an object is already selected and you click again it remains

selected. When holding "Ctrl" key you can add or remove objects from the selection. If the object clicked on

is not already selected, it will be added to the selection. If it is already selected, it will be deselected. 

Multiple selections can also be created by forming a rectangle around the objects you wish to select. Hold

left mouse key pressed and drag to form a rectangle around an object, once you release the mouse it gets

selected. Likewise, if there are multiple objects inside the formed rectangle they are all selected. All objects

that are completely within the rectangle that is formed get selected. 
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if you hold "Alt" while forming a selection rectangle the objects that are partial into the formed

rectangle also get selected. This is an easy way to select objects which are large and have irregular

shape.

Besides the rectangle selection tool, there is also the lasso selection  tool. If you move you mouse on top

of the rectangle selection tool a fly-out toolbar will appear showing both (Rectangle and Lasso) selection

icons, click to select the one that you want to use. When lasso is selected instead of forming a rectangle you

now click and drag over the design area in order to draw a freehand selection line around the objects that

you want to select. Release the mouse and all objects that are entirely inside the shape are automatically

selected. This is an easy way to select objects which are large and have irregular shape.

The last used selection tool is visible on the toolbar. You can click on its icon to start using for your selection,

or place the mouse over the selection icon and from fly-out menu select the alternative selection tool. You

can also use "Ctrl", "Shift" and "Alt" key, as described above to make multiple selections using lasso selection

or include partially covered objects.

There is an option "Allow polygon selection with lasso" in Options dialog, Tools tab. When this option is

enabled you can click while forming the Lasso selection and by specifying the nodes of a shape you can

create a polygon shape selection with lasso. 
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Note: By default the Rectangle selection  tool is the default selection tool. You can set the lasso

selection  to be the default selection tool from the Tools tab of the Options dialog box that is

located under the Tools menu.

Select with hotkeys

Most selecting of objects is done using the mouse, however, there are a few preset selection option that you

can access through "Edit" menu or using some handy keyboard shortcuts.

Select all

Using this option from the "Edit" menu, or by clicking the shortcut key "Ctrl+A" (for Mac OS Cmd+A), you can

select all the objects in the design. This option is useful when you want to modify all the objects of your

design at the same time. Any change will be applied on all selected objects at the same time. 

None selected Select all

Invert selection

Using this option from the "Edit" menu or using "Ctrl+Shift+I" (for Mac OS Cmd+Shift+I) shortcut key, you

can invert the object selection, select all unselected objects, and vice versa. This option is useful when you

want to select a larger portion of a design. Select a small object or group of what you don’t want, then

choose Invert selection to capture the larger portion. You’ve selected the portion you want in this reverse

process.

Selection  Invert Selection

Select none

There are various ways to deselect everything. First you can click with your mouse at any point outside of the

created design and everything will become unselected. We can also use "Select none" option of "Edit" menu

and nothing is selected. This function is the opposite of "Select all" function where you are selecting all the



81

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Selections

designs in the working area. It is useful when you want to clear your current design selections to make a new

selection 

Navigate through objects

There is also an easy way to navigate through the design objects using hotkeys. The shortcut key has the

following functionality:

· Using "Ctrl+Home" hotkey you can select the first object of the design (for Mac OS Cmd+Home) .

· Using "Ctrl+End" hotkey you can select the last object of the design (for Mac OS Cmd+End).

· Using "Tab" hotkey you can select the next object of the design. If nothing is selected the first object of the

design will be selected. Each time we press the "Tab" key a different object will be selected, which is the

next in the designing order of the design. If we continue pressing the Tab key, we will continue changing

objects, until we reach the last object of the design.

· Using "Shift + Tab" hotkey you can select the previous object of the design. If nothing is selected the last

object of the design will be selected. Each time we press the "Shift + Tab" hotkey a different object is

selected, which is the previous in the designing order of the design. If we continue pressing the Shift + Tab,

we will continue changing objects, until we reach the first object of the design.

Select by stitch type

Sometimes it is very useful to select all the objects, of the same type. For example you may need to select all

satin objects and apply a color change or any other transformation. To do so "Right click" on the "Satin" icon

 on Properties toolbar and from appearing menu use "Add Satin to selection" option. If other objects

were already selected, then the satin objects will be added to the current selection. If the type you wish to

add to selection is not visible on properties toolbar, you can click on the icon to expand the list of fill or

outline types and then right click on the desired type. In the same way, you can use Add to selection option

from the right click menu and select the stitch type from appearing list. 
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Likewise, it is easy to remove the objects of a selected stitch type from a selection. For example right click on

Satin type and use "Remove Satin from selection" option, if you wish to deselect all satin objects or use

Remove from selection option and select the type you wish to be removed from the appearing fill or outline

list. "Selections by type" makes your life easier, especially for big and complicated designs object, and apply

your embroidery changes to your entire selection. 

Select by color

In many case it is very useful to select all the objects that are using a specific color. This option is very handy

when you want to replace a color for example - it is not necessary to select the objects manually. You can

change color, stitch type, apply a style or any other transformation you want. You can select Fill color, by

Outline color or simply by color. In order to make a selection by color you need to right click on the color you

wish to select on palette bar. If you right click on a "Fill" color then you can choose to select all objects that

are filled with this color or all the objects that are using this color for either fill or outline. In the same way, if

you right click on an outline color, you can select all objects that have this outline color or all object that have

this color for fill or outline. 

Select on sequence manager

Sequence manager is a visual assistance tool that provides a graphical representation of the designs

overlapping order. The functionality and capabilities of sequence manager are described later in this manual.

At this point we will mention only the selection capabilities that it implements. If you click on any item on

sequence manager then and it gets selected on the design area. You can see the specific item selected in the
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design area with a highlight rectangle around it. You can also select multiple sequence items by holding

"Ctrl" key and clicking on the items to be selected (On Mac OS use "Cmd" key). 

1 sequence item selected Multiple sequence items selected



View your designs
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In this section we will present all the available ways and tools that can help you have the best view while

creating or editing your designs. Additionally we will present the various view modes (3D preview, stitch view,

thickness view) and the customizations of the available workspace components. You can easily change the

view of a design by zooming in to get a closer look or by zooming out to see more of the design. You can

experiment with a variety of zoom options to determine the amount of detail you want. Panning and

scrolling are two additional ways to view specific areas of a design. When you work at high magnification

levels or with large designs, you may not be able to see the whole design. Panning and scrolling let you move

the page around in the design window to view previously hidden areas. You can use the Pan tool to pan

around a large image and view particular areas. 

Zoom tools

The easier way to change the view, during any digitizing or editing process is by using the mouse wheel. By

default if you use the mouse wheel, the wheel scrolls horizontally. In case that you want to zoom in and zoom

out using the mouse wheel you need to hold "Ctrl" key (For Mac OS "Cmd") while you move the wheel and

the wheel switches temporary to zoom mode. Finally if you need to scroll vertically, press "Alt" key while you

move the wheel. Additional you can change view using the available zoom tools on "Tools" bar (Zoom in

, Zoom previous , Pan , Zoom entire design , Zoom all ) or by selecting a zoom preset

value from the lower right corner of the application.

Zoom in 

Using the "Zoom in"  tool, you can zoom in by clicking and dragging to select a specific area to magnify.

You can also access the Zoom in function by pressing the Z key. Using this tool you can enlarge the portion of

your design to check on details. Select the "Zoom in" tool from the "Tools" bar and the cursor will become a

magnifying glass. Then, click at the point from where you want the new view port to start and drag the mouse

holding the left button. The area you marked will be the new view port. 

Zoom previous 

Using "Zoom previous"  this option you can get the previous zoom view of your design. The new view

port will be the same as it was before the last zoom-in. You can activate "Zoom previous"  from the

"Tools" bar. if the icon is not visible, place the mouse cursor over "Zoom tools" are and all the zoom tools
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will appear. Click to select the "Zoom previous" tool, the Zoom Previous tool will become the current tool  on

Zoom tools area. You can also "Zoom previous using F3 shortcut key. 

Pan tool 

The "Pan"  tool lets you move a design around your screen like you would move a paper around on a

desk with your hand. You can activate the Hand tool (pan) function using the "Pan" icon on Tools toolbar or

by pressing the H shortcut key. The cursor will change to a hand like the one on the icon and you can use it by

clicking and dragging on the screen. Another way to Pan is using the mouse wheel, if you scroll up or down

you can move upper or lower and if you hold "Alt" key and scroll the mouse wheel up and down you can

move to the left -right.

Zoom Entire Design

Using this option you can view the whole design fitted into the visible screen. You can activate the zoom

entire design  function from the "Tools" bar, on "Zoom" section, or using the key F4. If you have a multi-

functional keyboard, make sure that F keys are not locked. 

Zoom All

Using this option you can view the hoop and the the entire design fitted into the visible screen. You can

activate the zoom-all  function from the "Tools" bar, on "Zoom" section, or using the key Shift+F4. If you

have a multi-functional keyboard, make sure that F keys are not locked. 

Zoom presets

You any one of the zoom presets, using the menu that appear on the lower right area. The zoom presets that

you can choose from are 25%, 50%, 75%, 100%, 125%, 150%, 200%, 250%, 300%, 400%, 500% and 600%. If you

set the exact size of your monitor, from the Monitor tab of the Options  dialog box under the Tools menu,

every time that you will select the 100% of the zoom presets you will view the design in its actual size.

Measure

The measure tool calculates the distance between any two points in the work area. You can activate the

measure tool function from the Tools toolbar icon  or by pressing the F9 shortcut key. With this tool you

will be able to measure any time you need to know the size of your embroidery design, or any portion of it.

Click and drag from any point that you want to start the measurement from until the point you want to

measure. A virtual line appears from the starting point to the point where the cursor is and displays the

distance the distance is displayed under it.
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The software remains in this Measure mode until the user selects another mode.

Units

With this drop down menu you can specify the unit in which the length will be displayed.

· Millimeters: With this option selected you measure the length in Millimeters

· Centimeters: With this option selected you measure the length in Centimeters

· Inches: With this option selected you can measure the length in Inches

Design view

You can select to view your designs in various ways, "3D preview", "Stitches" view and "Outline" view. By

default the software is starting with a realistic "3D preview" that shows how the design would look when

embroidered. The stitching style, the color of stitches and the way which the design will be sewed give you

the perception of a real embroidered result. In the "3D preview" the threads are much thicker than in the

"Stitches" view. You can switch from "3D preview" to "Stitches" view, by clicking on the "3D preview" option

of "View" menu or by pressing "P" key. The "3D preview" is switched off and you are on "Stitches view". Now

you can see the stitches as lines. You can also enable-disable the view of the stitches using "G" key. When in

"Stitches" mode, you can also disable "Stitches" and go to "Outline" view. In this view you can only see the

artwork of the design, so it is easier if you want to edit the artwork of the design. This view also makes it

easier to see all of the parts in the design and to make adjustments. 
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3D preview Stitches view Outline view

When you are on the "Stitches" view, there is an additional option "Stitch points" on the view menu. When

this is enabled, you can see the actual stitch points. Stitch points are the points where the machine’s needle

bores into the fabric. With this view, you can distinguish the stitch length, density, and bore points. 

Thickness view

This option is very useful in order to create professional looking designs. Stitches that fall on top of other

stitches don’t create nice embroidery. There may be times when we intentionally choose to let this happen to

create a special effect, but in the majority of cases we’ll want to know whether stitches fall on top of the

other, in order to eliminate it. You can enable "Thickness view" by using the respective option from the "View"

menu and then you can see the design in a special way where you can actually stitches that are on top of

other stitches appearing with darker color. Green are non overlapping stitches, yellow is stitches with minor

overlapping and red is multiple stitches one on top of another. To return to the previous view, you need to

click on the same option once more.
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Overlapping objects  Thickness View

Set light source

When in "3D preview" there is a way to change to change the light source of the 3D preview. Using "Set light

source" of view menu a special dialog appears with a 3D ball. On the 3D ball there is handle that shows the

current light source. Click and drag this handle on the ball to change the source that the light comes from.

You can also adjust the Intensity of the light that illuminates the threads. By clicking and dragging the

"luminosity" track-bar to the left the light decreases and to the right the light increases. Select the amount of

light you want to illuminate your embroidery designs. It is a 3D tool that gives you the ability to illuminate

your design from different angles. The best way to make the adjustment accurately is by having an

embroidery design loaded prior activating the "Set light source" option. Any change you are making is

immediately previewed on the design allowing you to make accurate adjustments. You can also use "Save"

this light source as default, in order to have by default for every design. Once a default value is selected and

saved as default it will be used for every new design. You can also use "Reset" to default in order to reset the

light source to the default value.
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View Grid

You can enable-disable the view of the "Grid" using the respective option of "View" menu. When "Grid -

Show" is enabled the grid will appear on the working area. The Grid appears as vertical and horizontal lines

with a virtual ruler on the edge of your design area. This values on the edge of the design area, are the values

of virtual X and Y axes based on centimeter or on inch values. The grid can help you draw, size and align the

objects precisely and create the design you want. In case that you want to create a design and have the cursor

snapping on the "Grid" to help you create something more accurately you can also enable option "Grid-

Snap" of "View" menu. 

You can also use Ctrl+Shift+G keyboard shortcut to switch between show grid and hide grid (Mac

Cmd+Shift+G).

if you hold Alt key pressed, while dragging or drawing an object,  you can temporary toggle the Snap of the

Grid from enabled to disabled and vice versa. This means that you can temporary disable the snap,

functionality in order to perform an operation or enable temporarily when disabled.

 In case you select "US" measurement system, from Tools-Options-General tab the grid will show

information in US(inches) and not Metric.

In case that you need to adjust the grid size, navigate to "View - Grid" and used option "Edit". On the

appearing dialog you  can set the value that you need for the grid. Once you press "OK" the grid size is

automatically updated. 
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View Crosshair

We added Cross-hair tool and we expanded its range to both screens for better and more accurate design

creation when using digitizing tools. 

Using "Crosshair" option in "View" menu, a cross follows the mouse when it is on the design and helps you

align and position design items. You can also initiate the crosshair display by pressing the letter "Ctrl +H"

from the keyboard while you are working with the design.

You can change the color that will be used for Crosshair lines from "View > Customize UI colors". There you

can adjust the colors that refer to Crosshair.

View Hoop

You can enable - disable the view of the hoop using "Hoop" option of View menu. By default any design you

create is previewed on the default hoop that you can select on the "Welcome" tab. When the hoop is

disabled you can only see a gray line, that shows the usable area of the hoop. In case that you want to select

another hoop for this design only then you can use "Machine/ Hoop" option on "Tools" bar. The Hoop is very

useful because it will make sure that the design which you are creating will fit on your embroidery machine

hoop. There is a variety of hoops from which you can select and you can even add your own. More

information about how to work with hoops in Change hoop section.

Slow redraw (Shift+F11)

A very valuable step before turning on your embroidery machine in order to embroider for first time, any of

your designs is a simulation like process. Slow redraw provides an automated way to simulate the

embroidery process. Move through objects stitches and preview the placement of every stitch. It’s a good

chance to correct any detail on your design. 
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 You can enter "slow redraw" by pressing on "Slow redraw" icon  on tools toolbar or use

"Shift+F11" keyboard shortcut.  

You need to press start  button to begin the visual simulation. You can also press Space key to start -

pause the simulation.  The simulation will start from the start of the design. You can stop the simulation by

pressing Stop button or press Esc key on your keyboard. After stopping the simulation, you can always start

over and continue from the stitch you left the simulation. When the simulation is stopped you can move the

current point indicator at any point of the colors line or move through object-stitches using the buttons next

to the start button. These buttons help you to select the object or the stitch that you want.

Design start, go to the first stitch of the design. Home key

Previous object, go to the first stitch of the design. Up key 

Previous stitch, move to previous stitch. Left arrow 

Next stitch, go to next stitch Right arrow 

Next object, move to the first stitch of the next object Down key

Design end, go to last stitch of design End Key

You can type a "speed" value in case to wish to make the simulation faster or slower. The speed can take

values from 100 - 4000 rpm. Finally if you enable the "Move hoop" option you can switch from the default

view mode that the head of the machine is moving to a mode that the head stays at the same place and the

design (Frame/hoop) moves in such a way in order to pass under the head to be embroidered. 
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Customize UI colors

To customize the colors of the user interface (UI) you have to select the "Customize UI colors..." option from

the "View" menu.

The "Customize UI colors" dialog will appear where you can change the colors of the UI components.

To change the color of a UI component you have to click on the color next to its name. From the pop-up

dialog that will appear you can specify the color you want by clicking on the color wheel, adjust the black

level(how much dark or bright it will be) of the color and the transparency level by dragging on the

respective track-bar.

Once you are satisfied with the color you have selected, you can click outside the dialog to confirm it.
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If you want to set your color selections as the default ones, click on the "Save as defaults" button at the

bottom of the dialog.

If you want to restore the default colors of the software, click on the "Restore" button at the bottom of the

dialog.

Guidelines

Guidelines are very useful while creating - editing a design, in order help you align and position the design

parts. There are three types of guidelines, "Vertical", "Horizontal" and "Diagonal". 

You can "Show" - "Hide" temporarily the guidelines by enabling - disabling the "Show" option of

menu "View - Guidelines". 

In order to add - remove guidelines you need to start "Guidelines" mode by pressing the "Guidelines" icon

. When you start this mode, you can click and drag to add any guideline you want. Now you are in

working mode that you can not change your design, you can only draw, change and delete guidelines. Click

and drag vertically to add a vertical guideline, horizontally to add a horizontal and diagonally to add

diagonal guidelines. 

When you click on any of the guidelines you can see the line with an outline to reveal that the guideline is

selected. You can delete this guideline by pressing "Delete" key. You can move the guideline if you place the

mouse on top of bullet that appears on the center of the guideline. Then the cursor turns into a hand and you

can click and drag to move the guideline. 
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If you place the mouse anywhere else on the guideline the cursor turns into a rotate handle and you can

rotate the guideline. You can hold "Alt" key and the rotation will snap on every 30 degrees. You can also hold

"Shift" key and the rotation will snap on every 15 degrees. Additionally if you press Ctrl key while you are not

on top of the center bullet, you can change from rotate to move operation. 

You can also change the position and rotation angle using numeric values. When you select a guideline you

can see on "Tools options" bar, the horizontal - vertical position of the guideline and the rotation angle. By

typing a value you can change the position of the guideline and the rotation. To move a horizontal guideline

you need to adjust the "Y" value and for a vertical the "X" value. If you type a "Rotation" value you can

change the angle of the guideline. The rotation is performed based on the green bullet that appears on a

guideline when selected. You can change the position of the bullet by adjusting the "Y" value for the Vertical

guidelines, the "X" value for horizontal and "X-Y" for diagonal.

All inserted guidelines have snapping abilities that can be found very useful when you are designing. All

objects can snap on Horizontal and Vertical guidelines that you have placed on the working area while

moving the objects towards them. This is very useful when you want to align the objects of the design to

specific position and makes your life easier while designing. Also, it is possible to do the opposite and move

the Horizontal and Vertical guidelines towards the objects and be able to snap on its edges/sides. 
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If you want the design objects to snap on the guidelines you can enable the "Snap" option of menu

"View - Guidelines".

Work Area

The “Work area…” option is can be found in the “Guidelines” mode and will allow you to insert a working

area that will be used as a guide. 

From the “Work Area” dialog that will appear you will be able to:

1. Select the position of the guideline shape that will be inserted. You can do that by specifying the vertical

and horizontal center of the shape (X and Y Center positions).

2. Select the type of area:

· Rectangular area: You can set the dimensions of the rectangular area by specifying the “Width” and

“Height”.

· Circular area: You can set the dimensions of the Circular/ellipse area by specifying the “Width” and

“Height”.

· Polygonal area: You can set the dimensions of the Polygonal area by specifying the “Width”, the

“Height”, the number of “Sides” and the “Start Angle” of the shape.

After setting the values you want, click OK to insert the “Work area” on the working area.
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To delete a “Work area” you have to select it while you are in Guidelines mode and press the “Delete”

key on the keyboard.



Edit objects
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 You can import artwork in various ways, import bitmap images or embroidery files. You can also create Text

and Monogram designs. In any case for any of design parts you select the "Tools options" pane, appears on

the upper left corner of the design area. This pane is content sensitive; it shows the properties and options for

any selected object or tool. When an object is selected you have immediate access to some of its properties

and using the available controls you can change them. For example when you select an object you have a

basic set of options available. Using these options, you can move, scale, duplicate, mirror and rotate any

selected object. 

Besides the basic set of options, this bar may also hold configuration options for various designing tools. For

example when you start "Text" tool, you can see the available text options, that you need to customize for the

inserted text. You need to type text and then customize size and various placement options. 

Insert text

The standard options that will appear when you select an object are: 

§ Change Position, By changing the X and Y values you can reposition the object inside the design area.

The position of the selected object is calculated based on its center. Therefore any inserted value in the

X and Y fields will define the position you want the center of the object to be located in the design area.

In order to change these values, type the value you like in the respective fields and then press enter or

click outside of the field. The change is automatically previewed in the design area.

§ Resize, By changing the Width and Height values you can change the dimensions of the selected object.

The values represent the exact dimensions of the object and not the approximate dimensions that you

are viewing on the selection rectangle whenever you select an object. To change the Width and Height

values, you have to click inside the relative field and then type the value you like. Press Enter from the

keyboard or click outside the field to confirm the value you have entered. In case that the option

proportional is checked and you select to scale one dimension the program automatically adjusts the

other dimension in order to keep the same analogy between the horizontal and the vertical size.

§ Scale, the Scale X-Y (%) provide the capability to scale the object by a providing a percentage of scale

according to the initial size. You can scale the object according to the X dimension or according to Y

dimension. In case that the option proportional is checked and you select to scale one dimension the

program automatically adjusts the other dimension in order to keep the same analogy between the

horizontal and the vertical size.

§ Duplicate object, press this button and an exact duplicate of the selected object will be created on top

of the initial object. 
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§ Mirror object, the next 2 buttons can be used to Mirror the original object based on the Horizontal or

Vertical axis. It is like flipping the object around a horizontal or vertical axis that is located on the

horizontal or vertical center of the object. 

§ Rotate object, using this field you can set a number in degrees to rotate the selected object. Type a

numeric value or use the arrows next to the field to specify one, press enter or click out of the control.

The object is automatically rotated clockwise for the degrees that you have specified.

Position objects

While you are creating or editing a design, one of the most useful tasks is the positioning of objects. There

are various ways to position objects, you can simply drag them to a new position, you can move them using

the arrow keys of your keyboard and finally you can set horizontal and vertical coordinates. Any of the

positioning ways can help you work more easily and more precisely. The easiest method, is to drag, that is,

tap or click to select an object and drag it to any position you like. While moving, you can see a preview of

the new position and when you release the mouse the object is placed into the new position.

While dragging, you can hold the "Ctrl" key pressed, and the movement of the object will

snap on a virtual grid of guidelines, on every 22.5 degrees. This snapping can help you make

accurate movements. In this way you can easily move into the same horizontal or vertical

position if you move the object horizontal - vertical, or diagonally if you move the object

diagonally. The point that you clicked when started dragging is used as the center point of

the virtual guidelines. 

if you hold Ctrl + Shift keys together you can only move the object horizontal or vertical. 

If the option Grid - Snap is enabled on "View" menu, then while moving an object the cursor

will snap to the closest horizontal or vertical lineation of the grid. if you hold Alt key

pressed, while dragging or drawing an object,  you can temporary toggle the Snap of the

Grid from enabled to disabled and vice versa. This means that you can temporary disable

the snap, functionality in order to perform an operation or enable temporarily when

disabled. 

Move objects with arrow keys

The position of an object can be also changed by using the Arrow keys from the keyboard. Select one or

more objects and then click on the respective arrow key to move towards the direction that you want to

move. You can move the objects until you are satisfied with the position that objects have. Every time you

click on the arrow key, the object(s) moves 1mm to the direction of the arrow. If you hold the Ctrl key pressed

and then press the arrow key, the object(s) will move 5mm to the direction of the arrow. Finally, if you hold

the Shift key pressed and the press the arrow key, the object(s) will move 0,10mm to the direction of the

arrow. By using the arrow keys and its combinations you can position the object(s) exactly in the place you

want. 

Move an object with X and Y coordinates

Another way to change the position of a shape, which is also the most accurate one, is to move an object

based on its X and Y coordinates. When you select an object its coordinates appear on the Tool options

toolbar. 
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X & Y coordinates 

Tool options is a proprietary toolbar that holds the options of the selected object. In order to change the

position of the object you have to change its coordinates, X and Y and place new ones based on the grid of

the working area. From the grid you can find the exact portion you want the design to be placed and enter

the respective values. The ruler is defining virtual X and Y axes and that is why you can enter negative

numbers as values to X and Y fields. The specified coordinates define the position of the center of the object. 

While moving one or more objects to a new position, you can press "D" key and switch into duplicate

mode. This means that when you release the moved object into the new position a duplicate object is

created and the initial object will remain unchanged. 

Copy - Duplicate - Delete

Using "copy-paste" you can easily re-use design parts from your designs or bring artwork from any bitmap or

vector designing application. You can copy objects, using keyboard shortcuts (Ctrl+C, Ctrl+X, Ctrl+V), using

the copy icon on the standard toolbar or using the available options of "Edit menu". For example is you

select an object and copy (Ctrl + C), the object is placed into the clipboard, then you can use "Paste" option

to place it into the same design or to another design. Since the software has information about the position

of the object the objects are always placed on the original position and remain selected to move it where

ever you like. Actually whenever you copy paste on the same design a duplicate object is created. You can

also have the same results using the duplicate option on Tools options bar. You can also "Cut" an object (Ctrl

+ X), in this case the cut object is placed on the clipboard and it is removed from the working area. In order

to make it appear again you have to paste it. You can "Paste" an object (Ctrl+V) only when you have

previously copied something. If the clipboard is empty, the Paste option is disabled. The copied parts remain

until something else is copied. So when you have copied an object, you can keen on pasting it until, you copy

something new and then it is no longer kept on the clipboard.

You can copy artwork from another application and paste directly into any design. The imported artwork may

need to be converted in some cases, for example when copying from photo editing software a conversion

dialog may appear. 

Delete

Whenever you no longer need an object you can delete it. To delete any selected object(s) you need either to

press the Delete key or use "Delete" option from the right click menu. The selected objects will be removed

from the design and can be recalled only by selecting the Undo from the standard toolbar. 

Transform objects

While creating or editing a design it is often needed to change the appearance of objects. You many want to

scale a design for use in different a project or just adjust something that you may not like the initial creation.

The software provides capabilities for transforming design objects just like a graphics program. The main
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difference is that when transforming an object the software automatically recalculates the fill or outline types.

For example if you transform an object that is filled with embroidery all the stitches re be regenerated. The

quickest way to transform objects is simply using the mouse. For more precise results, you can select an

object and transform using the options on Tools options bar. For example, you can specify a precise rotation

angle or specify the size of an object. You can scale, skew, rotate and mirror objects in various ways that will

be presented in detail in the following section, now we must mention a variation that exists for the control

handles.

 

Separate Rotate - Resize

Since the transformations are one of the most frequent tasks, we thought it would be best to provide various

operating modes, so that users accustomed to different designing software, such a vector designing

programs, find it easier to become familiar with. Whenever you select one or more objects, you can see a

highlight rectangle around the selection with some bullets on the corners and on the middle of the sides.

These bullets are actually the control handles for any transformation. If you place the mouse on top of any of

these bullets the cursor changes into a double arrow head. By dragging to the directions of the arrows you

can re-size the selection. If you click the object once on the object, new handles appear. You can use these

handles to rotate and skew the object.

For the users that are not used to clicking in order to switch the transform handles, there is an alternative way.

If you switch to the alternative transform controls, at first when you select an object you will not notice any

difference. The main difference it that in order to access rotate - skew handles you need to place the mouse

on top of the respective control handles and a little to the outside of the highlight rectangle. You can select

an operation mode from "Tools – options", Tools tab. You need to deselect the option "Separate resize-

rotate" and on the next program start the control handles will switch to this mode.
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Each of the above methods lets you apply transformations to a single object or to multiple objects

simultaneously.

 At any point while transforming one or more objects you can press "D" key and when you

release the mouse to apply the transformation you will get a transformed duplicate of the initial

object. 

Repeat transformation

One option that can save us a lot of time and effort is the ability to "Repeat last transform". If you want to

repeat your last transformation you have to select the object you want the last transformation you made to

be applied. Then Right click on the object and select the "Repeat last transform" option from the appearing

menu. The last transformation you made will be applied to the selected object as many times as you use the

"Repeat last transform option". Every time you make a transformation it is automatically becoming the last

transformation and this one will be used when the "Repeat last transform" option will be applied. For

example, if you have rotated an object you can repeat the last rotation as many times you want using the

Repeat last transform option from the right click menu or by pressing the Ctrl+R shortcut keys from the

keyboard. The object will be rotated, by keeping the same rotation angle with the last made rotation, as

many times as you used the Repeat last action option.
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Clear transform

In many cases you may wish to revert all transformations applied on an object. If you right click on an object

that has transformations applied, there is an option to clear transform. Using this option you can Cancel all

the applied transformations. The "Clear Transform" option is available for any object that has been

repositioned, resized, slanted, rotated or when any other transformation has been applied. The reverted

transformations can be more than one. The object is reverted to its initial state and position that it was

designed. 

Scale - Size objects

As already mentioned in previous section, when you select one or more objects, a highlight rectangle appears

around the selection with control handles on the corners and on the middles of the sides. You can scale -

stretch the selection by dragging those handles. Using the handles on the corners you are scaling

proportionally, this means that both dimensions are changing but the analogy between them is kept the

same. if you drag to the inside of the object the object is shrunk, otherwise it is enlarged. 

 if you hold down "Alt" key and drag any of the corner handles you can scale both dimensions

freely, without keeping the same analogy between them.

Using the handles that are on the middle of the sides you are scaling only one dimension at the time. In

reality the object is stretched. 

 While scaling, you can always view on the "Status bar", that is located at the bottom of the

application window, the new size and the percentage of the scaling according to the initial size. 
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 if you hold down "Shift key" and drag one of the handles you can scale based on the center of

the selection.

 if you hold down Ctrl key and drag any of the on handles, the scale operation is performed by a

step of 25% of the original size. While dragging to scale, the operation snaps on multiple of the size

of the object, 25%, 50%, 75%,100%, 125%. This works both when scaling using the corner handles,

both dimensions scaled by 25% step, or when stretching one side, only the selected dimension is

scaled by 25% step.

 At any point while scaling one or more objects you can press "D" key and when you release the

mouse to apply the scaling you will get a scaled duplicate of the initial object. In this way you can

easily create mirrored objects. Drag to the opposite direction, until you see the proportional change

on the status bar reaches the -100%. Then before releasing the mouse you can press "D" to produce a

mirror object. 

The objects can also be scaled more precisely by typing the size or percentage of scaling on Tools option

bar. Whenever you select one or more objects, you can see and on "Tools options" bar the dimensions,

"Width, Height" and by typing a value you can scale the selected objects. Whenever you type a value you can

press "Enter" to apply. If "Proportional" option is enabled, when you type a width value, the height is updated

as well to keep the same analogy. If you disable the "Proportional" then you can stretch the objects by

changing any of the dimensions. In the same way you can scale by a percentage of the original shape. You

can scale both dimensions by percentage if "Proportional" is enabled, or stretch by percentage if you disable

and scale only one dimension. 

Skew - Slant objects

Skewing lets you slant an object to one side. In order to skew an object, you need to click on the object to

display the skew handles, and drag any of the skew handles to any direction. On the middle of each side there

is a skew handle.



106

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Edit objects

By default all skewing transformations are made based on the center of the selection, which is the cross sign

that appears on the center of the selection. You can move the skewing center by clicking and dragging it to

the position you want, even outside of the design. By positioning the center of the design outside of it you

can skew the design based on the new center. 

If you hold the "Shift" key pressed, while skewing the object, the operation will be performed

according to the opposite side.
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Rotating objects

Rotating lets you turn an object around its center axis or a point relative to its position. When you select one

or more objects, you can see sizing handles on the selection rectangle. Click the object a second time and

rotation handles appear at the corners of the object and an anchor point displays at the object’s center. Click

a rotation handle, and drag clockwise or anti-clockwise to rotate the object according to the anchor point.

This cross point is that is by default at the center of the selection, is actually the rotation center. Any rotate

operation is performed based on this point. In case needed you have the ability to move this rotation center.

Select the rotation center and drag it to any position you want. If you want you can move it outside of the

design. Once you have moved the rotation center you can rotate the design based on the new rotation

center. 

 

If you hold the Shift key pressed, while rotating the object, the center of the design will change automatically

and will be positioned at the diagonally opposite rotation handle, based on which the rotation will be made. 

 If you hold "Ctrl" key pressed. while rotating the object, the rotation snaps on every 22,5 degrees

based on the rotation center allowing you to make more accurate rotations.

You can also rotate objects precisely by defining the exact rotation degrees on the Tool options bar. To do

that you have to select the object you want to rotate, change the rotation center by dragging it to the

position you prefer, if you like, and type the exact degrees you want to rotate the design in the Rotate field.

Press Enter key to apply the rotation and the object will be rotated the exact degrees you have defined. The
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Rotate option can take values from 0o to 360o if you want to rotate the design anti-clockwise and from -0o

to -360o if you want to rotate the design clockwise.

Mirroring objects

While creating a design, in many cases, it is very useful to create mirror objects. Mirroring an object is similar

to resizing procedure. Select an object so that the control handles appear around the selection. If you drag

any of the corner handles all the way to the opposite direction until the complete mirror of the design appear

on the working area. According the mirroring you want to do, you have to drag the respective handle that will

give you the mirroring you want. You can mirror the design Vertically, Horizontally and Diagonally. 

 if you hold Ctrl key while dragging a control handle to the opposite side of the object, the scale

operation snaps on every 25% of the objects size. In this way you can drag until you see 100% on

status bar and then you will get a mirror with exactly the same size. 

 At any point while scaling you can press "D" key and when you release the mouse to apply the

transformation you will get a scaled duplicate of the initial object.

 If you want to mirror an object but keep the same position you can hold shift key and the object

will mirror based on the center of the design and not on the opposite side/handle of the design.
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Another way to mirror a selection accurately is by clicking the "Mirror X" and "Mirror Y" buttons that appear

on Tools options bar. To mirror the design vertically you have to select it and click on the Mirror X button. The

design will flip and you will view its vertical mirror. To mirror the design horizontally you have to select it and

click on the Mirror Y button. The design will flip and you will view its horizontal mirror. 

Group - Ungroup

Grouping functionality is very useful in the designing face of the embroidery. When you group two or more

objects, they are treated as a single unit but retain their individual attributes. Grouping lets you apply the

same formatting, properties, and other changes to all the objects within the group at the same time. In

addition, grouping helps prevent accidental changes to the position of an object in relation to other objects.

You can also create nested groups by grouping together existing groups. In order to make a group you have

to select the objects you want become one group by making a multiple selection of objects and from the

right click menu select "Group" option or Ctrl+G keys together. The selected objects will become one group

and will be treated as one object. In order to add objects to a group, select the object(s) and then select the

group of objects, at this point if you use group option, the selected objects will be added to the group. If you

want you can group multiple groups and make nested groups. To do that you have to select two or more

groups of objects and from right click menu select Group option once more. 

 If you want to edit individual objects in a group, you must first ungroup them, edit the objects you want and

re-group the object. In order to ungroup a group of objects or nested groups you have to select the group,
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right click and from appearing menu select ungroup option. You can also use Ctrl+U keys together to

ungroup. The group of objects will break and all objects will be handled as separate objects. The nested

groups will be separated to its sub-groups and will be handled as separate groups. You can continue

ungrouping the sub-groups of the nested groups until all groups become separate objects. To delete an

object from a Group you have to ungroup it first, delete the object you want and then re-group the rest of the

objects. 

Combine - Break apart

Combining two or more objects creates a single object with common fill and outline attributes. To combine

two or more objects you have to select them, right click, and from appearing menu use "Combine" option.

You can also use Ctrl+L keys together to combine objects. The two objects will become one with common fill

and outline attributes. If the objects are overlapping then the shape of the object that is above will become a

hole in the shape below. This is the way how the overlapped objects are combined. This is very useful when

you want to create holes inside an object. If the objects are not overlapping then the objects will have the

common attributes but the combine option will not affect the initial shape of the combined objects. The

attributes of the combined object come from the last selected object, so keep in mind to select last the one

that you want its color and other attributes to be applied to the combined object. 

If you need to modify the attributes of an object that has been combined from separate objects, you can

break apart the combined object. Select the combined object, right click on it and from appearing menu use

"Break apart" option. You can also use "Ctrl+K" keys together to break apart. The objects will be separated to

its initial objects but will retain their common fill and outline attributes. If you have just combined the objects

and you want them back as they where you have to "Undo" your last action.

Combined objects that are not overlapping in embroidery are connected with a Jump-stitch between them.

Therefore whenever you see two objects that are far one from the other and they are connected with Jump-

stitch, this means that they are combined. 

Undo - Redo

Using this option in the "Edit" menu, you can undo the very last action you took. You can also access the

"Undo" function from the "Standard" toolbar by clicking on the  icon. If you decide to cancel the undo

you made, click on "Redo" function. Using "Redo" option from the "Edit" menu, you can cancel the latest

undo that you have performed. You can also access the "Redo" function from the Standard toolbar by

clicking on the  icon. 
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You can also change the undo level from Tools > Options in the General options tab.

We made major improvements in the software's "undo" capabilities. Through the implementation of

differential compression, users can now enjoy practically limitless levels of undo functionality. This

means that you can feel free to explore and experiment with their designs without fear of losing

progress. 

Remove overlaps

The software has an automatic filter which removes unnecessary overlaps between the objects in order to

optimize your designs. This filter uses artificial Intelligence and it is applied only where necessary. The

application of the filter results in the reduction of stitches that will be placed on the fabric. It is also possible

to manually alter the overlapping status of each object. The "remove overlaps" option is located on the

Properties toolbar and it appears when you select an object filled with Satin, Step, Row fill , Netfill Satin

Serial or Running stitches. There are three possible options that you can apply on a specific object, "Auto",

"Never" and "Always". The "Auto" is the default option and the one that the software uses to automatically

create the best possible results on the design. When the "Never" option is applied on an object, the specific

object will never trim the objects that overlaps. This means that all the objects/shapes that are under the

selected objects will be embroidered normally, placing all their stitches on the fabric. The opposite option is

"Always". When it is applied to a specific object it trims all the objects that it overlaps. This means that all the

parts of objects/shapes that are under the selected object will not be embroidered. The advantage of this

option is that it is applied automatically during the creation of the design without having to apply it

manually. It will automatically decide which objects will trim and which not based on embroidery rules.



Edit stitches
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In the "edit stitches"  mode you can see the stitches of the current design. You can make as many

adjustments as you want on the stitches and create the embroidery design that will be embroidered exactly

in the way you want. In addition you will learn how to select, move, insert or remove stitches and any

combination exists that can make your life easier. 

You cannot edit stitches on all objects. 

In order to edit the stitches of an object, you have to either disable the "Auto-sequence"  or

the object has to be stitch data object (opened .jef or .jpx file). Also, the object must contain only one

stitch type. This means that the object cannot have Fill and Outline type at the same time. 

After editing the stitches of an object you have limitations on the tools that you can use on it. The stitch

edited object is locked and it does not change its status even if you edit its nodes or change the stitch type.

To reset the status of the stitch edited object and unlock it, you have to:

1. Select the object and right click on it. 

2. From the right click menu select the "Clear stitch editing" option.

3. The object will be reset and any stitch editing will be lost. 

4. You are now able to apply all the available tools on the object. 

Convert vector-based objects to raw stitches for accurate stitch editing

One of the challenges of embroidery design is matching the stitches to the tension of the fabric. In order to

make these adjustments, it's often necessary to remove the artwork from the design and work with just the

raw stitches. That's why an important feature for any embroidery software is the ability to convert vector-

based objects into raw stitches. This allows for more precise editing and produces better results on the

finished product. 
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You can convert any object to stitches by right clicking on it and then selecting the "Convert to stitches"

option. You can select the same option from the "Convert" button at the top bar. The outlines will be

removed automatically. This will have as a result that every stitch editing you make(inside edit stitches mode)

will be retained during resizing. 

Selections in stitch editor

There are many ways to make selections in the stitch editor. You can make multiple selections or single stitch

selections by creating a rectangle selection or by single clicking on the specific stitch you want to move. 

Rectangle selection

Select more than one stitches by drawing a rectangle that will contain all the stitches you want to be selected.

To do that you have to click on the "Edit stitches" tool at the "modes" toolbar, click and drag on the working

area to draw a rectangle over the stitches you want to select and release the mouse click to confirm your

selection. After making the selections you can move them by clicking and dragging on any of the selected

stitches or make any other transformation you want. 

There are, also, special rectangle selections that you can do by using "Ctrl", "Shift" or "Alt" keys.

• Hold the "Shift" key pressed while making a rectangle selection to add more stitches to your

selection. 

• Hold the "Ctrl" key pressed to invert the current status of the selected stitches

• Hold the "Alt" key pressed while making a rectangle selection to remove them from your selection. 
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Single click selection

Click on a stitch you want to select it. The selected point is the same with the needle penetration point that

the embroidery machine will make on the fabric. 

There are, also, special "single click selections" that you can do by using "Ctrl", "Shift" or "Alt" keys.

• Hold the "Shift" key pressed while clicking on stitches to add more stitches to your selection. 

• Hold the "Ctrl" key pressed to invert the current status of the selected stitches

• Hold the "Alt" key pressed while clicking on selected stitches to remove them from your selection. 

Select All - None - Invert

More selection options are available if you right click on the selected object.

· The "Select all" option will select all stitches of the selected object. 

· The "Select none" option will deselect all stitches of the selected object.

· The "Invert selection" option will invert your current selection. If you have selected a group of stitches

and you apply "Invert selection" option, the currently selected stitches will be deselected and the rest

stitches of the object will become selected.
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Move stitches

If you want to move one stitch or multiple stitches, first you have to click on the “Edit stitches”  tool from

the left toolbar to activate the stitch editor. Then, you have to click and drag the selected stitches and move

them to a new position. By using the selection techniques we described in the previous section you can make

complicated stitch movements that give you powerful stitch editing abilities. 

Also you can move the selected stitches by using the arrow keys from the keyboard. 

After editing the stitches of an object you have limitations on the tools that you can use on it. The stitch

edited object is locked and it does not change its status even if you edit its nodes or change the stitch type.

To reset the status of the stitch edited object and unlock it, you have to:

1. Select the object and right click on it. 

2. From the right click menu select the "Clear stitch editing" option.

3. The object will be reset and any stitch editing will be lost.

4. You are now able to apply all the available tools on the object.

Snap movement

This movement of stitches can be activated by holding down the "Ctrl" key while click and dragging the

selected stitch points. 
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While dragging the selected stitches, they will snap on specific angles and help you to make accurate

movements. The stitches will snap on 22.5 degrees intervals. 

Insert stitches

Using this tool you can add stitches to the current design. This function can be used only when you are in

"Edit stitches" mode.

First click on the stitch from where you want to start adding stitches and press the "Insert" key from the

keyboard (for MS Windows users) or the "Insert" option of the right click menu. Each subsequent click adds a

stitch after your initial location and before the stitch you have selected. 

After finishing with the insertion of stitches you can simply right click with the mouse and the function will

end. 

If you want to add stitches at the end of the current object, you right click anywhere on the object and select

the "Insert at end" option from the menu, following the same procedure we described previously. 

Delete stitches

In order to delete stitches, first you have to select the stitches that you want to delete, by using the selection

options we described, and then press the "Delete" key from the keyboard or select the "Delete" option from

the right click menu. This action will remove the selected stitches from the design and will recalculate the rest

to fit in the changes. 
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View/Hide nodes

When you select an object with "Edit stitches" mode enabled, the needle penetration points appear as small

rectangular nodes. You can either view or hide the nodes. To do that you have to right click on the object and

from the pop up menu select "Hide nodes".

   

To make the nodes visible you can right click once more on the object and from the pop-up menu select

"Show nodes". 



Lettering
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Lettering is one of the most valuable tools available. Using the lettering tools you can personalize and

decorate your designs and create unique looks on any project. You can easily add text and monogram into

any of your designs using the available lettering tools. Using the Text tool you add Text to any design you are

working on and using monogram tool you can create monograms with optional frame. All the fonts that are

installed in you computer are available you to create Text Art designs easily. You can find the "Lettering

tools" on the toolbar on the left side of the application window, on Lettering section. When you put the

mouse over Lettering section you can see two options, one for text and one for monogram. 

Add text

You can find the "Text" tool  on the toolbar on the left side of the application window, on Lettering

section. Start the Text tool by pressing on its icon or using F8 keyboard shortcut. When you start the text tool,

you can click on the design area to define the position of the text. Wherever you click, you set a blue dash

and this is the position that you text starts from. If the position is not correct then click again to change the

starting point. On the top part of the design area you can see the text options. From this place you can

control all available Text options. 

1. Type or paste the text you wish to add. To paste the text you have to select the "Paste" option from "Edit"

menu or by selecting the respective option from the right click menu. The pasted text will be inserted
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allowing you to edit it further. The inserted text will appear on the working area immediately. Any edit you

make in the "Text" field is automatically applied on the existing text. 

2. Expand the Font name list to select a Font.  The Font will change on the text allowing you to visualize how

the embroidery will look like with a different font. There are 2 types of fonts, the predigitized fonts, that

have this zig zag icon , and the true type fonts that have this TT icon . The pre-digitized fonts are

made from professional embroiderers, for high quality lettering sew outs. More than 200 pre-digitized

fonts are included in the Lettering tool. The TrueType fonts are all the fonts that are installed in the

computer. The text you have defined is automatically previewed with any font that you select.

3. Adjust the size of the font by typing a value. You can also scroll with your mouse wheel, if you are using

one. This value actually represents the height of the characters. 

4. You can adjust the distance between the characters using the character spacing.

5. Set the characters to be Bold. 

6. Set the characters to be Italic.  

7. Enable or disable smart text, which gives you the ability to type special phrases that are replaced by

special characters. For example, using parenthesis enclosing a C you can add a copyright sign.

8. Edit the available abbreviations.

9. You can use envelope to transform the text. 

10. Using this value you can adjust the shape of the selected envelope.  The value can take values from 1 to

100. When the value=1 the shape is rectangle, while the value is increasing the shapes tends to be more

like the selected shape. 

11. Select the text placement to apply alternative placement options. 

The red dots that you can see under each character are placement handles. So use the mouse to select any of

them and move individual characters, to create unique text placements. 

When you are done, adjusting the text options or placement you can click on the rectangle selection, and the

text is finalized with the current properties. Now if you select the text object you just created you can see its

dimensions on tool options toolbar and not text options. At this point the text object can be transformed as
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any normal object. To adjust the text options again or edit the text, you need to select the text tool once

again. Adjust the options as you like and click on the selection tool to release the text tool. You can edit text

option or change the position of each character as long as it still a text object. In case that a text object is

converted into curves then the text options are removed and you can only handle it as any other curve

object. 

While adjusting the text options, you can left click somewhere else and you can start a new text. 

Additionally, when the mouse is on top of the characters, the cursor turns into a "Hand" and by click and drag

you can move the created text to another position. It is similar to moving individual characters, but this time

you move the whole text part. 

Text abbreviations

We call an Abbreviation any combination of letters – characters that can be used in order to represent a

special character which we can’t easily add using the keyboard. The software includes a list with commonly

used abbreviations that can be easily added to our text designs.

The "Smart text" option allows to enable or disable the usage of abbreviations for the inserted text.

Therefore if you want to use "Abbreviations" you have to have it checked.

In order to see the list of the available abbreviations you must first activate the text tool by clicking on the

 button from the "Tools bar" or by pressing F8 keyboard shortcut. When "Text tool" is activated various

options appear in Tool options" bar that can be used to customize the inserted text. 

You can Press  button in order to bring up the abbreviations editor.
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In this dialog we can see the list of available

abbreviations. 

We can also manage abbreviations 

1. Create new 

2. Edit existing

3. Delete 

4. Reset all modifications 

The usage of these options will be described in a

separate section.

When typing text we can use any of the available character combinations in order to add various special

characters. For example if we type “==>” it will automatically be converted into the as there is an

abbreviation for that special type. 

Likewise, you can use any of the available abbreviations. The program automatically recognizes the pressed

keys and replaces the inserted text with the interconnected abbreviation.

In order to use that feature and have abbreviations automatically applied on inserted

text make sure that Smart Text option is enabled. In case that we want to write

normally without applying abbreviations we must disable smart text option.

Abbreviation Disabled Abbreviations Enabled

 Not all abbreviations are available to all Fonts. If the abbreviation is converted to a

character/text/symbol that is not the one you have set, then the currently selected font does not

contain the character/text/symbol you are trying to produce. 
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Creating abbreviations

There are special characters that we may like to use in

our designs. 

Click on the "New" button to create your own

abbreviations.

For example 

1. Press the "New" button on "Abbreviations" editor

dialog. 

2. On the lower part of the dialog, an new row will be

inserted. Double click on the empty cell to edit it. 

3. Set the text in the "Replace" field that will be

replaced with the symbol/text that you will set in the

"with(odd)" field.

4. Press "Enter" ("Return" for Mac) to apply the new

abbreviation.

5. In our case when we typed “:D” then it will be

replaced by the laughing “” sign. 

6. Click on "Close" to apply the change.
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Edit abbreviation

1. Select any of the available abbreviations

2. Click on the "Edit" button or double click on the cell

you want to edit.

1. The cell will become editable. 

2. Change the text in the "Replace" cell and then

double click on the "with (odd)" cell or press "Tab"

to change the special character. 

3. Click on "Close" to apply the change.

Delete abbreviation

1. Select any of the available abbreviations.

2. Click on "Delete" button to remove it

Text Placement

Using this option you can change the Text placement. By default the text is placed using "Horizontal"

placement and there are no special placement options for this placement.  You can change the way the the
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text is placed by selecting any of the available "Placement" options that are available on "Tool options" bar

when adding any text object. The placement options are:

 

· Vertical: The text is placed vertical.

· On line segment: The text is placed on a straight line that can be adjusted using the green handles on the

edges of the line. 

· On arc: The text is placed on an arc that can be adjusted using the three control handles of the arc. Using

the handles on the sides of the arc you can change the start - end of the arc and using the one in the
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middle you can adjust the radius of the arc. 

When selecting  placement "On line segment", "on Arc" or "on User path", there a few additional options

available. The additional options are : "Text placement", "Text alignment", "Offset" and "Reverse direction".

Text Placement

Using the "Text placement" options you can select the position of the text in relation to the path line. 

§ Baseline (Default): The Baseline option is the default option and positions the text on the curve having

characters such as small ‘g’ to expand under the curve. 

§ Bottom: The Bottom option positions the text over the curve completely. The curve (path) will be position

at the bottom of the text. The characters such as small ‘g’ will be positioned over the curve completely. 

§ Ascent: The Ascent option positions the text exactly under the curve, all letters go below the line, except

from ascenders, like letter "d" that may go over the line. The curve line is positioned exactly over the text.



128

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Lettering

§ Top: The Top option positions the text under the curve by keeping a small distance from the curve. 

Text alignment: 

Using the alignment options we can change the position of the text on the line and set the alignment to left, 

right, center or full.

· Left: The "Left" option is the default option and sets the Text on path to start from the Left side of the path.

· Right: The "Right" option sets the Text on path to start from the Right side of the path.

· Center: The "Center" option centers the Text on the path.

· Full: The "Full" option justifies the Text on the path.
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When you set the alignment to full, you can  adjust the letter spacing, if you change the size of the

line. 

Offset: 

The "Offset" numerical field specifies the distance of the Text from the path start. The default offset value is

zero and you can change it by typing a new value in the field, and then press enter key from the keyboard to

apply it. The "Offset" value can take positive or negative values and move the Text on the path accordingly. 

Reverse Direction: 

If you choose Reverse direction, you make the text start from the other edge of the line. When you place Text

on a path or on a shape the text takes the direction of the path. If the path was drawn from left to right, then

the Text will be also placed from left to right and over the path. On the other hand if the path was drawn

from right to left then the Text will be also placed from right to left but will be positioned below the path. 

 

When the path or the shape was designed from right to left and the text you have placed on appears in the

opposite way from what you expected, you can simply check the "Reverse direction" checkbox and the text

will appear in the way you wanted to be. 

Envelope on Text

When adding any text object, you get to see the envelope option together with all text options, on Tool

options toolbar. Using Envelope, you can easily transform the shape of your Text, by selecting any of the

available envelope shapes. The envelope is only available for the "horizontal" placement.

To apply an envelope on any text, you have to 
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1. Type a text in the "Text" field of "Tool options" bar

2. Expand the "Envelope" drop-down menu and select the envelope shape you want to apply. 

3. The software tries to fit the text into the desired envelope shape. So you will see the shape of your shape

transformed.

4. Using the "Value" option under the envelope drop-down, you can adjust the shape of the selected

envelope.  The value can take values from 1 to 100. When the value=1 the shape is rectangle, while the

value is increasing the shapes tends to be more like the selected shape. 

5. If you changed your mind, you can apply a different envelope from the list and see how it looks. At any

point, you can clear the applied envelope and reset it back to the way it was originally by selecting "no

envelope".
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Monograming

With the Monogram tool you can create your own monograms, using various templates and decorative

frames. To create a Monogram design you have to do the following:

· Click on the "Monogram" icon  that is located on "Tools" bar, in Lettering section. The "New

Monogram" dialog will appear and you can customize all monogramming options. The dialog always

comes with the setting of the last created monogram. If you move the wizard dialog you can see a

preview of the created monogram.

1. Type  the monogram characters. There is a limit of 3 in characters that you can insert in the field.

2. Define the size of the area that the monogram will be placed by setting the "Width" and the "Height".

While adjusting "Width" and "Height", using this lock, you can make sizing proportional or not. When the

lock is on, any change of width also affects the height and if unlocked, you can adjust width or height

individually.

3. The "Stretch" percentage of the monogram "Text". The default value is 90%. By increasing the "Stretch"

value, the monogram text becomes bigger and comes closer to the decorative frame. By decreasing the

"Stretch" value, the monogram text becomes smaller. 

4. The "Font" that will be used for the monogram. You can either use Pre-digitized, True Type(TT), Open

Type(OT) and Symbol(S) fonts. 

5. The "Template" that will be applied on the inserted monogram Text. There are many templates from

where you can select the one you prefer. Select one by clicking on it. It will automatically be applied and

previewed on the workspace of the software behind the "New monogram" dialog.

6. The "Frame" that will decorate the Monogram. There are three "Frame" types. "Borders", "Corners" and

"Sides".



132

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Lettering

§ "Borders": Are embroidery designs that will frame the monogram Text that you will insert. The

diagonal arrow shows the area where the Text will be placed. 

§ "Corners": Are embroidery designs that are suitable for placing them at the corners of the

monogram. You have the option to add one up to four corner designs by clicking on the rectangles of

the "Visible corners" options.

 

§ "Sides": Are embroidery designs that are suitable for placing them at the sides of the monogram.

You have the option to add one up to four side designs by clicking on the rectangle of the "Visible

sides" options.

 

Every change that is made inside the "New monogram" dialog, it is previewed on the workspace behind the

dialog. To apply the changes you have to click Ok. The monogram will be placed on the workspace ready to

edit it further.

Edit monogram

To edit the monogram you have inserted you need to do the following:

1. Select the monogram text.

2. The "Tool options" bar will change and show all the options you can edit.

3. In the "Text" field you will see the monogramming characters you have inserted in the design. Change any

character and press "Enter/Return" to apply the change.

4. To change the font type of the monogram, select a different one from the "Font name" drop down menu.

5. Finally you can change the template from the "Monogram" drop down menu.



Working with colors
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In this section we will present how to work with colors for your projects. By default when creating a new blank

design, the "Used colors" bar, that is located on the lower part of the application, is blank. When you create

an object the default "fill"  and "outline"  color are automatically applied and you can see them on

"Used colors" bar.

This bar holds all the colors that are already used on this design and you can apply any color to any object,

remove fill or outline, select a new color and edit any color. The upper row, holds the "outline" colors and the

lower row shows the "fill" colors. If you open a design with multiple objects you can see all used outline

colors on the upper row and all used fill colors on the lower row. When an object is selected the colors that

this object has appear highlighted. If you click on any other color (fill or outline), than those already applied

to this object, then the color that you click is automatically applied to the selected object.

Click on the "none" color  (fill - outline) to remove the fill or outline from the selected object. 

You can set a new color, to the selected object, by clicking on the "Fill"  or "Outline"  icons.  The "color

selector" appears to select a new color for the selected object. In the same way, if you click on any of the

used colors you can edit the color. The "color selector" appears and you can change the color. The new color
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is automatically applied to all objects that were using the previous color. You can also right click on any color

and use "Edit color" option to edit the color. 

Using the "color selector" you change the selected color. You can move the small circle inside the color wheel

to select any other color. You can also adjust the brightness of the color, using the track bar that is next to the

color wheel. When you drag this handle upwards the object gets brighter. At any point you can see a preview

of the selected color on the preview area. 

Another way to select a color is to type a value into "Color name" box. You can type a color in any of the

following ways.

1. RGB value, if you are familiar with RGB colors you can type the RGB values separated with comma and the

software will set the selected color. For example if you type 130,170,154 you will get the green of the

following image. 

2. Hex Color Codes, Color-hex gives information about colors including color models (RGB,HSL,HSV and

CMYK), Triadic colors, monochromatic colors and analogous colors calculated in color page. You may find
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a Hex color code of a color you want to use. For example the Hex color code of the green color in the

following image is #82aa9a

3. Color names, you can type the name of any know color, like type green. The software will set a green

color. But have in mind that green has many variations and the software will automatically select one

only. 

If you select a Thread palette the software automatically matches the color wheel color with the closest one

from the thread palette you have selected. 

When you have a palette selected you can also see a list of the palettes colors by switching to "Swatches"

instead of the color wheel. You can scroll trough these color and click to select any color from this list. 
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You can also use "Color manager" to manage and reduce the design colors. 

Set default colors

As we have already mentioned, when creating an object a set of default "Fill" or "Outline" colors is

automatically applied. You can change the default set of colors simply by clicking on a "fill" or "Outline"

color, when nothing is selected. If you click on any "fill color, the "set default fill" color dialog will appear

displaying the color you have selected. On this dialog you can select for which types of objects (Graphic

objects or Text objects) the selected color will be used as default Fill color. Furthermore, you can select

whether this fill color will be used only for the current design or for every design from now on. If the color

that you want is not listed on "Used colors" bar then you should first add the color by clicking on the "Fill"

 or "Outline"  icons.

In the same way you can change the default outline color. When no object is selected, click on any outline

color and the dialog "Set default outline color" will appear, displaying the color you have selected. You can

select for which types of objects (Graphic - Text) the selected color will be used as default outline color.

Furthermore you can select whether this outline color will be used only for the current design or for every

design from now on. From the same dialog (outline) you can also change the width of the default outline

color. Check the "Set default outline width" check-box and type the width you want in the respective field.

The default outline width will be set to the new value and the change will be applied to the "current design"

or "on every design" according to your selection on the selection of the default.
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If you have objects selected that you do not want to release, but you want to set a default fill - outline

color, you must hold "Ctrl" key and then click on the Fill - Outline color that you want to set. The same

dialog will appear. Your selection will not be filled with the clicked color, it will be just set as default

Fill - Outline color.

From the same dialog (outline) you can also change the width of the default outline color. Check the "Set

default outline width" check-box and type the width you want in the respective field. The default outline

width, will be set to the new value and the change will be applied to the "current design" or "on every

design" according to your selection on the selection of the default.

In case that you don’t want the created objects to have Fill and/or Outline color by default, you can

click on the "none”   color at the “Fill” row, if you don’t want to have Fill color, or at the "Outline”

row, if you don’t want to have Outline color, and set both to “none” if you don’t want either of them

to have color by default. 

Selections by color

In many cases it is very useful to select all the objects that are using a specific color. This option is very handy

when you want to replace a color for example - it is not necessary to select the objects manually. You can

change color, stitch type, apply a style or any other transformation you want. You can select by Fill color, by

Outline color or simply by color. In order to make a selection by color you need to right click on the color you

wish to select on palette bar. If you right click on a "Fill" color then you can choose to select all objects that

are filled with this color or all the objects that are using this color for either fill or outline. In the same way, if

you right click on an outline color, you can select all objects that have this outline color or all object that have

this color for fill or outline. 
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Color manager

In general you can easily import artwork from various sources. Files that are created in other applications are

imported and converted into embroidery designs. When importing artwork from other sources, you should

always have in mind, the limitations about embroidery designs. If you import a vector design that has 50

colors, it would be too difficult to produce with so many color changes. Additionally the available colors of

each thread palette are limited. The "color manager" can always help us optimize and handle the colors of a

design. Using the "Color manager" you can:

· Reduce the colors of a design

· Edit the colors on color wheel

· Apply a Thread palette to all design colors

· Apply color harmonies to all design colors.

Reduce colors

For embroidery designs, you need to select a thread manufacturer palette and then using the "Colors" track

bar you can reduce the colors of the design. When reducing the colors, the color manager automatically

matches multiple design colors to a representative color of the selected thread palette. The color changes

are automatically visible on the design. 

 

For example, if you have a design with 13 colors, select a Thread manufacturer palette and reduce the colors

to 6, then the color manager automatically groups multiple colors and matches them to the closest color
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from the selected thread palette. As you can see on the following figure, there are 3 variations of red on the

design and the reduction matches them to the closest available red from the selected thread palette. 

If you do not like the automatic grouping of color you can always drag a color from the left list to any of the

other color lines or drag to the area labeled "Drag here for a new color" to add a new color. For example,

you can drag the green color to a new color and move the brown color to the red color group. 

Always have in mind that you can "Undo" any change you have made by clicking on the undo 

icon  (Ctrl+Z) or click on the Redo icon to cancel the last Undo (Ctrl+Shift+Z) you have made.

icon. 

In order to apply the changes you need to click the rectangle selection icon . The colors are reduced

permanently, if you have changed you mind you can only "undo" the operation. If you open color manager

again the available colors are the reduced colors. You can only manually create new colors. You can select

any of the numbers that are on top of the color wheel and change the color by moving it to another point

and by adjusting the brightness. if you have too many colors and it is not easy to locate the color you need to
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edit, you can move the mouse cursor over the color on the design and click to select it. The color is selected

on the color wheel, the little circle gets another outline. 

Using "Harmonies control" you can automatically replace the colors of the design using various techniques.

For example if you apply Monochromatic, all the design colors are replaced by tones of the same color. More

information about harmonies is provided into the Harmonies topic.

 

Original design Monochromatic

Harmonies

As already mentioned previously, using "Harmonies" you can automatically replace the colors of the design

using various techniques. On the following figures, you can see how all the harmonies are applied on the

same design. On any color harmony, the color that is labeled with number 1 is the base color. You can change

all harmony colors at once if you drag the triangle on the outer circle of the color selector. 

 If you double click on any of the numbered circle icons that represent the design colors you can

set that color as a base color and the harmony colors are calculated based on this color. When you

select a harmony, the color labeled number 1, is always used as a base color, so if you have previously

selected another base color and change harmony you will switch back to the default. 

Original design Monochromatic: The monochromatic harmony

uses one base color and the rest of the design

colors are replaced by tones of the same color.
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Complementary: This harmony places all the design

colors one opposite to the other on the color wheel,

so all colors are considered to be complementary

colors (example: red and green). The high contrast of

complementary colors creates a vibrant look.

Diad: The diadic or diad color harmony uses two

colors that are separated by one color on the color

wheel. 

Analogous: The analogous harmony puts the colors

next to each other on the color wheel. The colors

usually match well and create nice designs.

Triad: The triad harmony puts the colors on a

triangle and they are evenly spaced around the color

wheel. Triadic color harmonies tend to be quite

vibrant, even if you use pale or unsaturated versions

of your hues.
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Tetradic: The rectangle or tetradic color harmony

places the design colors arranged into two

complementary pairs. and creates a rich color

scheme offers plenty of possibilities for variation.

Split - complimentary: The split-complementary

color harmony is a variation of the complementary

color scheme. In addition to the base color, it uses

the two colors adjacent to its complement. This

harmony has the same strong visual contrast as the

complementary color scheme, but has less tension.

Square: The square color harmony is similar to the

rectangle, but with all colors spaced evenly around

the color circle.



Re-order design
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The software includes two ways to re-order the objects/shapes of a design. The first is from the "Order"

option of the right click menu and the second the "Sequence manager" bar. The first method can be used in

all cases and the second only if the Auto sequence  is disabled. We will explain how each method can be

applied in the following sections. 

· Re-order from right click menu

· Re-order with Sequence manager

Re-order objects

One way to re-order objects is by using the order option from the right click menu. You can change the

selected objects order by bringing one to front and send another to back. The re-ordering you are making is

for the graphic design mainly. While having the auto-sequence  set to "Auto", the final embroidery

sequence will be based on various optimization that will be applied on the design and will not be identical

with the order that the graphic design had initially. To completely manage the order of the design you have

to set the sequence to "Manual".

There are four available reordering options which are "To front one", "To back one", "To front of design", "To

back of design". To apply any of the reordering options to the object(s) you have to select it and then right

click on it in order the pop-up menu to appear. From the right click menu expand the Order sub-menu and

select any of the four reordering options.

· To front one: With this option you can move the selected object forward one position. If the selected object

is positioned at the top of the design then the To front one option will not be available. Another way to

apply this option directly is by pressing Page-Up shortcut key (PgUp) together from the keyboard.

· To back one: With this option you can move the selected object behind one position. If the selected option

is the last object of the design, this option will not be available. Another way to apply this option directly is

by pressing Page-Down shortcut key (PgDn) together from the keyboard.

· To front of the design: With this option you can move the selected object(s) to be in front of all other

objects of the designs. Another way to apply this option directly is by pressing End shortcut key (End)

together from the keyboard.
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· To back of the design: With this option you can move the selected object(s) to be behind of all other

objects of the designs. Another way to apply this option directly is by pressing Home shortcut key (Home)

together from the keyboard.

For example, in the figure below we have three circles; and the pink circle is at the lowest level, the green to

the next level and the yellow to the top level. 

In order to change the order of the circles we have to select the pink one and from the right click menu select

"Order > To front one" option. 

 

Immediately the circle from lowest level goes one level above. We can also do the opposite by selecting the

yellow circle and from the right click menu select "Order > To back of the design" option.

 

This option sends the circle to the lowest level of the design. The reordering tools can help you create exactly

the design you want to embroider. 
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Sequence manager

“Sequence manager” provides a graphical representation of the design’s order and an easy way to change it

at will. The "Sequence manager" is located next to "Properties" bar. All design items are represented as icons

in a square box. The "Sequence" manager has two modes:  "Auto" and "Manual". 

"Auto"

When the sequence is set to "Auto", the software optimizes the embroidery design to produce the best

possible quality. Towards that end the objects that are filled with stitches cannot be re-sequenced and

therefore appear grouped in one object. 

The program uses intelligent mechanisms to automatically create the sequence of the stitch items and (while

in the Auto mode) you can’t control the order according to which the objects will be embroidered by using

the sequence manager. You can only specify some optimization preferences to guide the software on how

you want the design to be embroidered. 

"Manual"

When the sequence is set to "Manual" or when the "Embroidery Technique" is disabled you can see all

objects/shapes individually on the sequence manager. You can then re-order them at will simply by dragging

them upwards or downwards. 
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The objects positioned higher on the Sequence manager are those that will be embroidered first or the ones

that will be positioned lower in an overlapping stack. 

More information about the usage and customizations of the Auto-sequence is provided in chapter

Embroidery sequence. 

Sequence manager bar

The Sequence manager appears by default on the right area of the window next to "Properties" bar. If you

click on any icon of the sequence manager it gets selected and you can see it inside the design area with a

highlighted rectangle around it. You can select multiple items using the "Ctrl", or Cmd key on mac OS, and/or

the "Shift" keys. To select a series of sequence icons hold the "Shift" key pressed down, click on the first icon

of the series and then on the last one. All the sequence icons between the ones you clicked are now selected.

If you hold the "Ctrl" key pressed down and click on multiple sequence icons they get selected too. Using the

"Ctrl" key, you can also remove icons from a selection. If you hold the "Ctrl" key and click on already selected

sequence icons, these icons are deselected. You can also use the "Ctrl" and "Shift" keys in combination, that is,

if you select a series of sequence icons using the "Shift" key and then hold the "Ctrl" key pressed down,  you

can add other non-sequential icons to the selection or remove selected icons from the selection. If you right

click on any sequence icon when one or more sequence icons are selected, then you also get  some general

selection options.  Using "Select all" you can select all sequence icons, using "select none" you can deselect

everything and using "Inverse selection" you can select all other icons except the ones already selected. 

When deleting an object, the next object in the sequence automatically becomes selected. This allows both

the Sequence Manager and the user's focus to remain on the current position, streamlining the workflow and

saving production time.
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Next to each sequence icon you can see a numeric value which represents the position of this design part in

the embroidery sequence. You can click and drag one or more sequence icons up or down to change their

position in the embroidery sequence. For designs with too many design parts it may not be easy to drag the

sequence icons to the position you want them to be. In such case, it would be easier to move one or more

selected sequence icons to scroll up or down to the direction where you want them to be and right click on

the sequence icon where you want them positioned. On the appearing menu you can now choose from the

new options “Move Before” and “Move After”, to position the icons right before or after (accordingly) to

where you right clicked. 

If you select non sequential icons and right click on any of the selected icons, you have the option (Join

together) to bring these sequence icons one next to the other. The icons will be then moved next to the icon

you right clicked upon.
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On the right click menu there is also the option to reverse the order of two or more sequence icons. To do so,

simply select two or more sequence icons, right click on top of the selection and use the "Reverse" option.
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Group by color

When the sequence is set to "Manual", one more icon  (group by color) appears on the title bar of the

sequence manager. When you see this icon , all the design parts are separate icons. If you click on this

icon, then the design parts are grouped by color and the icon changes into this palette icon  . This means

that all the sequential objects/shapes with the same color are grouped into one icon. It is a two state button,

so by default you see all objects as separate icons, if you press once the objects are grouped by color and if

you click once again you switch back to separate icons. The group by color function does not group

objects/shapes with the same color if they have different fill or outline types.  When the sequence icons are

grouped by color then next to each icon you see a series of numeric values. Additionally, you can see the fill

and outline colors that are used for each icon.    

The sequence manager can only be resized or minimized and cannot be closed. To resize the sequence

manager place the mouse cursor on top of the left edge of the sequence manager, until the cursor switches

into a size handle. Click and drag to the right to make it smaller or to the left to enlarge it. If you shrink it too

much, the sequence numbers and the colors are hidden. To minimize the sequence manager, you have to

click on the pointing   icon on the header and to maximize it you need to click again on the same 

icon which will now point to the opposite direction. 

We can also change the sequence of the design items using  Order options that appear on the right click

menu. These ordering options will be described in a separate section. In order to simulate the embroidery

sequence, you can use slow redraw tool.

Hide/Show item

When editing designs, it can be helpful to hide certain objects in order to better focus on the underlying

shapes and layers. That's why we've added a tool that allows you to hide and show specific objects at will.

This feature is handy when working with designs that have multiple layers, such as fill areas, shapes, and

borders stacked on top of each other. With the ability to hide these layers for clearer editing, creating

intricate designs becomes simpler and more efficient. 

To hide or show an object you have to select it from the working area or from the Sequence manager, right

click on it and select "Hide/Show item" option from the right click menu.
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Tools
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In this section we will present some of the available tools that are included in the software.
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Insert symbol

Every font that is installed on our computer may include symbols that are based on the artwork of the Font.

Those symbols maybe a very good source of artwork. The "Insert symbol" option provides a way to inspect

them and use them if you like. You can easily insert a symbol by activating the "Insert symbol" option from

"Tools" menu. The Insert symbol dialog will appear where all symbols of a specific font will be listed. Select

any font, using the dropdown list, to view the available symbols. You may need to scroll down to see all

available symbols. 

Once you have found the symbol you want to use you have to select it and click the Insert button. You can

also double click on any icon. The dialog disappears to make space on the design area. The cursor turns into

a cross waiting to specify the position of the symbol, click and drag with the mouse specifying the width of

the symbol and the angle you want to have. After releasing the mouse, the symbol appears on the working

area with the default fill and outline colors and the Insert symbol dialog turns back on. You can insert as many

symbols you want by following the same steps.

      

 You can also start "Insert symbol" by pressing "Ctrl+F11" keys (Cmd +F11 for Mac OS) . If you

hold the "Shift" key pressed while dragging, the cursor will snap on every 22.5o degrees allowing you

to insert the symbol on a specific angle. Using "Alt" key the inserted symbol is mirrored horizontally. 
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Ambience Quilting

The software provides an easy way to create a quilting block using any design. Select the object, (either an

entire design or part of it) which you would like to include in the quilting block. Take for example, the

following image of a yacht. When this is selected, by right clicking, the "Ambience quilting" option will

appear in a drop down menu. You can also select "Ambience quilting" from the Convert icon in the horizontal

toolbar.

By clicking "Ambience quilting...", the following dialog will appear for you to adjust the settings of the quilt

block.

In the "Border" area you define the size of the complete quilt block. Press the lock icon to enable

Proportional Sizing, which means that if you change one of the dimensions, the other is automatically

updated to keep the same proportions. 

In the "Shapes" area you can see the size of the selected design part. This is just a reference to help you

define the block size; in other words, you cannot resize the object from this dialog.

In the "Properties" area you can set the "Offset" value, which is the distance between the object and the first

stippling line and the "Density", which is the distance between the stippling lines. If you wish to have the

same "Offset" and "Density" values, you can click the lock icon to lock the values together and then any

"Density" value you set shall be set as "Offset" distance as well. 
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Stippling

When using the "Stippling" type, the quilt block is filled with stippling fill around the object, starting from the

defined offset. 



Embroidery - Creating embroidery designs
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In this chapter we will describe all the stitch transformations that the software can do. You will learn about

"Properties" bar functionality, how you can adjust "Design properties", how to change "Fabric" , how to add

one or more "Hoops" and how to adjust the Stitch flow. 

Stitch types - Embroidery types

 The software includes several "Stitch types", that are listed in the following table:

Stitch types 

· Satin

· Step

· Stippling

· Running

· Satin Serial

· Cutwork

Stitch types

The "Satin" and the "Step" stitch types are used from the software to fill vector shapes with stitches. The

"Running" and the "Satin serial" stitch types are used to fill vector outlines and line art designs.

Satin stitch type

When the Satin stitch type is applied on any object, stitches are connecting two points from one side of the

object to the other. These points are formed like closely arranged zigzag stitches along the shape of the

object. Satin stitch type can be laid down at any angle and with varying stitch lengths. For small and oblong

objects will be filled with Satin stitches. 

Vector object  Satin fill

Step stitch type

Step stitch type (or Fill stitch type or Tatami stitch type) is a series of Running stitches commonly used to fill

large areas. Different fill patterns can be created by altering the angle, length and repeat sequence of the

stitches. Usually the large objects in the vector design most of the times are filled with step stitches. 
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Vector object Step fill

Stippling type

"Stippling" is a special stitch type that is mainly used for quilting projects. Select any object and by activating

Stippling embroidery type, the selected object is filled with stipple fill as in the following figure. 

 

Vector object Stippling fill

Running stitch type

Running stitch type consists of one stitch between two points. It is used mainly for outlining, fine detail and

complete designs. Also known as a walk stitch. All line art designs and thin object outlines will be filled with

Running stitches.

Thin outline object  Running fill
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Satin Serial stitch type

Satin serial stitch type is applied on thick outline objects by forming closely placed zigzag stitches along it. It

is generally used to fill borders and line art designs. All thick line art designs and object outline will be filled

with Satin Serial stitch type. 

Thin outline object Satin serial fill

Cutwork

The "Cutwork" is a special type that is used in order to cut fabric or other soft materials. The "Cutwork" is a

special type for adding special type cuts which require the 4 special knifes. 

Cutwork Outline Cutwork

The same stitch types are used with the same or different names from the embroiderers around the world. To

understand to which stitch types we refer with the names Satin, Step etc. we will analyze them for you.

Fabric selection

Fabric selection dialog is not just for previewing the design on the fabric. The software automatically adjusts,

according to the selected fabric, various embroidery parameters. Embroidery quality depends on some of

these parameters. Important quality factor is also how the fabric is stabilized on the frame of the embroider

machine. The software suggests the appropriate backing materials for every fabric, in the printout of each

design. In case that you don’t want to preview the design on any fabric you can select the "None" option that

exists in any of the fabric categories. In this case, only the color that is select in "Fabric dialog" will appear in

the background of the created design. 
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The fabrics are categorized in groups of embroidery types with different preset parameters:

· "Embroidery smooth", is starting with Density 55 for normal thread No 40, with lighter underlay

· "Embroidery normal", is starting with Density 40 for normal thread No 40

· "Embroidery normal light", is starting with Density 40 for normal thread No 40, with lighter underlay

· "Embroidery light", is starting with Density 55 for thick thread No 30. 

· "Embroidery Ultra light", is starting with Density 85 for thick thread such as wool 

· "Embroidery Heavy", is starting with Density 35 for thin thread such as metallic. 

All the designs can be previewed on different fabrics. There are various colors and types of fabrics. When you

decide to save your design, in order to embroider it on a garment, you must be sure that the fabric you have

chosen is similar with the one that will be embroidered. Otherwise the results may not be the expected ones.

There are 50 fabric types in any color spread to different categories, from which you can select the

appropriate one.

Select fabric dialog

This option can be accessed from menu "Tools > Fabric...", from the shortcut key Ctrl+F or from the standard

toolbar by clicking the select fabric  icon. From the Fabrics dialog you can choose the "Embroidery

category" and "Color" by clicking on them. The "Embroidery category" drop down menu has the six

categories that are available.

These are "Smooth", "Ultra Light", "Light", "Normal Light", "Normal" and "Heavy". 

· "Smooth": In this category you can choose between any of the fabrics that are listed. The embroidery that

will be placed on these fabrics will be light and smooth. That is why the embroidery on the 3D preview will

appear with low density. All the fabrics have specific internal embroidering parameters that needed for
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high quality embroidering. The embroidering parameters are adjusted to each fabric in order the

embroidery that will be placed on to have smooth feel and keep the fabric soft. 

· "Ultra Light": In this category you can choose between “Bridal Tulle”, “Waffle knit”, “Wool” and “Standard

Ultra Light”. The embroidery that will be placed on these fabrics will be Ultra light. That is why the

embroidery on the 3D preview will appear with low density. The first three fabrics have specific internal

embroidering parameters that needed for high quality embroidering. The “Standard Ultra Light” fabric is

not a specific fabric but can be used as an alternative for embroidering Ultra light on any fabric you want.

The embroidery results of the “Standard Ultra light” settings will depend on the fabric. 

· "Light": In this category you can choose a fabric between “Lycra lame”, “Sweat shirt knit”, “T-shirt knit2”,

“Vinyl2”, “Wool Crepe” and “Standard Light”. The embroidery that will be placed on these fabrics will be

Light. That is why the embroidery on the 3D preview will appear with low density. Each of these fabrics has

specific settings in order to produce the best possible results if you embroider the design on the respective

fabric. Be sure you have chosen the correct fabric from the fabric list. If you want to embroider a design

with light settings in a fabric that is not included in the list, choose the “Standard Light” fabric that contains

those settings. The embroidery results depend on the fabric that is used. 

· "Normal Light": In this category you can choose a fabric between “Crepe Polyester”, “Denim1”, “Light

weight bridal satin”, “Linen1”, “Panne velvet”, “Rayon”, “Rayon Sand washed”, “Sweater knit”, “T-shirt knit1”,

“Towling”, “Vinyl1” and “Standard Normal Light”. The embroidery that will be placed on these fabrics will

be Normal with a tension to Light. That is why the embroidery on the 3D preview will appear with normal

density. Each of these fabrics has specific settings in order to produce the best possible results if you

embroider the design on the respective fabric. Be sure you have chosen the correct fabric from the fabric

list. If you want to embroider a design with Normal Light settings in a fabric that is not included in the list,

choose the “Standard Normal Light” fabric that contains those settings. The embroidery result depend on

the fabric that is used.

· Embroidery Normal: In this category you can choose a fabric between “Berber fleece”, “Chiffon scarf”,

“Cordoury”, “Cotton”, “Craft Fleece”, “Denim2”, “Denim3”, “Faille1”, “Flannel”, “Fleece”, “Heavy weight

Bridal satin”, “Knit flannel1”, “knit flannel2”, “Linen3”, “MicroFiber”, “Nylon flag”, “Quilted cotton”, “T-shirt

knit3” and “Standard Normal”. The embroidery that will be placed on these fabrics will be Normal. That is

why the embroidery on the 3D preview will appear with normal density. Each of these fabrics has specific

settings in order to produce the best possible results, if you embroider the design on the respective fabric.

Be sure you have chosen the correct fabric from the fabric list. If you want to embroider a design with

Normal settings in a fabric that is not included in the list, choose the “Standard Normal” fabric that contains

those settings. The embroidery result depends on the fabric that is used.

· "Heavy": In this category you can choose a fabric between “Burlap”, “Chenille”, “Cross-stitch cloth”, “Faille2”,

“Fake fur”, “Linen2”, “Lycra bathing suit”, “Lycra workout clothes” and “Standard heavy”. The embroidery

that will be placed on these fabrics will be Heavy. That is why the embroidery on the 3D preview will

appear with high density. Each of these fabrics has specific settings in order to produce the best possible

results, if you embroider the design on the respective fabric. Be sure that you have chosen the correct fabric

from the fabric list. If you want to embroider a design with Heavy settings in a fabric that is not included in

the list, choose the “Standard Heavy” fabric that contains those settings but the embroidery result depend

on the fabric that is used.

You can change the color of the fabric by clicking on the color button and selecting a different one from the

color wheel. If the fabric has two colors you can change also the second one by following the same steps. 
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Click "OK" on the dialog to apply the changes on the currently active design. 

Properties

On the "Properties" bar you can see all the Fill and Outline types that can be applied on the design parts. You

can also adjust the parameters of each type according the needs of the design. Its contents are changing

dynamically based on the currently selected object. If nothing is selected the "Properties" bar is minimized on

the top right area of the design area. Once you have something selected you can see the currently applied Fill

or Outline types and edit the properties or select any other type for the selected object. 

Notice: if the selected design part has none color for its Fill or Outline then the section with the none

color is hidden. For example if the design part has none outline the Outline section on properties bar

is hidden. In this case id you wish to a outline to the design part, you must first set a color for its

outline. 

In order to change the "Fill" or "Outline" of the select you go to the respective section on Properties toolbar

and click on the icon of the currently selected type to expand the list with the available types and the click on

the icon of the type you like. 

Fill types

Satin

Step

Stippling
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Outline types

Running 

Satin Serial

Cutwork

 

Fill Properties

The "Fill" section contains every type that can be applied to the Fill of a design part. The available types are

not visible until you select one or more objects. By default, when a design is created, the software

automatically selects the applied fill types. This is why the "Auto" check-box, next to the selected fill type, is

checked. When another fill type is selected the "Auto" becomes unchecked. If you check it again, you can

restore the automatically selected type. This is very useful when you have made many changes to a design

and you want to cancel all the changes you made by using the tool of "Properties" bar and start again from

the beginning.

The available fill types are: 

Satin

Step

Stippling

For any type selected you can also see the available parameters on Fill section under the its icon. You can

adjust the available parameter to edit the fill. In you wish to reset the parameters to their default values you

can right click on the desired stitch type and use the "Reset type to defaults" option. 



166

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Embroidery - Creating embroidery designs

Artwork

When this option  is applied, sets the fill area to be artwork (vector design). All the fill stitches are

removed from the design. Whenever you don’t want to embroider a specific fill area you can set its’ fill to

Artwork and have the stitches instantly removed.

Satin

When selecting Satin fill type, the stitches are going from one side of the object to the other. It is like

connecting two points from one side of the object to the other. These points are formed like closely arranged

zigzag stitches along the shape of the object. Satin stitch type can be laid down at any angle and with

varying stitch lengths. For small and oblong objects will be filled with Satin stitches. 

Vector object  Satin fill

When a Satin object is selected you can see it parameters on the Properties bar and you can adjust the Satin

fill using these options. You can change the feel of Satin by selecting a "Pattern". There are many different

"Patterns" that you can apply on any stitch design.Additionally, you can adjust the"Density", the

"Compensation", the "Underlay", enable - disable the use of Short/long and Add random stitches.  The

available properties are described below: 
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Pattern

Density

Compensation

Underlay

Pattern

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, created

from stitches. You can make combinations between Stitches and Patterns and produce your own designs.

Some combinations when applied may not look good on the design. This happens because combinations do

not always produce correct stitch results. 

Select the pattern you prefer by clicking on it.  You can remove the applied pattern by clicking on the X

button, next to the icon of the selected Pattern. Your selections are instantly displayed in the design area

letting you experiment with it. There are 195 different patterns to apply to your design. If you want to view

only the pattern you have selected and not a combination with "Stitches", you must be sure that "Stitches"

option is set to "None". Otherwise you will view a pattern with "Stitches" in it.

There are three more options that can help you adjust the embroidery parameters of the design. As we have

already mentioned in the Select fabric section previously in this chapter, each fabric has different presets that

affect the way the embroidery design will be placed on it and some of them are visible at the bottom of the

"Properties" toolbar. For Satin stitch type they are "Underlay", "Density" and "Compensation". These options

can help you make useful adjustments on the design and produce the embroidery results you prefer. 
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Density:

You can activate the "Density" option by checking the check-box next to it. In the numeric field, you can

specify the density of the satin stitches that you are adding. You can also adjust density by clicking on the

value and rotating the mouse wheel  if there is one. Changes are instantly previewed on the design area

and can be set by clicking outside the density field or by pressing "Enter/Return" from the keyboard.

Compensation: 

You can activate the "Compensation" option by checking the check-box next to it. In the numeric field you

can enter the value of compensation you want with lower bounder 0mm and upper bounder 2.0mm. Also you

can adjust density by clicking on the value and rotating the mouse wheel if there is one. 

The entered value changes the width of satin stitch that will be embroidered. The default compensation value

depends on the fabric you are using. If you change fabric the compensation will adjust automatically.

Changes are instantly previewed on the design area and can be set by clicking outside the "Compensation"

field or by pressing "Enter/Return" from the keyboard. 

Underlay: 

You can activate the "Underlay" option by checking the checkbox next to it. Click on the "Underlay" you want,

and it will be immediately applied on the selected object. If you don’t select an underlay manually, the

software will automatically select the appropriate one for you. The underlay stitches are placed on the fabric

in order to create the base for the cover stitches that will follow. The "Underlay" is important for the quality

of the embroidery designs.

For Satin stitch type, the following underlay patterns are available:

Tacking – If tacking is selected, there will be no underlay and the software will

make running stitches in order to go from one position to another and cover the

area with cover stitches.

Single - If single is selected, the software will make a single line with running

stitches near the middle of the shape of the object and then cover this with cover

stitches.

Double - If double is selected, the software will make running stitches following

the shape of the object and position Double underlay near the edge of the outline.

ZigZag - If zigzag is selected, the software will create a sophisticated ZigZag

pattern which automatically changes directions (according to the direction of the
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cover stitches) and then fill the shape with cover stitches.

Cross - If cross is selected, the software will create a thicker sophisticated ZigZag

pattern which automatically changes directions (according to the direction of the

cover stitches) and then fill the shape with cover stitches.

ZigZag+ - Is a combination of Zig-Zag and Double underlay.

Cross+ - Is a combination of Cross and Double underlay

Netting - If netting is selected, the software will cover the area of the object with a

thicker sophisticated ZigZag pattern, which automatically changes directions

(according to the direction of the cover stitches) two times and then fills the shape

with cover stitches. 

Netting+ - Is a combination of Netting and Double underlay.

Double ZigZag - If Double Zig-Zag is selected a Zig-Zag underlay is applied in

both directions.

Double ZigZag+ - Is a combination of Double Zig-Zag and Double underlay.

3D-1 - Fist level of 3D look Satin stitches

3D-2 - Second level of 3D look Satin stitches (Recommended in most cases)

3D-3 - Third level of 3D look Satin stitches

3D-4 - fourth level of 3D look Satin stitches

3D-5 - Fifth level of 3D look Satin stitches

To apply 3D look on the Satin objects you have to select on of the 5 different 3D Underlays available. all of

them will give a 3D look to the shapes that you will apply them. The recommended 3D underlays are "3D-2"

and "3D-3", which will give you great embroidery results.

There are also two more options that are very useful in customizing the way that the software will be

embroidered. Those are the "Remove overlaps" option and the "Sequence" option. 
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Remove overlaps: 

This is an automatic filter which removes all overlaps between objects of the vector designs. This filter uses

artificial Intelligence and it is applied only where necessary. The application of the filter results in the

reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping

status of each object. There are three possible options that you can apply on a specific object, "Auto",

"Never" and "Always". The "Auto" is the default option and the one that the software uses to create the best

possible results on the design. When the "Never" option is applied on an object, the specific object will never

trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will

be embroidered normally, placing all their stitches on the fabric. The opposite option is "Always". When it is

applied to a specific object it trims all the objects that it overlaps. This means that all the parts of

objects/shapes that are under the selected object will not be embroidered. 

The software uses this tool to embroider your design more efficiently and effectively. But in order for this

function to work well, avoid applying "Trim" tool which permanently removes the stitches underneath. You

must always use it with care or after setting "Remove overlaps" option to Never. 

Sequence: 

With this tool it is possible to change the embroidering sequence of the design while it is set to "Auto" .

Specific objects of the design can be set to be embroidered at the start or at the end of the embroidering

process. This gives you the ability to sew the designs in the order you prefer. More specifically, the

"Sequence" drop down menu has three options "Auto", "To start" and "To end". The "Auto" is the default

option and the one that creates the best possible embroidering sequence results. In order to change the

embroidering sequence manually, use the other two options. The To "Start" option sets the selected object to

be embroidered first. This means that if it was to be embroidered fifth in the embroidering sequence, now

will be embroidered first in the row. Exactly the opposite for the "To end" option. When this is applied on an

object of the embroidery design, it will be immediately become the last object that will be embroidered. By

using the "To start" and "To end" options, is the only way you can change the embroidering sequence  while

the sequence option it is set to "Auto"  . This tool is really useful for embroidering hats and on delicate

fabrics that need special care regarding the placement of objects on the fabric.

If you have set more than one object to be embroidered "To start" and more than one "To end", the software

will automatically decide which one of those will be the first and which one will be last to be embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered "To start" and 5 "To

end", the software will embroider those that was set "To start" first, automatically deciding their
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embroidering sequence, then those (10) set to "Auto" and finally those set "To end", once again

automatically deciding the order of the last 5.

The "Stop before" option is a special sequence command that you can add to the selected design, if you

want to stop the machine before sewing the object. It is useful for multi hoop designs, applique, name drop

designs and every design you need control when the machine will stop to perform a specific task.

Step

Step stitch type (or Fill stitch type or Tatami stitch type) is a series of Running stitches commonly used to fill

large areas. So when selecting Step fill type, the software automatically creates a series of parallels running

lines that run in an angle in order to fill any shape. Different fill patterns can be created by altering the angle,

length and repeat sequence of the stitches. Usually the large objects in the vector design most of the times

are filled with step stitches.

When a Step object is selected you can see it parameters on the Properties bar and you can adjust the Step

fill using these options. You can change the Step look by changing its "Pattern". There are many different

"Patterns" that you can apply on any stitch design.  Additionally, you can adjust the "Density", the "Length",

the "Compensation" and the "Underlay". The available properties are described below: 

Pattern

Density 

Length

Compensation

Underlay



172

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Embroidery - Creating embroidery designs

Pattern

The patterns area contains all the patterns that can be applied on the design. Patterns are shapes, created

from stitches. You can make combinations between "Stitches" and "Patterns" and produce your own designs.

Some combinations when applied may not look good on the design. This happens because combinations do

not always produce correct embroidery results. 

Select the pattern you prefer by clicking on it. The none selection will restore the default satin type. Your

selections are instantly displayed in the design area letting you experiment with it. There are 195 different

patterns to apply to your design. If you want to view only the pattern you have selected and not a

combination with "Stitches", you must be sure that "Stitches" option is set to "None". Otherwise you will view

a pattern with "Stitches" in it. 

There following options can help you adjust the embroidery parameters of the design. As we have already

mentioned in the Select fabric section previously in this chapter, each fabric has different presets that affect

the way the embroidery design will be placed on it and some of them are visible at the bottom of the

"Properties" toolbar. For Step stitch type they are, "Density", "Length", "Compensation" and "Underlay". These

options can help you make useful adjustments on the design and produce the embroidery results you prefer. 

Density: 

You can activate the "Density" option by checking the check-box next to it. In the numeric field, you can

specify the density of the satin stitches that you are adding. You can also adjust density by clicking on the

value and rotating the mouse wheel  if there is one. Changes are instantly previewed on the design area

and can be set by clicking outside the density field or by pressing "Enter/Return" from the keyboard.
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Length: 

You can activate the Length option by checking the check-box next to it. In the numeric field you can specify

the length of each stitch in the step.

Compensation: 

You can activate the "Compensation" option by checking the check-box next to it. In the numeric field you

can enter the value of compensation you want with lower bounder 0mm and upper bounder 2.0mm. Also you

can adjust density by clicking on the value and rotating the mouse wheel if there is one. 

The entered value changes the width of satin stitch that will be embroidered. The default compensation value

depends on the fabric you are using. If you change fabric the compensation will adjust automatically.

Changes are instantly previewed on the design area and can be set by clicking outside the "Compensation"

field or by pressing "Enter/Return" from the keyboard. 

Underlay: 

You can activate the underlay option by checking the check-box next to it. Click on the Underlay you want,

and your change will be calculated and stored in the saved design. If you don’t select an underlay manually,

the software will automatically select the appropriate one for you. Underlay is important for quality

embroidery designs.

For Step stitch type, the following underlay patterns are available: 

Tacking – If tacking is selected, there will be no underlay and the software will make

running stitches in order to go from one position to another and cover the area with

cover stitches.

Edging - If edging is selected, the software will make running stitches following the

shape of the object and position Edging underlay near the edge of the outline.

Packing - If packing is selected, the software will cover the area of the object with

vertical running stitches (according to the direction of cover stitches) as the icon

shows.

Netting - If netting is selected, the software will cover the area of the object with

running stitches at 45o and -45o (according to the direction of the cover stitches)

and then fill the shape with cover stitches.
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Packing + - Is a combination of Packing and Edging underlay.

Netting + - Is a combination of Netting and Edging underlay

There are also two more options that are very useful in customizing the way that the software will be

embroidered. Those are the "Remove overlaps" option and the "Sequence" option. 

Remove overlaps: 

This is an automatic filter which removes all overlaps between objects of the vector designs. This filter uses

artificial Intelligence and it is applied only where necessary. The application of the filter results in the

reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping

status of each object. There are three possible options that you can apply on a specific object, "Auto",

"Never" and "Always". The "Auto" is the default option and the one that the software uses to create the best

possible results on the design. When the "Never" option is applied on an object, the specific object will never

trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will

be embroidered normally, placing all their stitches on the fabric. The opposite option is "Always". When it is

applied to a specific object it trims all the objects that it overlaps. This means that all the parts of

objects/shapes that are under the selected object will not be embroidered. 

The software uses this tool to embroider your design more efficiently and effectively. But in order for this

function to work well, avoid applying "Trim" tool which permanently removes the stitches underneath. You

must always use it with care or after setting "Remove overlaps" option to Never. 

Sequence: 

With this tool it is possible to change the embroidering sequence of the design while it is set to "Auto" .

Specific objects of the design can be set to be embroidered at the start or at the end of the embroidering

process. This gives you the ability to sew the designs in the order you prefer. More specifically, the

"Sequence" drop down menu has three options "Auto", "To start" and "To end". The "Auto" is the default

option and the one that creates the best possible embroidering sequence results. In order to change the

embroidering sequence manually, use the other two options. The To "Start" option sets the selected object to

be embroidered first. This means that if it was to be embroidered fifth in the embroidering sequence, now

will be embroidered first in the row. Exactly the opposite for the "To end" option. When this is applied on an
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object of the embroidery design, it will be immediately become the last object that will be embroidered. By

using the "To start" and "To end" options, is the only way you can change the embroidering sequence  while

the sequence option it is set to "Auto"  . This tool is really useful for embroidering hats and on delicate

fabrics that need special care regarding the placement of objects on the fabric.

If you have set more than one object to be embroidered "To start" and more than one "To end", the software

will decide automatically which one of those will be the first and which one will be last to be embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered "To start" and 5 "To

end", the software will embroider those that was set "To start" first, deciding automatically their

embroidering sequence, then those (10) set to "Auto" and finally those set "To end", deciding automatically

the order of the last 5.

The "Stop before" option is a special sequence command that you can add to the selected design, if you

want to stop the machine before sewing the object. It is useful for multi hoop designs, applique, name drop

designs and every design you need control when the machine will stop to perform a specific task.
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Stippling

Stippling is a special stitch type that is mainly used for quilting projects. Select any object and by activating

Stippling  embroidery type, the selected object is filled with stipple fill as in the following figure. You can use

stippling for a variety of things, create stippling blocks with any shape or size you like or fill area with an

irregular line placed randomly into the shape. 

Stitches

The "Stitches" area contains all the stitch styles that can be applied on this object. "Stitches" in the software is

a way of movement from one point to another, which normally can be done by one stitch. Some "Stitches"

when applied may not look good on the stippling objects, the irregular movement of the stipple pattern may

not look good on many "Stitches". This happens because styles cannot fit correctly in all possible shapes. 

Select the "Stitches" you prefer by clicking on it and viewing it in your design. The none selection will restore

the default stippling type. Your selections are instantly displayed in the design area letting you experiment

with your design. The "Stitches" that are in film icon (for example: ) are a series of different styles in

one. 

Offset:
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With this option you can specify the distance, inner or outer, you want the Stipple pattern to be moved. For

example: if you set the Offset value to 3mm the Stippling will increase its size by 3mm to all directions

outside its original outline. On the other hand if you set the value to -3mm the stippling will decrease its size

by 3mm to all direction inside its original outline. 

The maximum value that the Offset can have is 15.0mm and the minimum is -15.0mm. To change the Offset

value you have to either click on the up and down arrows next to the field to increase or decrease its value or

type the exact value you want and then press the Enter key from the keyboard. Another way to increase or

decrease the value is by clicking inside the Offset field and use the mouse wheel to change its value. The

changes that you will make will be immediately applied on the design. By changing this value you can make

adjustments on the Stippling size, which is really useful when you want to cover a hole and making sure that

the net will be embroidered on the fabric and not inside the hole.

Density:

You can activate the Density option by checking the check-box next to it. In the numeric field you can specify

the distance between the lines of the stipple pattern. Also you can adjust density by clicking the arrows next

to the value or by clicking on the value and rotating the mouse wheel  if there is one. Changes are instantly

previewed on the design area and can be set by clicking outside of the density field.

Length: 

You can activate the Length option by checking the check-box next to it. In the numeric field you can specify

the length of each stitch that will be used for the stipple pattern. Adjust thread tension according to stitch

length as necessary.

Break apart

Finally, there is an option to "Break apart" the stippling fill into separate stipple parts."

Remove overlaps: 

This is an automatic filter which removes all overlaps between the objects of the vector designs. This filter

uses artificial Intelligence and it is applied only where necessary. The application of the filter results in the

reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping

status of each object. There are three possible options that you can apply on a specific object, Auto, Never

and Always. The Auto is the default option and the one that the software uses to create the best possible

results on the design. When the Never option is applied on an object, the specific object will never trim the

objects that overlaps. This means that all the objects/shapes that are under the selected objects will be

embroidered normally, placing all their stitches on the fabric. The opposite option is Always. When it is
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applied to a specific object it trims all the objects that it overlaps. This means that all the parts of

objects/shapes that are under the selected object will not be embroidered. 

The software uses this tool to embroider your design more efficiently and effectively. But in order for this

function to work well, avoid applying trim tool. You must always use it with care or after the setting Remove

overlaps option to Never. 

Sequence: 

With this tool it is possible to change the embroidering sequence of the design. Specific objects of the

design can be set to be embroidered at the start or at the end of the embroidering process. This gives you

the ability to embroider the designs in the order you prefer. More specifically, the Sequence drop down menu

has three options Auto, To start and To end. The Auto is the default option and the one that the software uses

to create the best possible embroidering sequence results. In order to change the embroidering sequence

manually, use the other two options. The To start option sets the selected object to be embroidered first. This

means that if it was to be embroidered fifth in the embroidering sequence, now will be embroidered first in

the row. Exactly the opposite for the To end option. When this is applied on an object of the embroidery

design, it will be immediately become the last object that will be embroidered. By using the To start and To

end options, you can change the embroidering sequence and embroider the design you have created the way

you prefer. This tool is really useful for embroidering hats and on delicate fabrics that need special care

regarding the placement of objects on the fabric.

If you have set more than one object to be embroidered To start and more than one To end, the software will

decide automatically which one of those will be the first and which one will be last to be embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered To start and 5 other

To end, the software will embroider those set To start first, deciding automatically their embroidering

sequence, then those (10) set To auto and finally those set To end, deciding automatically the order of the

last 5.

The "Stop before" option is a special sequence command that you can add to the selected design, if you

want to stop the machine before sewing the object. It is useful for multi hoop designs, applique, name drop

designs and every design you need control when the machine will stop to perform a specific task.
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Outline properties

The Outline section of Properties toolbar contains the types that can be applied to the outline of any design

part and their functions. The outline section is not visible until you select an object that has outline color

applied. When a design is initially created or imported the software automatically selects and applies outline

types on the design. That is why the Auto checkbox, next to the applied outline type, is checked. When you

select another outline type, Auto becomes unchecked. You can check it again and restore the initial auto

selected outline type selection.

Artwork

This option , when applied, sets the outline to be empty. All the outline stitches are removed from the

design and only the fill remains, if one exists. Whenever you don’t need to embroider a specific outline part

you can set its outline to Artwork and have the stitches instantly removed.

Running

This option, when applied, sets the border outline of a design or a line design to Running. All the border and

line stitches are changed to Running, which is automatically calculated and produced from the program. The

Running type that was placed is the default. You can change Running’s feel by changing its Thickness and

Style. There are different thicknesses and Styles that you can apply on any stitch design. Also, you have the

ability to change the stitch "Offset" and "Length"The Running type that was placed is the default. You can

change Running’s feel by changing its Thickness. Also, you have the ability to change the stitch "Length".

Outline width

By changing this value you can add an outline on the selected object or change the width of an existing

outline. By changing the value to any value greater than 0, an outline will be added to the object with the

specified width. You can change the value of the Outline thickness by highlighting the current value and then

typing the new one. The old value will disappear and the new one with take its place once you press

"Enter/Return" key from the keyboard or click outside the field. The value change affects the outline of the

selected object. 

For Running stitch type the "Outline width" affects the way that will be stitched out. The following automatic

changes are applied if the "Auto" properties check-box is checked.

· Outline width 0.1 - 0.4: Running with 1 pass.

· Outline width 0.5 - 0.8: Running with "Double" "stitches" applied (2 passes).
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· Outline width 0.9 - 1.9: Running with "Triple" "stitches" applied (3 passes).

· Outline width >1.9: Running will change to "Satin serial"

Length: 

You can activate the Length option by checking the check-box next to it. In the numeric field you can specify

the length of stitches for the punching object that you are adding. Also you can adjust length using the track-

bar that appears when you click on the length value or by clicking on the value and rotating the mouse wheel

 if there is one. Changes are instantly previewed on the design area and can be set by clicking outside of

the length field.

Remove overlaps: 

This is an automatic filter which removes all overlaps between objects of the vector designs. This filter uses

artificial Intelligence and it is applied only where necessary. The application of the filter results in the

reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping

status of each object. There are three possible options that you can apply on a specific object, "Auto",

"Never" and "Always". The "Auto" is the default option and the one that the software uses to create the best

possible results on the design. When the "Never" option is applied on an object, the specific object will never

trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will

be embroidered normally, placing all their stitches on the fabric. The opposite option is "Always". When it is

applied to a specific object it trims all the objects that it overlaps. This means that all the parts of

objects/shapes that are under the selected object will not be embroidered. 

The software uses this tool to embroider your design more efficiently and effectively. But in order for this

function to work well, avoid applying "Trim" tool which permanently removes the stitches underneath. You

must always use it with care or after setting "Remove overlaps" option to Never. 

Sequence: 

With this tool it is possible to change the embroidering sequence of the design while it is set to "Auto" .

Specific objects of the design can be set to be embroidered at the start or at the end of the embroidering

process. This gives you the ability to sew the designs in the order you prefer. More specifically, the

"Sequence" drop down menu has three options "Auto", "To start" and "To end". The "Auto" is the default

option and the one that creates the best possible embroidering sequence results. In order to change the

embroidering sequence manually, use the other two options. The To "Start" option sets the selected object to
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be embroidered first. This means that if it was to be embroidered fifth in the embroidering sequence, now

will be embroidered first in the row. Exactly the opposite for the "To end" option. When this is applied on an

object of the embroidery design, it will be immediately become the last object that will be embroidered. By

using the "To start" and "To end" options, is the only way you can change the embroidering sequence  while

the sequence option it is set to "Auto"  . This tool is really useful for embroidering hats and on delicate

fabrics that need special care regarding the placement of objects on the fabric.

If you have set more than one object to be embroidered "To start" and more than one "To end", the software

will decide automatically which one of those will be the first and which one will be last to be embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered "To start" and 5 "To

end", the software will embroider those that was set "To start" first, deciding automatically their

embroidering sequence, then those (10) set to "Auto" and finally those set "To end", deciding automatically

the order of the last 5.

The "Stop before" option is a special sequence command that you can add to the selected design, if you

want to stop the machine before sewing the object. It is useful for multi hoop designs, applique, name drop

designs and every design you need control when the machine will stop to perform a specific task.

Satin Serial

This option, when applied, sets the border outline of a design or a line design to be Satin serial. All the

border and line stitches are changing to Satin serial, which is automatically calculated and produced from the

program. The Satin serial type that was placed was selected from the program and is the default. Also, you

have the ability to change "Underlay",  stitch "Density".

Outline width

By changing this value you can edit the outline width of the selected object. You can change the value of the

outline thickness by highlighting the current value and then typing the new one. The old value will disappear

and the new one with take its place once you press "Enter/Return" key from the keyboard or click outside the

field. The value change affects the outline of the selected object. 

Also, there are some options that can help you adjust the embroidery parameters of the design. For Satin

serial stitch type they are Density, Compensation and Underlay,. Below we will describe how its option affects

the embroidery design.

Density: 

You can activate the "Density" option by checking the check-box next to it. In the numeric field, you can

specify the density of the satin stitches that you are adding. You can also adjust density by clicking on the

value and rotating the mouse wheel  if there is one. Changes are instantly previewed on the design area

and can be set by clicking outside the density field or by pressing "Enter/Return" from the keyboard.
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Compensation: 

You can activate the "Compensation" option by checking the check-box next to it. In the numeric field you

can enter the value of compensation you want with lower bounder 0mm and upper bounder 2.0mm. Also you

can adjust density by clicking on the value and rotating the mouse wheel if there is one. 

The entered value changes the width of satin stitch that will be embroidered. The default compensation value

depends on the fabric you are using. If you change fabric the compensation will adjust automatically.

Changes are instantly previewed on the design area and can be set by clicking outside the "Compensation"

field or by pressing "Enter/Return" from the keyboard. 

Underlay: 

You can activate the underlay option by checking the check-box next to it. Click on the Underlay you want,

and your change will be calculated and stored in the saved design. If you don’t select an underlay manually,

the software will automatically select the appropriate one for you. Underlay is important for quality

embroidery designs.

For Satin Serial stitch type, the following underlay patterns are available: 

Tacking – If tacking is selected, there will be no underlay and the software will

make running stitches in order to go from one position to another and cover the

area with cover stitches.

Single - If single is selected, the software will make a single line with running

stitches near the middle of the shape of the object and then cover this with cover

stitches.

Double - If double is selected, the software will make running stitches following

the shape of the object and position Double underlay near the edge of the outline.

ZigZag - If zigzag is selected, the software will create a sophisticated ZigZag

pattern which automatically changes directions (according to the direction of the

cover stitches) and then fill the shape with cover stitches.

Cross - If cross is selected, the software will create a thicker sophisticated ZigZag

pattern which automatically changes directions (according to the direction of the

cover stitches) and then fill the shape with cover stitches.

ZigZag+ - Is a combination of Zig-Zag and Double underlay.

Cross+ - Is a combination of Cross and Double underlay
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Netting - If netting is selected, the software will cover the area of the object with a

thicker sophisticated ZigZag pattern, which automatically changes directions

(according to the direction of the cover stitches) two times and then fills the shape

with cover stitches. 

Netting+ - Is a combination of Netting and Double underlay.

Double ZigZag - If Double Zig-Zag is selected a Zig-Zag underlay is applied in

both directions.

Double ZigZag+ - Is a combination of Double Zig-Zag and Double underlay.

3D-1 - Fist level of 3D look Satin stitches

3D-2 - Second level of 3D look Satin stitches (Recommended in most cases)

3D-3 - Third level of 3D look Satin stitches

3D-4 - fourth level of 3D look Satin stitches

3D-5 - Fifth level of 3D look Satin stitches

To apply 3D look on the Satin objects you have to select on of the 5 different 3D Underlays available. all of

them will give a 3D look to the shapes that you will apply them. The recommended 3D underlays are "3D-2"

and "3D-3", which will give you great embroidery results.

Remove overlaps: 

This is an automatic filter which removes all overlaps between objects of the vector designs. This filter uses

artificial Intelligence and it is applied only where necessary. The application of the filter results in the

reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping

status of each object. There are three possible options that you can apply on a specific object, "Auto",

"Never" and "Always". The "Auto" is the default option and the one that the software uses to create the best

possible results on the design. When the "Never" option is applied on an object, the specific object will never

trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will

be embroidered normally, placing all their stitches on the fabric. The opposite option is "Always". When it is

applied to a specific object it trims all the objects that it overlaps. This means that all the parts of

objects/shapes that are under the selected object will not be embroidered. 
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The software uses this tool to embroider your design more efficiently and effectively. But in order for this

function to work well, avoid applying "Trim" tool which permanently removes the stitches underneath. You

must always use it with care or after setting "Remove overlaps" option to Never. 

Sequence: 

With this tool it is possible to change the embroidering sequence of the design while it is set to "Auto" .

Specific objects of the design can be set to be embroidered at the start or at the end of the embroidering

process. This gives you the ability to sew the designs in the order you prefer. More specifically, the

"Sequence" drop down menu has three options "Auto", "To start" and "To end". The "Auto" is the default

option and the one that creates the best possible embroidering sequence results. In order to change the

embroidering sequence manually, use the other two options. The To "Start" option sets the selected object to

be embroidered first. This means that if it was to be embroidered fifth in the embroidering sequence, now

will be embroidered first in the row. Exactly the opposite for the "To end" option. When this is applied on an

object of the embroidery design, it will be immediately become the last object that will be embroidered. By

using the "To start" and "To end" options, is the only way you can change the embroidering sequence  while

the sequence option it is set to "Auto"  . This tool is really useful for embroidering hats and on delicate

fabrics that need special care regarding the placement of objects on the fabric.

If you have set more than one object to be embroidered "To start" and more than one "To end", the software

will decide automatically which one of those will be the first and which one will be last to be embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered "To start" and 5 "To

end", the software will embroider those that was set "To start" first, deciding automatically their

embroidering sequence, then those (10) set to "Auto" and finally those set "To end", deciding automatically

the order of the last 5.

The "Stop before" option is a special sequence command that you can add to the selected design, if you

want to stop the machine before sewing the object. It is useful for multi hoop designs, applique, name drop

designs and every design you need control when the machine will stop to perform a specific task.

Cutwork

The "Cutwork"  is a special type that is used in order to cut fabric or other soft materials. The "Cutwork" is

a special type for adding special type cuts which require the 4 special knifes. 
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Cutwork Outline Cutwork

The cutting needles allows every cut, namely every incision to be made directly on the embroidery machine.

The installation of four needles on a machine permits every kind of cut. The system consists of 4 cutting

needles, which replace the regular embroidery needles. They are installed at an angle of 45° to each other (0°

- 45° - 90° - 135°). Simple forms such as rectangles, squares, etc. requires only two needles for cutting.

However, with all four needles, every kind of complex forms can be archived. The use of these does not

require any change in the machine. The only need is to switch off the "thread break" sensor.

To create a Cutwork you must select a curve or  a closed shape/text object with outline and assign it to

"Cutwork" option that you will find in the "Outline" tab of "Properties" bar. Its length should not exceed 1mm.

 The cutting needle has width of 1,2mm. The cutting can be programmed independently, either before or

after the embroidery. 

Create a Cutwork

To create a Cutwork design, you can select a curve or a closed shape/text object with outline and then click

on the "Cutwork"   icon on the "Properties > Outline" tab.

After assigning the "Cutwork" option to the outline shape you can adjust the way you want the cut to be

made from the available options of Properties bar.
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Outline width:

With this option you can specify the outline width of the Cutwork design you have created. The value that you

will set it does not affect the cutwork but the design. Type value you want in the field and press

"Enter/Return" to apply the change.

Length:

With this option you can specify the length of the Knife's movement while cutting. The maximum length is

2mm but it is advisable to keep it lower than 1mm. To change the "Length", type the new value and press

"Enter/Return" to apply the change.

Running before

With this option you can specify how many running stitches you want to be made on the fabric before

applying the cutwork. We do that to stabilize the fabric and make the cutwork look better and not loose.

Usually 3-5 running passes with different offsets before applying the cutwork will do. The options you have

for creating this running stitches are listed below.

· Offset: 

In the "Offset" numeric field you can enter the value of offset you want, with lowest value of -15mm and

highest value 15mm. Also, you can increase or decrease the offset value by clicking on the value and

rotating the mouse wheel, if there is one. The value that you are inserting defines the exact distance you

want the running before outline to have from its initial position. If the value is negative, the running object

will make an inner offset and vice versa, if it is positive. The default offset value is zero and can be changed

only from you. Any changes you are making on the offset value they are automatically previewed on the

design.

The "offset" is mainly used to move the "Running before" from the position where the cutwork will be

made and avoid cutting it. Also, the "Running before" will hold the fabric in place and protect it from

unraveling when the cutwork will be applied.

· Length:

In the "Length" numeric field you can specify the length of running stitches for the "Running before". Also,

you can adjust length by clicking on the value and rotating the mouse wheel if there is one. Changes are

instantly previewed on the design area and can be set by clicking outside of the length field.

The minimum stitch length that you can set is 0.8 millimeter and the maximum 99.9 millimeter.

· Passes: 

With this option we can set the number of passes that "Running before" will make to stabilize the fabric.

The maximum number of passes that you can set is 9 and the minimum 1. 

To change the "Passes" value you can type the exact value you want and then press the "Enter/Return" key

from the keyboard. Another way to increase or decrease the value is by clicking inside the Passes field and

use the mouse wheel to change its value. The changes that you will make will be immediately applied on
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the design. Every running pass that will be made will not penetrate the fabric in the same position the

previous one did, securing the fabric tricot even more. 

Any change in the "Passes" value is becoming visible only if you simulate the design with the "Slow redraw"

functionality from the tools toolbar. Otherwise the changes are not visible. 

Cutting offset

With this option you can specify the distance, inner or outer, you want the cutwork to be moved. For example:

if you set the "Cutting offset" value to 3mm the cutwork will move its outline by 3mm to all directions outside

its starting position. On the other hand if you set the value to -3mm the cutwork will move its outline by 3mm

to all direction inside its starting position. 

In the "Cutting Offset" numeric field you can enter the value of offset you want (cutwork offset), with lowest

value of -9mm and highest value 9mm. Also, you can increase or decrease the offset value by clicking on the

value and rotating the mouse wheel, if there is one. The value that you are inserting defines the exact distance

you want the running before outline to have from its initial position. If the value is negative, running object

will make an inner offset and vice versa, if it is positive. The default offset value is zero and can be changed

only from you. Any changes you are making on the offset value they are automatically previewed on the

design.

Running 

With this option you can specify how many running stitches you want to be made on the fabric after applying

the cutwork. We do that to either stabilize the fabric (some people prefer to stabilize the fabric after and the

cutwork and not before) and prepare it for Net fill or decorate the cutwork you have created. For stabilizing

the fabric usually 2-5 running passes with offset after applying the cutwork will hold the fabric properly. The

options you have for creating these running stitches are listed below.

· Offset: 

In the "Offset" numeric field you can enter the value of offset you want, with lowest value of -9mm and

highest value 9mm. Also, you can increase or decrease the offset value by clicking on the value and rotating

the mouse wheel , if there is one. The value that you are inserting defines the exact distance you want the

Running outline to have from its initial position. If the value is negative, the running object will make an

inner offset and vice versa, if it is positive. The default offset value is zero and can be changed only from

you. Any changes you are making on the offset value they are automatically previewed on the design.

The "offset" is mainly used to move the "Running" from the position where the cutwork was made and

avoid placing stitches in the cut area. Also, the "Running" will hold the fabric in place and protect it from

unraveling, if no other running stitches have been applied before the cutwork.
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· Length:

In the "Length" numeric field you can specify the length of running stitches for the "Running". Also, you can

adjust length by clicking on the value and rotating the mouse wheel if there is one. Changes are instantly

previewed on the design area and can be set by clicking outside of the length field. The minimum stitch

length that you can set is 0.8 millimeter and the maximum 99.9 millimeter.

The "Length" value is important for applying "Stitches" on the "Running" object and decorate the cutwork.

By changing the length your are changing also the size of the "stitches". It is important though not to

decrease the "Length" value that it took when you applied the "stitches", further because it will end up

making zero length stitches that will cause unexpected thread trims to the final embroidery result. You can

increase the length without any problem.

· Passes: 

With this option we can set the number of passes that "Running" will make to stabilize or decorate the

fabric. The maximum number of passes that you can set is 9 and the minimum 1. 

To change the "Passes" value you have to either click on the up and down arrows next to the field to

increase or decrease its value or type the exact value you want and then press the Enter key from the

keyboard. Another way to increase or decrease the value is by clicking inside the "Passes" field and use the

mouse wheel to change its value. The changes that you will make will be immediately applied on the

design. Every running pass that will be made will not penetrate the fabric in the same position the previous

one did, securing the fabric tricot even more. 

Any change in the Passes value is becoming visible only if you simulate the design with the "Slow redraw"

functionality from the tools toolbar. Otherwise the changes are not visible. 

· Stitches: 

The "Stitches" area contains all the stitch stitches that can be applied on the "Running" option. The

"Stitches" is a way of movement from one point to another, which normally can be done by one stitch.

Stitches, when applied, are placed one after another. By applying different stitches you can create great

decoration stitches for your cutwork. 

Select the "stitches" you prefer by clicking on it. Your selection is instantly displayed in the design area

letting you experiment with your embroidery design.

By clicking on the "None" "stitches", no "stitches" will be applied on the "Running". 

There are 325 stitches that you can use to produce unique designs. The stitches that are in film icon (for

example: ) are a series of different stitches in one.

Net fill

This option when applied fills the cut area with "Net Fill". The "Net fill" is a special fill type that adds two scan

lines that are crossing, with parallel equidistant running stitches. These two scan lines are forming a Net that

is used to fill the cutwork and create beautiful designs. 
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The Net fill includes some more options that allow us to customize the way that will be applied on the

selected object. These options are the following:

· Cell size: 

With this option you can specify the size of each square side that the Net fill consists of. For example by

setting the "Cell size" to be 2.0 mm all squares of the net will have 2.0 mm side size. The maximum value

that the "Cell size" can have is 9.9mm and the minimum is 0.5mm. To change the value of the Cell size

option you can type the exact value you want and then press the "Enter/Return" key from the keyboard.

Another way to increase or decrease the value is by clicking inside the Cell size field and use the mouse

wheel to change its value. The changes that you will make will be immediately applied on the design. By

changing this value you can create a net with large squares or small squares according your preferences. 

· Offset: 

With this option you can specify the distance, inner or outer, you want the Net fill to be moved. For

example: if you set the "Offset" value to 3mm the Net fill will increase its size by 3mm to all directions

outside its original outline. On the other hand if you set the value to -3mm the Net fill will decrease its size

by 3mm to all direction inside its original outline. 

The maximum value that the "Offset" can have is 9.0mm and the minimum is -9.0mm. To change the

"Offset" value you can type the exact value you want and then press the Enter key from the keyboard.

Another way to increase or decrease the value is by clicking inside the "Offset" field and use the mouse

wheel to change its value. The changes that you will make will be immediately applied on the design. By

changing this value you can make adjustments on the "Net fill" size, which is really useful when you want to

cover the cutwork and making sure that the net will be embroidered on the fabric and not inside the hole.

This option is very important for creating proper Net fills.

· Angle:

With this option you can change the Angle that the "Net fill" will be applied. For example: When the angle

is set to 0o degrees the "Net fill" will be aligned on the X and Y axes creating right angles. If you change

the Angle value to 30o degrees the "Net fill" will be rotated 30o degrees anticlockwise and change

completely its direction. 

The "Angle" values that you can set are between 0o and 360o degrees. To change the "Angle" value you

can type the exact value you want and then press the Enter key from the keyboard. Another way to increase

or decrease the value is by clicking inside the "Angle" field and use the mouse wheel to change its value.

The changes that you will make will be immediately applied on the design. 

By changing the "Angle" of the "Net fill" you can orientate it based on the shape that it is applied on. This

ability allows you to produce better and more beautiful embroidery results.

Satin Serial

With this option you can apply "Satin Serial" on the cutwork and cover the edges of the cut fabric. It can be

used also to hold the Net fill in place and secure the fabric from unraveling. The applied Satin serial has the

same width with the "Outline" value that is set on the "Tool options" toolbar. Also, the software give you the

ability to change some Satin serial parameters according your preferences. These parameters are the

following:

· Offset: 

Inside the Offset numeric field you can enter the offset value you want, with lowest value of -8mm and

highest value 8mm. Also you can increase or decrease the offset value by clicking on the value and rotating
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the mouse wheel, if there is one. The value that you are inserting defines the exact distance you want the

satin serial outline to have from its initial position. If the value is negative, the satin serial object will make

an inner offset and vice versa, if it is positive. The default offset value is zero and can be changed only from

you. Any changes you are making on the offset value it is previewed on the design.

· Density:

Inside the Density numeric field you can specify the density of satin serial stitches that you are adding. Also,

you can adjust density by clicking on the value and rotating the mouse wheel if there is one. Changes are

instantly previewed on the design area and can be set by clicking outside the density field.

Discard part

The Discard part drop down menu gives you the ability to specify which part of the fabric will be discarded

after the cutwork.

· Auto: If the "Auto" value is set means that the software will automatically decide which part of the fabric

must be discarded. The software decides between "External", "Internal" and "Both", which are the available

"Discard part" options and they are explained below. The decisions are made automatically and you can

change them according your needs. 

· External: If the "External" option is selected, the part of the design will be kept, after applying the cutwork,

will be the fabric inside the cutwork outline. The rest must be thrown away (Discard part). 

· Internal: By default the "Internal" option is selected. This means that the part of the design that will be kept

after applying the cutwork will be the fabric outside the cutwork’s outline. The rest must be thrown away

(Discard part).

· Both: If the "Both" option is selected the fabric will be cut along the path but no fabric/stitches will be

thrown away. This option is set when you apply cutwork embroidery type on open shapes or when there is

embroidery inside or outside of the defined cutwork area.

Remove overlaps: 

This is an automatic filter which removes all overlaps between objects of the vector designs. This filter uses

artificial Intelligence and it is applied only where necessary. The application of the filter results in the

reduction of stitches that will be placed on the fabric. It is also possible to manually alter the overlapping

status of each object. There are three possible options that you can apply on a specific object, "Auto",

"Never" and "Always". The "Auto" is the default option and the one that the software uses to create the best

possible results on the design. When the "Never" option is applied on an object, the specific object will never

trim the objects that overlaps. This means that all the objects/shapes that are under the selected objects will

be embroidered normally, placing all their stitches on the fabric. The opposite option is "Always". When it is



191

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Embroidery - Creating embroidery designs

applied to a specific object it trims all the objects that it overlaps. This means that all the parts of

objects/shapes that are under the selected object will not be embroidered. 

The software uses this tool to embroider your design more efficiently and effectively. But in order for this

function to work well, avoid applying "Trim" tool which permanently removes the stitches underneath. You

must always use it with care or after setting "Remove overlaps" option to Never. 

Sequence: 

With this tool it is possible to change the embroidering sequence of the design while it is set to "Auto" .

Specific objects of the design can be set to be embroidered/cut at the start or at the end of the

embroidering process. This gives you the ability to sew the designs in the order you prefer. More specifically,

the "Sequence" drop down menu has three options "Auto", "To start" and "To end". The "Auto" is the default

option and the one that creates the best possible embroidering sequence results. In order to change the

embroidering sequence manually, use the other two options. The To "Start" option sets the selected object to

be embroidered/cut first. This means that if it was to be embroidered fifth in the embroidering sequence,

now will be embroidered first in the row. Exactly the opposite for the "To end" option. When this is applied

on an object of the embroidery design, it will be immediately become the last object that will be

embroidered/cut. By using the "To start" and "To end" options, is the only way you can change the

embroidering sequence  while the sequence option it is set to "Auto"  . This tool is really useful for

embroidering hats and on delicate fabrics that need special care regarding the placement of objects on the

fabric.

If you have set more than one object to be embroidered "To start" and more than one "To end", the software

will decide automatically which one of those will be the first and which one will be last to be embroidered. 

For example if you have a design with 20 objects and you have set 5 to be embroidered "To start" and 5 "To

end", the software will embroider those that was set "To start" first, deciding automatically their

embroidering sequence, then those (10) set to "Auto" and finally those set "To end", deciding automatically

the order of the last 5.

The "Stop before" option is a special sequence command that you can add to the selected design, if you

want to stop the machine before sewing the object. It is useful for multi hoop designs, applique, name drop

designs and every design you need control when the machine will stop to perform a specific task.

Printout with Cutwork

The printout of a Cutwork design is important to the embroidery process. In the printout, except of the

standard information you can find also, information about, which “Knife” must be placed in which needle

carrier(or every time the machine will stop) in order the “Cutwork” function to work properly. Depending on

when you want the cuts to be made (before or after the embroidery) you can change the cutting order by

changing the sequence of embroidering process.

For avoiding mistakes while placing the “Knifes” follow the guidelines.
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· Knife — = Place 0o knife in the specified needle carrier 

· Knife / = Place 45o knife in the specified needle carrier 

· Knife | = Place 90o knife in the specified needle carrier 

· Knife \ = Place 135o knife in the specified needle carrier 

Stitch flow

Stitch flow is a special operating mode that provides tools to adjust the directions of stitches and divide

objects into sections. Using the available stitch flow tools, you can improve embroidery quality and the look

of your designs. When you start Stitch flow you can only work with directions and divides. For any object that

you click, on the top part of the design area you see the available stitch flow options. For example, if you click

on a Satin object you see the following functions available: Directions and Divide. 

If you click on a Step object you only see the "Directions" option. For example, if you start Stitch flow and

click on a Step object like the following image, you only have the Directions option and you need to click and

drag to draw a line that will define the direction of stitches. Once you release the mouse the direction is

automatically applied. 

For Satin objects, it is possible to add multiple "Divide" and Direction lines and manage the way in which the

outlines are split into satin bars. Using Stitch flow you can customize the way "Satin" objects will be

embroidered and create exactly the design you want. 

So if you click on a Satin object like in the following image, select Divide option, can click and drag from one

side of the object to the other, you can one or more divide lines. 

Likewise, if you switch to Direction tool you can add one or more Direction lines.
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In order to delete the divide line you have created, just click on the ‘X’ icon in the middle of the line. You can

change any existing divide line by clicking and dragging the points of the line. The "Divide" line has green

color in order to distinguish them from the directions lines that are red. 

It is very useful also when you want to create Text art designs and embroider the design with a specific way.

You can divide the satin characters and define exactly the way you want to be embroidered. 

With the combination of "Divide" and "Directions" tools you can create unique designs that can have many

sub-objects as brunches and specific direction of stitches for each sub-object. 

Notice: While working with Stitch flow tool, you can switch between the available Stitch flow options

by pressing "D" key. If you are using Directions and press "D" key you switch to Divide, if you press

"D" once more you switch back to Directions tool.  It is like a toggle key to switch between the

available Stitch flow tools. 

You can start the "Directions" tool using Ctrl+Shift+D keyboard shortcut (Mac OS Cmd+Shift+D).

You can start the "Divide" mode using Shift+D keyboard shortcut (Mac OS Shift+D).

Special functions

A "Special function" is a special command that will instruct the embroidery machine to perform a special

action. Inside the software there are two available "Special functions", "Trim" and "Stop" and they are

available only when the Sequence is "Manual" mode.

Thread trim

This special function instructs the embroidery machine to make a pause, cut the thread and then start

embroidering again. To add a "Trim" special function you have to select the object that will become also

selected in the Sequence manager. Then you have to right click on it in the Sequence manager and expand

the "Trim" option. By default it is set to "Auto". To enable the "Trim" special function you have to set it to

"On". 
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If an object has a "Trim" Special function applied, the relative  icon will appear next to the object on the

Sequence manager. 

If you set the "Trim" Special function to "Auto", then the software will decide if it will add a thread trim or

not, based on the settings of the "Optimizer options" dialog. If the software decide to add a thread trim on

an object you will see the "Auto"  icon next to the object, so you will know that the embroidery machine

will make a thread trim before sewing out the object. If you do not want the Auto thread trim to happen you

can either change the settings in the "Optimizer options..." or set manually the "Trim" to "Off". If you set it to

"Off" the following  icon will appear next to the object.

Stop

This special function instructs the embroidery machine to Stop, there are things that can’t be done

automatically by the embroidery machine, the machine makes a stop and waits until you press start. To add a

"Stop" special function you have to select the object that will become also selected in the Sequence

manager. Then you have to right click on it in the Sequence manager and expand the "Stop" option. By

default it is set to "Auto". To enable the "Stop" special function you have to set it to "On". 

If an object has a "Stop" Special function applied, the relative  icon will appear next to the object on the

Sequence manager. 
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If you set the "Stop" Special function to "Auto", then the software will decide if it will instruct the machine to

stop or not, based on the settings of specific stitch types. If you do not want the stop to happen you can set

manually the "Stop" to "Off". If you set it to "Off" the following  icon will appear next to the object.

Design Properties

Apart from the stitch changes that you can make in your embroidery designs, you can also adjust the

properties of its design. You can add general information about the design and optimize the way it will be

embroidered. You can access Design properties from menu "File > Design properties". In the dialog box that

will appear, you can adjust the properties in the General and Optimizer tab.

General

In the general tab you can add information about the "Designer’s name", design "Keywords" and any

"Remarks" about the design. The search mechanism of the design browser can locate a design by its name or

by keywords that you can define.

· Designer

In the "Designer" text field you can add information about the designer (Name, company, etc.). These fields

are useful for record keeping. 
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· Keywords

In the "Keywords" field you can add words that describe the current design. The keywords can be used only

if you save your designs in “.NGS” or “.DRAW” format. 

The “NGS” file format can be opened from WINGS SYSTEMS Ltd digitizing programs, eXPerience®

and Wings’ modular®. Those software include a browser where keywords can be used as a filter in

search option. If you are dealing with hundreds of designs it can be a vital function for quickly

searching your database. Many people find it easier to write down a fixed list of options or keywords

to allow multiple users to enter data in the same style into a common design database. 

· Remarks

In this text area you can add any remarks for your design. Any information about stitch type, color palette,

fabric type and number of threads that was used in the design creation are useful for quick reference for

anyone that might use it. Also you can add instructions relating to embroidery production. 

Any changes in the General tab can be saved as default, by clicking on the "Save as default" button, which

means that every time you create a new design the already saved settings will be displayed. 

Optimizer

The "Optimizer" is very important for adjusting the way of the final embroidery will be produced. 

All options that you will find inside the Optimizer, refer to embroidery production process and are important

for quality stitch output. The optimizer tab can be accessed, also, from Optimizer options of Tools menu or

by pressing Ctrl+Shift+J shortcut keys together from the keyboard. 
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The Optimizer options that you can adjust are listed below:

Appliqué frame out distance 

This setting is important for designs that include appliqué. In production of embroidery designs with

appliqué, there is a phase where the machine will stop, bring the frame out and ask you to add the appliqué

in the predefined area. In that phase, the frame movement that the embroidery machine makes, is defined as

Appliqué frame out distance. By changing the value of this field, you are setting the frame out movement

from the position where it stopped. 

Trimming distance between objects

This tool is applied only to embroidery objects (the Embroidery Technique should be active). 

With thread trims between the objects of the embroidery design you get high quality of embroidery in longer

time because every time the machine cuts a thread, it takes some time to start embroidering again.

On the other hand, without trims between the objects, you get high quality of embroidery in less production

time. The jump-stitches are there to connect the object without cutting the thread. You can either cut the

jump-stitches manually afterwards or keep them on the design. In cases where the objects are too close,

jump-stitches are not a problem for most embroiderers but it is the best way of embroidering. It is also

matter of embroidering style.
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This setting is important for thread trimming in the embroidery production process. With the "Trimming

distance between objects" option you are setting the distance that the software will use to check each jump-

stitch between objects. If the software find a longer stitch it will cut it. 

Therefore, if you want to make sure that thread trims will be added to the entire design you have to set the

value to 0.5mm.

Trimming distance in Cross-stitch

This tool is applied only to embroidery objects (the Embroidery Technique should be active).

This option handles the trimming distance between cross-stitch objects. In the software the cross-stitch

designs are treated as one object. In the cross-stitch designs we can treat the thread colors that are filling the

design as objects. Cross-stitch designs in most of cases have scattered crosses with the same color that makes

the trimming calculations difficult. The Trimming distance in Cross-Stitch option gives you the ability to

define the distance that you want a thread trim to occur between the color objects of the design. The

trimming needs are different in different designs therefore you must be careful with the inserted value in this

option. 

End points at closest connection, even on trims

This option is important for the way that the design will be embroidered. When the check-box is checked, the

software filters the entire design and finds the closest connection points between the objects, even if a trim is

made. This option gives better rooting between objects and better flow to the embroidery. In addition, it

gives fewer thread trims because the objects of the same color are connected from their closest point. 

Start/Return to center of hoop

This option is important for the way that the design will be embroidered. When the check-box is checked, the

software will force the embroidery machine to return to the center of hoop after the end of the embroidering

process. Also will force the machine to start from the center of hoop. 

Enable Auto-sequence

This option shows if the "Auto"  sequence is enabled or not(it acts as an indicator). If it is checked the

"Optimization Strategy" section will be available. If you set the Sequence  button to "Manual" the

"Enable Auto-sequence" will be unchecked. 

Optimization strategy

This tool is available only if the "Auto-sequence" option is enabled (the Embroidery Technique should be

active). 

With this tool you can define the way that the objects of the embroidery design will be embroidered. It is like

an automatic embroidering sequence creator. With this tool you can define the way/sequence in which the

objects of the embroidery designs will be placed on the fabric. This tool is really important for embroidering

hats which need to be embroidered from the center to right and left. Also, it is useful for delicate fabrics that
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need special care regarding the way that the objects will be placed on them. The embroidering options for

defining the sequence of the objects are the following:

· Top to bottom:

When this option is applied the objects of the design will be embroidered from top to bottom. This means

that the software will change the embroidering sequence and will begin embroidering the objects/shapes

that are at the upper most position in the design and will continue with direction to those that are at the

lower position in the design.

· Bottom to top:

This is the opposite of Top to bottom option. Therefore when it is applied on an embroidery design the

software will change the embroidering sequence and will begin embroidering the objects/shapes from

those that are located at the bottom until it reaches the top objects.

· Left to right:

When this option is applied the objects of the design will be embroidered from left to right. This means

that the software will change the embroidering sequence and will begin embroidering the objects/shapes

that are at the left most position in the design and will continue with direction to those that are at the right

most position in the design.

· Right to Left: 

This is the opposite of the Left to right option. Therefore when it is applied on an embroidery design the

software will change the embroidering sequence and will begin embroidering the object/shapes from

those that are located at the right most position in the design until it reaches the left objects.

· Small to large: 

When this option is applied the software orders the embroidering sequence from the smaller object of the

design to the largest ones.

· Large to small: 

This is the opposite option of the Small to large option. Therefore when it is applied on a design the

objects/shapes of the design will be embroidered from the larger ones to the smaller ones.

· Inside to outside: 

When this option is applied the objects of the design will be embroidered from inside to outside. This

means that the software will change the embroidering sequence and will begin embroidering the

objects/shapes that are at the middle of the design and continue with those that are at the outer positions

of the design. This option is often used when embroidering designs on hats. 

· Outside to inside: 

This is the opposite option of the Inside to Outside option. Therefore, when it is applied on a design the

objects/shapes will be embroidered from the outer to the inner ones. the software will check the current

sequence of the design and will make recalculation in order to create one you have selected.

Any changes on the Optimizer options dialog, affects, also, the "Optimization strategy" option.

Therefore, always keep in mind that a combination of Optimizer’s options will be applied on the

embroidery design and not only the selected Optimization strategy. With proper combination of

options you can get the appropriate embroidery results. 
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Keep sequence of overlapped objects, even if trimmed

This option is available only if the Auto-sequence option is enabled (the Embroidery Technique should be

active).

This option is important for the embroidering sequence of the design. When this option is checked, all shapes

of the vector design will be embroidered by keeping their overlapping order. This means that the order of

the embroidery will follow the overlapping order of the vector design. By applying this option it will be

possible to manage better the way that the design will be embroidered. 

Changes that you make on the overlapping order of the Vector design are calculated accordingly by

the software. The overlapping order will not be followed as it is because more filters are applied on

the design, which affect the embroidering sequence. 

No thread trims inside combined objects

This option is available only if the "Auto-sequence" option is enabled (the Embroidery Technique should

be active).

This option, when it is checked, does not allow any thread trimming between combined objects. This option

applies only to objects that are combined (not grouped). 

In order to use this option properly you have to select the objects you want to combine and apply the

"Combine" option from the right click menu. The objects will become combined and react as one object,

inheriting all the attributes of the last selected object. If you try to simulate the design ,you will view the

combined objects (like text art objects) to be connected with a jump-stitch between them. With the "No

thread trims inside combined objects" option checked, all combined objects will be embroidered with jump-

stitches between them, even if you have set Trimming distance between objects" option to shortest distance. 

If you leave the value of "No thread trims inside combined objects" unchecked, all thread trims will be

calculated normally.

Combined object: An object created by combining two or more objects and converting them into a

single curve object. A combined object takes on the fill and outline attributes of the last selected

object. 

Minimize color changes

This option is available only if the Auto-sequence option is enabled (the Embroidery Technique should be

active).

This option is important for limiting color changes in the embroidery production process. Color changes have

to do with thread changes that the embroidery machine makes in order to embroider each stitch design

object. With more color changes the embroidery design sequence is followed more accurately but the

production process is longer. On the other hand with fewer color changes, the embroidery design sequence

changes to fit the Minimizing color change settings but gives shorter production process. The alteration in the
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embroidery design sequence might produce inaccurate embroidery results, or might not. This depends on the

embroidery design, embroidery machine and the fabric. You can adjust color changes through the use of the

track bar. 

Also, you can change the value of the track bar by pressing the Left & Right arrows of the keyboard. 

Any adjustments you are making are for your current design. If you want your adjustments to be stored as

default, click on the "Save as default" button  in the Optimizer tab. 

In case you have changed the default the software settings with your own and you want to restore them, you

can click on the Restore factory defaults button 

In case you have changed the settings of Optimizer and you want to return to your previous Saved as defaults

settings, you have to press the  button. This function will restore the last saved setting

that you saved by clicking on the Save as defaults button.

Machine / Hoop

Machine and hoop selection is crucial upon design creation. First, it helps you have a better view of the

design in the hoop and make sure that the designs indeed fits the hoop. Second, it informs the software

about the machine you are working on, so that the embroidery file exported is suitable for your machine. 

So, when you export the design, you only see the formats that the selected machine supports. This is

necessary because many embroidery machine manufacturers require the imported file to have information

about the hoop that is to be used. Otherwise, the file is not recognized by the machine. Embroidery machine

manufacturers like, Janome, Elna, Brother, Pfaff, Husqvara - Viking, Babylock, Necchi, etc. use files formats that

have a hoop assigned to each design. Formats like PES, PEC, PCS,PCM,VP3,JEF, JEF+ appear on the Save list

only when a suitable machine and hoop are assigned to a design. 

When the design does not fit in the stitch-out area of the hoop, the area turns red and you need to change

the design or the hoop so that the design fits into the hoop. In this topic we will show you how to change or

move the hoop and how to set a default hoop. 
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If the hoop you have selected is not visible on the working area you have to enable it by selecting the

"Hoop" option from the "View" menu. If the "Hoop" option is checked and the hoop is still not visible,

try to "Zoom out" with any of the available zoom tools or by using the mouse wheel while holding

the Ctrl key down. 

Set the default hoop

You can set the default hoop only from the "Welcome" page of the software. When you start the software

you always get to see the welcome tab. On the welcome tab, there is a hoop icon which displays info about

the default selected hoop. 
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1. Click on the "hoop" icon to set the default hoop. 

2. A pop over will appear. 

3. Select the brand of your embroidery machine by clicking on the "Company" drop down menu. 

4. Select the model of your embroidery machine by clicking on the "Machine" drop down menu. 

5. The hoops that the selected machine supports will appear in the "Hoops" area. Select the hoop that you

will use. Once you click on a hoop, the pop over will close and the selected hoop will be set as the Default

one. Every design that you will create from now on will be created with this hoop.



204

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Embroidery - Creating embroidery designs

Edit hoop  

In some cases, you may need to use an alternative hoop or move the currently used one, without changing

the default hoop. For example, when the design extends beyond the hoop, the area is displayed in red. If you

don't want to change the size of your design, you may move the hoop to place the design inside it or select a

bigger hoop. Let's see how you can edit the hoop. 

1. You can change or move the hoop using either the "Machine/Hoop" icon, which is located in the lower

part of the tools toolbar, or the "Change" option that is available under the machine icon on the top

toolbar. 

2. When using any of these options you start a working mode through which you can only affect the hoop. If

you are using "Change" option, in order to change the hoop, you need to close the "Edit hoop" dialog

first. 
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3. Drag the hoop to place the design inside it, if possible. If the hoop is not selected, click the hoop and it

will turn blue. If the design fits into the hoop, the red color on top of the hoop area is removed. 

4. While moving the hoop, the center of the hoop snaps on the center of the design, to help you place your

design onto the center of the hoop. 

5. You can also change the position of the hoop or rotate the hoop using numeric values on the "Tool

options" bar that appears on the upper right part of the design area.

6. Change the values in the "X" and "Y" fields to position the hoop accurately on the workspace. Click in the

respective fields and type the values you want. Press "Enter/Return" and the software will move the hoop

to the "X" and "Y" axes immediately. 
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7. To rotate the hoop, you can use the "Rotation" option. Type the Rotation value you want in the field and

press "Enter/Return". The hoop will rotate counter-clockwise. You may set values from 0 to 359 degrees.

8. In case you can't fit the design into the hoop, you may select a bigger hoop to accommodate the design.

Double click on the hoop icon that has appeared in the upper right corner of the design area. 

9. The "Edit hoop" dialog will appear. 



207

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Embroidery - Creating embroidery designs

10.Set "Company" and "Machine". Only the hoops that can be used with the specified sewing machine are

displayed.

11.Click the hoop that you will use. The pop over closes and the selected hoop is placed on your design.

You can adjust the hoop display size by moving the track bar at the bottom of the screen to the left or

right.

The software also provides multi hoop  functionality, which allows you to stitch out large designs in

multiple hoops. Using the "+" button you can add extra hoops and create multi-hoop designs. This is

presented into the following section. 

Center design to hoop

An easy way to align the hoop with the design is to click "Center to Hoop" from the "Machine" on the

standard toolbar. The design will be then centered to the hoop.

Fit to hoop

With this option you can fit any design in the hoop. Simply click on the "fit to hoop" option, and the program

will automatically scale the design to fit within the embroider able area of the hoop. No longer do you need

to manually adjust or guess at the correct size - our software takes care of it for you. 
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If the design is larger than the embroider-able area of the hoop it will scale it down to make it fit. On the

other hand if the design is smaller that the embroider-able area of the hoop it will scale it up to make it fit.

The software always keeps a safety distance from the hoop's edge.

If the software finds that the design fits better if the hoop is in landscape mode, it will rotate the hoop and

make it fit. 

Add custom hoops 

You can also create Custom hoops, in case a hoop you have in hand is not available in the list of Hoops for

the selected machine model. Go to the menu tools and select "Options";  on the appearing dialog go to the

"Custom hoops" tab. Press the "Plus" icon to add a custom hoop.  

1. Type a name for that hoop.



209

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Embroidery - Creating embroidery designs

2. Select the machine manufacturer and the model of the machine. In case the manufacturer of the machine

or the machine model is not available on the lists, you may double click on the list and type the

manufacturer name OR the model name yourself. 

3. Select the shape of the hoop. 

4. Define the useful area by typing a width and height value.

5. From now on, this hoop will also be available in the hoop list of your machine. 

Embroidery machine manufacturers like, Janome, Elna, Brother, Pfaff, Husqvara - Viking, Babylock,

Necchi, etc. use files formats that have a hoop assigned to each design. So when using a custom hoop

you may not be able to export to formats like PES, PEC,PCS,PCM,VP3,JEF, JEF+, as those formats

appear on the Save list only when a suitable machine and hoop are assigned to a design. 

Add Mutliple hoops

The software provides a multi-hoop function which allows you to stitch out large designs in multiple hoops.

For example, the following design can't fit even in the biggest hoop this machine supports. In order to

embroider it, we need to use multiple hoops. 



210

User guide 
 
                                                                                                                                                                                                                                                                           © 2025 DRAWstitch Intl Ltd.

Embroidery - Creating embroidery designs

1. To edit the currently used hoop, use either the "Machine/Hoop" icon, which is located in the lower part of

the tools toolbar, or the "Change" option that is available under the machine icon on the top toolbar. 

2. When using any of these options, you start a working mode through which you can only affect the hoop. 

3. In order to add an additional hoop, click on the '+' button of the hoop manager. 

4. The "Insert hoop" dialog will appear. 

5. Select the position where you want the hoop to be placed from the "Hoop Position". You can select more

than one positions and insert multiple hoops at once.

6. Click on the "Hoop" that will be the additional one. The pop over closes and the selected hoop is placed

in your design.
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7. Multiple hoops have been added to the design as shown below. The “Hoop option” shows all the hoops

you have placed.
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8. When you click on one hoop, it is displayed in blue while under the “Hoop option” the hoop is marked

with a blue line. A hoop displayed in blue can be moved, rotated, and deleted.

· To move the hoop, drag it or enter a value in "X", "Y" in "Properties".

· To rotate the hoop, enter a value in "Rotate" in "Properties".

· To delete the hoop, press "Delete" or hover over "Hoop option" and click the [X] that appears.

· In the “Hoop option” the hoops are arranged from top to bottom in the embroidering order. You may

change the order by dragging the icons.

The software processing speed may slow down and the "Show entire hoop" function may not show

the whole image depending on PC specifications.

Move hoops - Customize Cut line

The areas where the hoops overlap are highlighted in blue rectangles and the diagonal line with the red

handles defines how the design will be split. The parts that are under the line correspond to the lower hoop,

while the parts over the line correspond to the upper hoop. Any part that is crossed by the line may be

divided if necessary.
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1. Move each hoop over the shapes that you want it to encompass. 

2. Move or edit the Cut Line, to accommodate the design parts into the respective hoop. Move the nodes at

both ends of the Cut Line to set the cutting position.  

3. The Cut Line needn’t always be a straight one. It can also be formed by connected lines to allow for a

custom split. Place the mouse over any point on the line, double-click and a node is added. The node is

displayed, and you can move it to adjust its position. You can then add and move the multiple nodes to

create a series of connected lines, which allow you to easily divide the parts between the hoops.  To delete

a node, double-click on it or press the [Delete] key.

If creating a split line or a series of lines is not possible and the cut line is crossing design parts then

some design split may occur. In general, the software tries to avoid object/shape trimming, and keep

the embroidery quality high. This is not always possible. With the line you can specify where the

objects will be trimmed.

To check exactly what parts of the design go to each hoop, you can switch into slow redraw. Click on any hoop

to see the exact parts of the design that are assigned to that hoop. 
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Saving Design to Embroidery File

When you are done editing your design and you have verified in Slow redraw that the design is divided as

you like, you can save it as an Embroidery File to send for production. One thing you should have in mind is

that when saving a design with multiple hoops into an embroidery file, a separate file will be created for

each hoop. 

1. From the “File” menu, click on the "Save as" option.

2. From the Save dialog, select an embroidery file type that your machine supports.
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3. The software will save a separate file for each hoop and you need to load them one after the other for

your machine to stitch out the whole design.  

4. Finally, you may make a printout where all information of how the design is to be stitched out is listed.

You shall find it very helpful. 

Embroidery sequence

In this section we will analyze the tools that the software includes to adjust the embroidery sequence of the

designs you are creating. The software includes automatic and manual tools for producing the embroidery

sequence. You can combine the different available tools and produce the embroidery results you prefer. 

Automatic Embroidery sequence 

Manual Embroidery sequence 

Automatic Embroidery sequence

The software includes an automatic sequencing mechanism that produces great results based on the

sequencing options that you have set. The tools described bellow, are responsible for adjusting the automatic

embroidery sequence: 

1. Auto sequence tool

2. Sequence tool
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With these tools you can adjust the automatic embroidery sequence that is produced from the software. 

Auto sequence 

In this section we will analyze how the Auto sequence mode works and how to switch to Manual sequence to

re-arrange/optimize your design manually. By default the software is working on Automatic sequence mode,

this means that the software automatically decides about the sequence of all design objects according to its

innate optimization strategy. So, you practically leave all control over the sequence, to the software, Which

uses its intelligent mechanisms to find the optimum sewing sequence. 

The software though is making its decisions, based on the optimizer options. On Optimizer options dialog on

section "Optimization strategy", we can see the rules of the automatic optimization strategy. For example, the

option "Large to small" means that larger objects are embroidered first. Now, if you switch to slow redraw,

you will see that the largest object will be embroidered first, the second larger second and so on. If we

change the optimization strategy, a different order will be followed. So, Using "small to large", the smaller

object will be first sewn first and so on. 

 

The options that you can adjust about design optimization are the following:

· Optimization strategy: With this option you can define the way that the objects will be embroidered. It is an

automatic embroidering sequence creator. With this tool you can define how the objects of the embroidery

designs will be placed on the fabric. The embroidering options for defining the sequence of the objects are

the following: Large to small, Small to large, Left to right, Right to left, Top to bottom, Bottom to top,

Inside to outside, Outside to inside. All these options do exactly what their names specify on the objects of

the embroidery design. Therefore based on how you want your embroidery design to be embroidered you

have to select the respective Optimization Strategy. 

· Keep sequence of overlapped objects even if trimmed: This option is important for the embroidery

sequence of the design. When this option is checked, all shapes of the vector design will be embroidered

by keeping their overlapping order. This means that the order of the embroidery will follow the

overlapping order of the vector design. This filter has effect, even if you have tiny areas overlapping

between objects and even if the software decides to add thread trims between them. If this option is

unchecked the software will rearrange the objects to match better the optimization strategy and the other

optimization options you have selected. 

· No thread trims inside combined objects: This option, when it is checked, does not allow any thread

trimming between combined objects. This option applies only to objects that are combined (not

grouped).With the No thread trims inside combined objects option checked, all combined objects will be
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embroidered with jump-stitches between them, even if you have set Trimming distance between objects

option to shortest distance. 

If you leave the value of "No thread trims inside combined objects" unchecked, all thread trims will be

calculated normally and will re-sequence the objects based on the selected "Optimization strategy" and

the other optimization option you have selected(like the Trimming distance between objects).

· Minimize color changes: This option is important for limiting color changes in the embroidery production

process. Color changes have to do with thread color changes that the embroidery machine makes in order

to embroider each embroidery object. With more color changes the embroidery design sequence is

followed more accurately but the production process is longer. On the other hand with fewer color

changes, the embroidery design sequence changes to fit the "Minimizing color changes" settings but gives

shorter production process. This option will do its best to minimize the color changes but it cannot alter the

overlapping order of the objects in order to make one color change for each color used. Also, the decisions

that this option makes are related with the other optimizing settings such as the "Optimization strategy"

option, "trimming distance between objects" option, the "Keep sequence of overlapped objects even if

trimmed" option and the "Sequence" option from Properties toolbar. 

It is important to keep in mind that all optimizing options are related and the embroidery sequence is

calculated based on all optimizing options and not only to a specific one. Whenever you set the optimization

settings you have to consider how the changes you are making will affect the embroidery sequence by

keeping in mind all the other optimizer settings. You can view the results of the changes that you are making

through the "Slow redraw"  functionality (you will find in the Tools toolbar) which is simulating the

embroidering process of the design that you are creating.

The sequence window is always on top of the upper right edge of the design area. When you are in Auto

sequence mode you can only see an icon that shows the whole design.

 

But what if you want to take control over the sequence yourself? You can simply disable the Automatic

optimization by pressing the Auto button on the standard toolbar. In place of Auto button you now have one

called Manual. This means that you switched into Manual Embroidery sequence and if you look now at the

sequence window you can see the individual shapes of the design. By default, when you turn on the Manual

mode, the software will automatically optimize the design once and separate the Fill parts from the outline

parts, so that all objects are manipulated and rearranged separately for the best sequencing results.

Additionally the objects are re-arranged so that the color changes are minimized and Trimming is applied

when needed.
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Now you can click on any icon and drag it to any position you like, to create you own sequence. The sequence

manager is presented into a separate section, now we will only present how to work with manual mode in

general and how automatic optimizations work in manual mode.

Sequence tool

The software also has the "Sequence" tool on the Properties toolbar that has the functionality to order

specific objects or sets of objects to be embroidered at the beginning or at the end of the embroidering

process. The Sequence tool appears on Constraints section of Properties toolbar whenever you select an

object or a set of objects. 

The Sequence option gives you four possible abilities: "To start", "To end", "Stop before" and "Auto". 

By default the "Auto" option is selected that lets the software decide the embroidering sequence of the

design. If you want an object to change order and be embroidered first or last in the embroidering sequence

you have to use, respectively, "To start" or "To end" option. In case you have selected multiple objects and set

them "To start" or "To end" a different procedure will take place. The software will change the objects that,

for example, are set To start, move them to the beginning of the embroidering sequence and decide

automatically the order of those "To start" objects. Therefore, the objects you have set to be embroidered

"To start" will be embroidered first but with the order that the software will decide based on the other

settings that you have set on the "Optimizer options" dialog. The same will happen if you set multiple objects

to be embroidered "To end". The software will manipulate those objects and move them at the end of the
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embroidering sequence but the order will be automatically decided. The objects that remained with the

default "Auto" sequence option will be embroidered after the "To start" objects and before the "To end"

objects with order automatically decided by the software. 

Therefore, you can re-sequence the objects of the design by creating three groups: 

· Those that will be embroidered first (To start), 

· those in the middle (Auto) and 

· those that will be embroidered at the end of the object. 

If you do not make any change on the sequence option, the software will automatically create the best

possible embroidery sequence for you based on the other settings that you have set on the "Optimizer

options" dialog.

The "Stop before" option is a special sequence command that you can add to the selected design, if you

want to stop the machine before sewing the object. It is useful for multi hoop designs, applique, name drop

designs and every design you need control when the machine will stop to perform a specific task.

Every time you want you can simulate the embroidery sequence of the design through "Slow redraw" 

 tool and decide if you need to make more changes on the embroidery sequence. 

Manual Embroidery sequence

The software includes a manual sequencing mechanism that gives you the ability to re-sequence the design

freely based on your preferences. By default the software applies the Automatic Embroidery sequence, that is

very useful for inexperienced users and for those who are not familiar with embroidery sequencing. But what

if you want to take control over the sequence yourself? You can simply disable the Automatic optimization by

pressing the Auto button on the standard toolbar. In place of Auto button you now have one called Manual.

This means that you switched into Manual Embroidery sequence and if you look now at the sequence window

you can see the individual shapes of the design. 
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By default, when you turn on the Manual mode, the software will automatically optimize the design once, and

separate the Fill parts from the outline parts, so that all objects are manipulated and rearranged separately

for the best sequencing results. Additionally the objects are re-arranged so that the color changes are

minimized and Trimming is applied when needed. More objects will appear on the Sequence manager that

you will be able to re-sequence freely. The produced embroidery sequence on the "Sequence manager" will

depend on the settings you have set in the "Auto-sequence" sub-section that you will find inside the

"Tools>Optimizer options" dialog. The only thing that you must keep in mind is that more objects will be

produced, this will make re-sequencing more difficult, especially on traced bitmap objects.

Now you can select one or more icons on the Sequence manager and drag them to any position you like, to

create you own sequence. The result of the re-sequence will be visible directly on the working area. If you do

not like the results or you think that you made a mistake, you can "Undo" (Ctrl+Z or Cmd+Z on MacOS) the

last action you made and try to re-sequence the objects once more. The sequence manager is presented into

a separate section, now we will only present how to work with manual mode in general and how automatic

optimizations work in manual mode.

If the design is coming from a clear vector artwork the objects will be few and you will not have problem re-

sequencing the design. On the other hand if the design is coming from a traced bitmap the number of

objects will vary from few, up to thousands that will be difficult to manage and handle. Therefore, you must

be cautious on how to use the manual sequencing tool and you must always be prepared to manage large

numbers of objects. For this purpose the software has many tools that allow you to select objects "by

color" (outline, fill, or both) or "by stitch type" and make re-sequencing more easily.

Despite switching the embroidery sequence to manual, all options inside "Optimizer options" dialog

which are not listed under the "Auto-sequence" option, will not be applied on any of the above

manual sequencing options, until you "save" the design to stitch file(.dst,.pes, etc.) or use the "slow
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redraw" functionality to simulate the final embroidery result. This means that the "Appliqué frame-out

distance", the "Trimming distance between objects", the "Trimming distance in Cross-stitch" and the

"End points at closest connection, even on trims" options will not be calculated while enabling or

disabling "Auto-sequence" functionality. 

It is important to remember that while re-sequencing, some objects might change, as a result of the

"Remove overlap" functionality that is applied automatically. The "Remove overlap" option that is

located at the "Properties" toolbar removes unneeded parts of the design that are positioned

underneath of other objects, to reduce the embroidery stitch count and thickness. It does not remove

them permanently like the "Trim" tool does, but it holds the artwork information until you save the

design to stitch file (.dst, .pes, etc.). Therefore, you might move a large object from the bottom of the

design (that looks like a border/outline because of the "Remove overlap" functionality) and place it

on top, but once you do that you will find out that it changes to a large fill object that covers all the

other objects. To overcome that you have to use the "Trim" tool first from the "standard" toolbar, in

order to trim the bottom object and then re-order it. All these are automatically calculated when the

"Auto-sequence" functionality is enabled. 



Software Preferences
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In this section we will present the "Options" dialog and how to set preferences for various aspect of the

software. You can start "Options" dialog, using "Options" of "Tools" menu or by pressing Ctrl+T shortcut key.

For Mac OS users go to menu "Artistic" - "Preferences" or use "Cmd+ ," keys.  In the dialog box that appears

you can adjust the properties in each menu tab. 

Click on each tab, on the above image, to view their options.

General

In the "General" tab of "Options" dialog you can select a language for the user interface, you can manage the

"Undo levels" and "Auto backup steps" and finally select the measurement system and its options. You can

increase or decrease the programs "Undo level" according to your needs. The number that you define is the

number of operations that you can undo. 

The "Update Manuals" button appears only if there is an update available for the currently selected

language. 

Note: that high undo levels acquire more systems memory. 

With the "Auto backup steps" option you can set after how many of your actions an autobackup will occur.

For example, if Auto-backup steps is set to 5, the software will take a backup every 5 changes you are making

to your design.

You can select the "Measurement system" of the program, by default the programs shows all measurement

values in Metric (mm). If you wish to show in "Inches" you can use "To imperial" button and this will changes

the display of all measurements to inches. 

You can adjust the "Limit Backdrop size" by typing a new value. This numeric value specifies the maximum

width or height of any imported image. If any of the imported image dimensions (width or height) is larger

than the default "backdrop size limit" (29,5cm), the resolution values (width, height and dpi) are

automatically adjusted to match this limit.

By checking the "Override default machine selection from stitch file data" option, the default machine will

change based on the imported stitch file like .pes, .jef etc. Therefore if you import a .jef file and your default

machine was set to Brother, it will automatically change to Janome machine. Currently the supported stitch

file formats are . pes, .jef,  .jef+ and .jpx.
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Tools

In the "Tools" tab you can change some options about the selection tools, the focus status of sequence

manager and the selection of a mode for the digitizer tool. 
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Selection

· If you check the "Allow polygon selection with lasso" you will activate an extra feature of lasso tool. This

feature lets you draw straight-edged segments of a selection border. In order to draw a straight-edged

selection border, start the lasso tool and whenever you want to create a line while making a lasso

selection, you need to click twice to define the start point of the line and the end point of the line. When

your last straight-edge of your selection reaches the beginning point then your selection polygon will

be created activating all the design objects that surrounds. 

· You can set the "Lasso" as the default selection tool, using "Make lasso default selection tool". 

· The software has 2 operation modes for the transformations. The default is to have "Separated resize -

rotate" and this means that by default when you select an object you have "Size-Scale" handles and you

need to click on the object in order to switch to "Rotate-Slant" handles. More information is available

on topic Transform objects.

· In the "Selection movement step" field you can specify the distance you want an object to be moved

each time you press the "arrow key" on your keyboard. The default step movement is 1mm.

Sequence Manager 

Using "Focus on item" dropdown menu you can specify when the objects on the working area will become

focused when you work with the Sequence manager. To apply this option click OK on the dialog and restart

the software.
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· On Hover: By selecting this option whenever you hover over an object at the Sequence manager it will

become focused(highlighted and centralized in the software's view port) immediately. 

· On Click: By selecting this option whenever you click over an object at the Sequence manager it will

become focused(highlighted and centralized in the software's view port) immediately.

· Never: By selecting this option the focus option will be disabled.

Monitor

In the "Monitor" tab you can set the actual width of your monitor. This is important if you want to view your

embroidery designs in their actual size when 100% zoom selection is clicked from the standard toolbar. In

order to find your monitor’s width you can measure the visible area with a ruler. The result of your

measurement must be entered in the text field Visible area at the right metric format. Another way to define

your monitor’s width is by knowing the size of your monitor in inches, and simply clicking on the respective

monitor preset size button. The program will automatically set your monitor’s width. Finally using "Auto

Detect" option the program will try to detect automatically the size of your monitor. In order to activate your

changes you have to click "OK" at the "Options" dialog box. The next time you try to view your stitch design

in 100% zoom, the size of your design will be the actual one.

View

In the "View" tab you can adjust the way that you are viewing tool-bars. You can change the size of the "Stitch

type" icons, the "Style icons" and the icons of the "Standard" and the "Tools" toolbar. You can also select

whether "Label" text will be displayed or not and the position of the label.
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Properties

· Styles icon size: In this numeric field you can specify the size of the "Style" icons of the "Properties"

toolbar. The number of this field shows the pixel size of the icons. You can enter the exact size you want

or you can adjust size by clicking the arrows next to the value or by clicking on the value and rotating

the mouse wheel  if there is one. The size of the Styles icon cannot be more than 64 pixels.

· Values width:  In this numeric field you can specify the values' width of the Properties toolbar. You can

enter the exact size you want or you can adjust size by clicking the arrows next to the value or by

clicking on the value and rotating the mouse wheel  if there is one. The "values width" of the

Properties toolbar cannot be less than 100 pixels.

Tool-bars

Using the "Icon size" track bar you can define the size of the icons for "Standard" toolbar on the top area of

the application and for the "Tools" toolbar on the left area of the application. The number you define is the

size of the icon in pixels. Additionally you can select whether you want the label text to be displayed next to

each icon or not. 
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Ui scale

Using the "Font scale" or the "Controls scale" track bars you can scale the visible "Fonts" or the "Controls" of

the software in general. Using "Reset" button you can restore the default UI scale. 

Finally, using the "Defaults" button you can restore the default values in the "View" tab, except from the "UI

Scale" which has a separate "Reset" option. To apply all the adjustments you have made, you have to click on

the "OK" button of the "Options" dialog and restart the software. The next time that you will start the

software all the changes you have made will take effect immediately. 

3D

At this section you can make adjustments on the 3D settings of the software. 

· By checking the "Accurate rendering" option, the 3D quality will be better and more accurate. 

· From the "Sequence manager Quality" drop down menu, you can select the quality of the shapes on the

sequence manager. You can set the quality to "Low(show outline when possible)", Medium(show 2D

stitches), or "High(Show 3D stitches)".

These settings affect the speed of the software, together with the quality of the rendered 3D output. 

Printing

In the Printing tab you can adjust the Printout fonts, the Size of text and Printout parameters. 
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Printout fonts

In the "Printout fonts" option you can set which "True Type font" the printer will use for printing,  which

"Vector font" the plotter will use for printing and the "Barcode Type" you prefer to see in the Printout. The

"Barcode Type" that is supported, is the "Code 39" and the "Extended Code 39"

Also, in the "Size of text" option you can specify the size of the fonts in the printout. Click on the drop down

menu and select a size.

Printout parameters

In the "Printout parameters" you can define the "DPI" (Dots Per Inch) of the printout and the "name- slogan"

that will be added on the printout. Setting the "DPI" of the printout is important for the printout quality. The

DPI value that must be placed in the "Design bitmap DPI" field and should be around half the DPI that the

printer is capable of. For example, on a printer with 360 dpi, you can set the value from 120 to 180 dpi. In the

"Company name" field you can add the name of the company or a slogan you want to view in the printout.

Palette order

Using the "Palette order" tab you can select which of the available "Thread palettes" will be visible and

change the order that they appear in "Color manager" colors list.

Use the check-box that exists next to each of available

thread manufacturer palettes in order to select which of

them will be available on the color list of color

manager or color tab.
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Additionally you can select any of the available palettes

and by drag to another position on the list and just like

that you can move the most used palettes in the

handiest position. 

Set default color palette

You can also select the default manufacturer palette that will be used for any new design using the "default"

combo box. If you wish to work with RGB colors you can enable the "RGB as default" option on the lower part

of the dialog. 

Custom hoops

In the "Custom Hoops" tab of "Options" dialog you can create custom hoops if you are using a hoop that is

not available on the hoop list. By clicking on the "Plus" button, the custom hoop dialog will appear where you

have the ability to define a new custom hoop with the dimensions you prefer. The hoop that you will create

will be added to the list of hoops for the selected machine, allowing you to reuse it as many times as you

want. The dimensions that you will enter must be the dimensions that the manufacturer of the hoop provides

for the specific hoop. 
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To create a custom hoop you have to set the dimensions you want to have, select the Machine manufacturer

and the machine model, select the shape of the hoop, define a name and then add it to the hoop list by

pressing the "Add" button. 

· Hoop Name – Description: The first option you have is to type the Hoop Name – Description in the

respective field. The name-description that you will type in this field will be the name that you will view in

the Select Hoop drop down menu. If you forget to fill this field, you will be asked from the software to do

so. It is good practice also to add always a description of the hoop (Oval, Rounded rectangle etc.) and

the dimensions of it in the Hoop Name – Description field, in order to be easier for you to decide which

one you have to use. 

· Machine company: Select the manufacturer of the machine that you are using this hoop on. 
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· Machine model: Select the model of the machine, the hoop will be listed on the available hoops of the

selected machine.

· Hoop shape: Select if the new hoop will be rectangle Rectangle or Circular. 

· Width: In the Width value field you can insert the width of the hoop you want to use. 

· Height: In the Height value field you can insert the height of the hoop you want to use. 

After adjusting the options you can save the hoop by pressing the "Create" button that will add the hoop to

the list of hoops of the selected machine. To use the hoop you have created you must  select a Hoop through

the "Welcome" tab or using the "Machine/Hoop" icon on Tools bar.
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